Bio-Plex Manager Software 6.1 User Guide

BIO-RAD TECHNICAL SUPPORT DEPARTMENT

The Bio-Rad Technical Support Department in the U.S. is open Monday through Friday, 5:00 a.m. to 5:00 p.m., Pacific Standard Time. Worldwide technical support is available on the Web at www.consult.bio-rad.com.

Phone: 1-800-424-6723, option 2
Fax: 1-510-741-5802
Email: LSG.TechServ.US@Bio-Rad.com (U.S.)
LSG.TechServ.Intl@Bio-Rad.com (International)
Web: www.consult.bio-rad.com

NOTICE

No part of this publication may be reproduced or transmitted in any form or by any means, electronic or mechanical, including photocopy, recording, or any information storage or retrieval system, without permission in writing from Bio-Rad.

Bio-Rad reserves the right to modify its products and services at any time. This user guide is subject to change without notice. Although prepared to ensure accuracy, Bio-Rad assumes no liability for errors or omissions, or for any damage resulting from the application or use of this information.

The following are trademarks of Bio-Rad Laboratories: Bio-Rad, Bio-Plex, and Bio-Plex Manager. Luminex, xMAP, and xPONENT are trademarks of Luminex Corporation. Windows is a trademark of Microsoft Corporation. Pentium is a trademark of Intel Corporation.

No rights or licenses under any of Luminex Corporation’s patents are granted by or shall be implied from the sale or acquisition of this Bio-Plex system containing Luminex technology (the “System”) to you, the end-user. By using this System, you agree that (i) the System is sold only for use with fluorescently labeled microsphere beads authorized by Luminex (“Beads”), and (ii) you obtain rights under Luminex’s patents to use this System by registering this System with Bio-Rad in accordance with the instructions accompanying this System and by purchasing a kit containing Beads.

Copyright © 2001–2011 by Bio-Rad Laboratories. All rights reserved.
# Table of Contents

**Chapter 1. Bio-Plex Suspension Array System Overview** . . . . . . 1  
Components ......................................................... 2  
Advantages ............................................................ 3  
For More Information ............................................... 4  
Bio-Rad Technical Support ......................................... 4  

**Chapter 2. Bio-Plex Manager™ Software Overview** ............ 5  
Software Editions ..................................................... 5  
Software Licenses .................................................... 6  
Compatibility with Luminex Software ............................. 6  
General Workflow ................................................... 7  
Quick Guide ............................................................ 8  
Types of Files .......................................................... 9  
Key Software Features ............................................... 9  

**Chapter 3. Software Installation** ............................... 11  
System Requirements ............................................... 11  
Required Screen Resolution ....................................... 12  
Installing the Software ............................................. 13  
  Microsoft.NET ...................................................... 13  
  Bioplexdata.mdb File ............................................. 13  
  Luminex LXR Directory and Files ............................... 14  
Hardware Protection Key (HASP Key) ............................ 14  
Uninstalling ............................................................ 14  

**Chapter 4. Starting the System** ................................. 15  
Starting Bio-Plex Manager .......................................... 15  
  Connecting with the Array Reader and Microplate Platform ... 16  
  Communication between the Array Reader and Microplate Platform ............................... 17  
  Disconnecting and Reconnecting ................................. 18
## Table of Contents

- Disconnecting with Sleep Mode ........................................... 19
- Menu and Toolbars ......................................................... 19
- Status Bar ........................................................................... 19
- Quick Guide ......................................................................... 20
- Sample Needle Adjustment ................................................... 21

### Chapter 5. Controlling the System ................................. 25

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bio-Plex MCV Plate IV .....................................................................</td>
<td>26</td>
</tr>
<tr>
<td>Start Up ....................................................................................</td>
<td>27</td>
</tr>
<tr>
<td>Optics Warm Up and Shut Down ................................................................</td>
<td>28</td>
</tr>
<tr>
<td>Calibration</td>
<td>29</td>
</tr>
<tr>
<td>Opening the Calibration Dialog Box ...........................................</td>
<td>30</td>
</tr>
<tr>
<td>Selecting/Entering Calibration Control Numbers .................................</td>
<td>30</td>
</tr>
<tr>
<td>Setting Up the Calibration ................................................................</td>
<td>33</td>
</tr>
<tr>
<td>Performing the Calibration ................................................................</td>
<td>34</td>
</tr>
<tr>
<td>Logging the Calibration ..................................................................</td>
<td>34</td>
</tr>
<tr>
<td>Start Up and Calibrate ...................................................................</td>
<td>37</td>
</tr>
<tr>
<td>Wash Between Plates .......................................................................</td>
<td>38</td>
</tr>
<tr>
<td>Remove Air Bubbles .......................................................................</td>
<td>39</td>
</tr>
<tr>
<td>Unclog .....................................................................................</td>
<td>40</td>
</tr>
<tr>
<td>Validation</td>
<td>41</td>
</tr>
<tr>
<td>Validation Kit ...........................................................................</td>
<td>41</td>
</tr>
<tr>
<td>Validation Kit Control Number ...................................................</td>
<td>41</td>
</tr>
<tr>
<td>Setting Up a Validation Run .....................................................</td>
<td>42</td>
</tr>
<tr>
<td>Control Number Selection ................................................................</td>
<td>42</td>
</tr>
<tr>
<td>Validation Type Selection ................................................................</td>
<td>43</td>
</tr>
<tr>
<td>Performing a Validation Run .......................................................</td>
<td>44</td>
</tr>
<tr>
<td>Validation Results .......................................................................</td>
<td>44</td>
</tr>
<tr>
<td>Validation Log ...........................................................................</td>
<td>45</td>
</tr>
<tr>
<td>Platform Heater ...........................................................................</td>
<td>48</td>
</tr>
<tr>
<td>Instrument Information ....................................................................</td>
<td>49</td>
</tr>
<tr>
<td>Eject/Retract Plate .......................................................................</td>
<td>49</td>
</tr>
<tr>
<td>Additional Instrument Functions ..................................................</td>
<td>49</td>
</tr>
<tr>
<td>Cancel Operation .........................................................................</td>
<td>51</td>
</tr>
<tr>
<td>Shut Down ..................................................................................</td>
<td>51</td>
</tr>
<tr>
<td>Instrument Operations Log ................................................................</td>
<td>51</td>
</tr>
</tbody>
</table>
# Chapter 6. Preparing Protocols

## Protocol Files
- Creating/Opening Protocol Files ........................................... 53
- Saving Protocols .................................................................. 54
- Reducing the File Size of Protocols ........................................ 54

## Multi-Assay Protocols
- Uses for Multi-Assay Protocols ........................................... 56
- Creating a Multi-Assay Protocol ............................................. 57
- Changing a Protocol from Single to Multi-Assay ......................... 57

## Protocol Window
- Step 1. Describe Protocol ......................................................... 59
- Step 2. Select Analytes .......................................................... 59
- Step 3. Format Plate ............................................................... 68
- Plate Groupings ................................................................... 75
- Step 4. Enter Standards Info ................................................... 78
- Standard Lots .................................................................. 79
- Step 5. Enter Controls Info (Optional) .................................... 96
- Step 6. Enter Sample Info (Optional) ..................................... 98

# Chapter 7. Running Protocols

## Run Protocol Window .......................................................... 100
## Bead Count .................................................................. 101
## Sample Timeout ............................................................... 101
## Reservoir Functions ........................................................... 102
  - Skip Functions ................................................................. 103
## Standard Curve Optimization .................................................. 104
## Advanced Run Settings .......................................................... 104
  - Bead Map Selection .......................................................... 104
  - Sample Size ................................................................ 105
  - Save Options ................................................................. 105
  - Sampling Errors .............................................................. 105
  - Doublet Discriminator Gates ................................................ 107
## Plate Loading Guidelines .......................................................... 107
## Running the Protocol ............................................................. 108
## Status Bar .................................................................. 110
## Manually Stopping a Reading ................................................... 110
## Generating Results from a Protocol ....................................... 110
## Histogram and Bead Map ....................................................... 111
  - Histogram .................................................................. 112
  - Bead Map ................................................................. 115
# Bio-Plex Manager Software 6.1 User Guide | Table of Contents

Bead Map Display Options .................................................. 117  
Raw Data Table ................................................................. 119  
   Bead Statistics ............................................................. 120  
   Sampling Error Codes ..................................................... 120  
   Raw Data Display Options ............................................... 121  
   Set Number Format ....................................................... 122  
   Other Table Formatting ................................................... 122  
   Copying the Raw Data ..................................................... 122  
Rerun/Recovery Mode .......................................................... 123

## Chapter 8. Using the Security Edition ................................. 125

Bio-Plex Manager™ Security Edition ....................................... 125  
   Background on 21 CFR Part 11 ........................................ 126  
   Standard Mode vs. Secure Mode ........................................ 126  
   System Requirements ..................................................... 127  
Installing and Starting Bio-Plex Manager Security Edition .......... 127  
Users, Passwords, and User Levels ...................................... 127  
   User Level Restrictions .................................................. 128  
   User Information ........................................................... 128  
Enabling and Disabling Secure Mode .................................... 129  
User Authentication ............................................................ 129  
Electronic Records ............................................................ 130  
   File Security and Validation ............................................. 130  
Calibration, Validation, and Instrument Operations Logs ............ 131  
   Secure Protocol and Results Files ..................................... 131  
   Unsigned Protocol and Results Files ................................. 131  
   Signed Protocol and Results Files .................................... 132  
   Document ID Number and Signature .................................. 134  
   Adjusting the Number of Unknown Samples in a Protocol ........ 135  
   Generating a Results File from a Protocol File ..................... 136  
Audit Trail ................................................................. 137  
   Viewing the Audit Trail ................................................... 139  
   Protected Directories ..................................................... 140  
Locking Bio-Plex Manager .................................................. 141  
   Logging Off ................................................................. 141

## Chapter 9. Analyzing the Results ....................................... 143

Results Files ................................................................. 143  
   Opening a Results File .................................................... 144  
   Saving a Results File ..................................................... 144
1 Bio-Plex Suspension Array System Overview

The Bio-Plex® suspension array system is a flow-based dual-laser system for simultaneously identifying and quantitating up to 100 different analytes in a single biomolecular assay (xMAP technology). The system detects and measures molecules bound to the surfaces of fluorescent microspheres, providing highly accurate, real-time digital analysis of serum or culture media samples as small as 50 μl. This allows quantitative analysis of a wide variety of cell biology assays, including immunoassays, complex genetic assays, and enzymatic assays.

The Bio-Plex suspension array system consists of a fully integrated array reader and microplate platform, with an optional HTF (high-throughput fluidics) sheath delivery module.

Figure 1. Bio-Plex array reader and microplate platform, with optional HTF
Bio-Plex Manager Software 6.1 User Guide | Components

The system also includes validation and calibration reagents, a selection of cytokine and phosphoprotein assays, sample preparation reagents, and a computer running Bio-Plex Manager™ 6.1 software. New angiogenesis, acute phase, diabetes, cancer and isotyping assays have been introduced with this version of the software.


The assays contain sets of microscopic color-coded beads, each of which is conjugated with a different reactant. Reactants can include:

- DNA
- Enzyme substrates
- Receptors
- Antigens
- Antibodies

These can be used to create, for example, a capture sandwich immunoassay.

To perform a multiplex reading, samples are mixed with conjugated microsphere and reactant mixtures; next, fluorescent reporter molecules are added. The assays are loaded into the wells of a 96-well microtiter plate, and the plate is inserted into the microplate platform. The platform and array reader are controlled by a computer running Bio-Plex Manager software.

The detection system in the array reader uses two lasers to analyze the microspheres in a flow stream. The first laser identifies each microsphere and its associated analyte based on the fluorescent signature of the microsphere, and the second measures the amount of analyte, using the reporter molecules attached to the analytes. When the reading is complete, Bio-Plex Manager displays the raw data and generates detailed summary reports.

Components

A certified Bio-Rad service engineer will install the complete Bio-Plex suspension array system at your site, including the array reader, microplate platform, and computer. The system setup procedure is described in "Bio-Plex 200 System Hardware Instruction Manual", available for download from the Bio-Rad website.

The Bio-Plex suspension array system includes the following components:

- Array reader
- Microplate platform
- Bio-Plex MCV Plate IV (required for Bio-Plex Manager 5.0 and later)
Advantages

- Bio-Plex reservoir
- Pentium-class PC, preinstalled with operating system, Microsoft Excel, Microsoft Internet Explorer, Microsoft.NET, and Bio-Plex Manager Instrument Control software
- Software package containing Bio-Plex Manager CD-ROM and a hardware protection key
- Instrument manual for array reader and microplate platform
- Sheath fluid bottle
- Sample needles (two long)
- Protective shield
- Waste bottle
- Communications cable to connect the reader to the computer
- Communications cable from microplate platform to the computer
- Computer monitor
- Power cords
- Computer keyboard
- Computer mouse
- HTF (High Throughput Fluidics), if selected
- Communications cable from the reader to the HTF, if HTF is present

The Bio-Plex suspension array system comes with these reagents:
- Bio-Plex Calibration Kit (CAL1 and CAL2)
- Bio-Plex Validation Kit 4.0 (optics, fluidics, reporter, and classify components)
- Sheath fluid

Advantages

With the Bio-Plex suspension array system, you can:
- Simultaneously quantitate up to 100 different analytes from culture media and serum samples as small as 50 μl
- Automatically analyze all the samples in a 96-well microtiter plate—yielding up to 9,600 data points—in about 30 minutes
- Instantly customize your experiments by mixing Bio-Plex assays or creating your own assays
- Analyze results, prepare reports, and print and/or export data immediately after each reading
- Provide a complete electronic audit trail of data generation and analysis in a secure digital environment with multilevel account access, that is compliant with the Code of Federal Regulations, Title 21, Part 11, “Electronic Records; Electronic Signatures”
For More Information

For more on the principles and concepts of the Bio-Plex suspension array system, see Basic Concepts in the Appendix on page 227.

Bio-Rad Technical Support

Bio-Rad Technical Support in the United States is open Monday through Friday, 5:00 a.m. to 5:00 p.m., Pacific Time. Worldwide technical support is available on the Web at www.consult.bio-rad.com.

Phone: (800) 424-6723, option 2
Fax: (510) 741-5802
E-mail: LSG.TechServ.US@Bio-Rad.com (U.S.)
LSG.TechServ.Intl@Bio-Rad.com (International)

Web: http://www.consult.bio-rad.com
2 Bio-Plex Manager™ Software Overview

Bio-Plex Manager™ 6.1 software runs on a computer installed with the Windows XP or Windows 7 operating system, and requires a hardware protection key, also known as a HASP key, installed on either the computer itself or the computer network system. The software features a standard Windows interface, with pulldown menus, toolbars, and keyboard shortcuts.


Software Editions

Bio-Plex Manager software comes in two editions:
- **Standard Edition** gives all users equal access to all features of the software with no restrictions and no electronic audit trail
- **Security Edition** provides different levels of user access to various features and creates a complete electronic audit trail of all data generation and analysis. The Security Edition can be run in Secure Mode, with all the security features enabled, or Standard Mode, which behaves like the Standard Edition of the software.
NOTE: Bio-Plex Manager Security Edition must be installed on the Windows XP Professional or Windows 7 operating system for full security and functionality.

Software Licenses

Bio-Plex Manager software is available with three different licenses:

- **Instrument Control** (previously called Workstation) license enables the software to control the array reader and microplate platform and to collect, analyze, and output data
- **Desktop** license enables the software to analyze data files but not control the array reader and platform. The instrument communication and control functions are not available with this license
- **Network** license provides Desktop licenses to multiple users over a computer network. The Desktop license enables the software to analyze data files but not control the array reader and platform

This user guide assumes that you are using the Standard Edition with an Instrument Control license, unless otherwise noted. The Security Edition user levels and restrictions are described in detail in the Appendix on page 219.

Compatibility with Luminex Software

Bio-Plex Manager 6.1 is compatible with Luminex xPONENT software. Because the Luminex LXR library has been updated, older Luminex IS 2.3 software will not function once you upgrade to Bio-Plex Manager 6.1. You must upgrade your Luminex IS 2.3 software to the current version in order to run both applications on the same machine.

If you install Bio-Plex Manager 5.0 or later on a computer with Luminex xPONENT software, note the following:

- To avoid communication conflicts with the array reader and platform, do not run Bio-Plex Manager and Luminex software at the same time.
- If you switch between the two software applications, you must recalibrate the array reader before acquiring data.
**ANALYZING LUMINEX DATA IN BIO-PLEX MANAGER**

Bio-Plex Results Generator 3.0 converts CSV Output files from xPONENT 3.1 and 4.0 into Bio-Plex Manager data files. You can analyze the converted results on any computer running Bio-Plex Manager 4.0 or later. You can make the files available to an entire workgroup by placing them on a public server.

With earlier versions of Bio-Plex Manager, you had to separately install Bio-Plex Results Generator. Beginning with Bio-Plex Manager 6.1, Bio-Plex Results Generator is automatically included in the Bio-Plex Manager installation.

The Bio-Plex Results Generator 3.0 application (*RBXGenerator_3.exe*) is included as a separate product on the Bio-Plex Manager 6.1 software CD. This allows you to install it on a machine that does not have a Bio-Plex Manager installation. There is also a help file (Bio-Plex Results Generator 3.0 Online Help) to walk you through installing the Results Generator and setting up Luminex protocols for conversion.

---

**General Workflow**

To collect, analyze, and output data using Bio-Plex Manager software, follow the general steps outlined below.

1. **Start up and calibrate array reader**
2. **Create a protocol by specifying analytes, plate, and standards**
3. **Run the protocol**
4. **Review results and generate reports**
5. **Print and/or export the data**

*Figure 2. Bio-Plex Manager software workflow*
Quick Guide

The Quick Guide, which displays automatically at startup, is designed to guide you through the typical Bio-Plex Manager workflow, from startup and calibration through shut down.

Commands, such as Start up & Calibrate, open dialog boxes that contain choices to guide you through the procedures.

Figure 3. Quick Guide
Types of Files

There are two main types of files created and used by Bio-Plex Manager:

- Protocol files (see page 53) contain the settings and controls for reading a microplate
- Results files (see page 143) contain the data from each reading, and tools and reports for analyzing that data

The application database file (*bioplexdata.mdb*) is installed on your hard drive or file server when you install the software. This database contains calibration, validation, and instrument operation information. See page 13 for more detail.

Key Software Features

Bio-Plex Manager 6.1 is a single integrated software package that has:

**Comprehensive instrument functions**
- Data collection
- Maintenance
- Validation
- Automatic error detection and logging

**Comprehensive data display**
- Raw data presentation including tables, bead maps and histograms
- Customizable tabular presentations
- Customizable standard curve and bar graph displays

**Comprehensive Calculations**
- Data normalization (internal controls for gene expression analysis)
- Auto calculation and display of usable assay range
- Multiple standard curve fitting options, including Brendan Scientific, StatLIA, Logistic 5PL.

**Comprehensive and versatile automated export options**
- Excel (now including optional standard curve graphs)
- Comprehensive .xml file
- New Luminex CSV (comma-separated values) output
- New customizable reports through style sheets
- New custom report for export to custom macros

**CFR 21 Part 11 compliance**
- User access management
- Comprehensive audit trail and instrument logs
- Secure documents (results files and protocols)
3 Software Installation

Install, or reinstall, Bio-Plex Manager™ 6.1 software as described in the following section. If you need to upgrade your software from a previous version, see the “Bio-Plex Manager 6.1 Software Upgrade and Configuration Guide” to determine the part number of your upgrade kit.

System Requirements

<table>
<thead>
<tr>
<th>Component</th>
<th>Minimum</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Windows XP (XP Professional required for running Security Edition) or Windows 7 (32-bit)</td>
<td>Windows XP Professional</td>
</tr>
<tr>
<td>Processor</td>
<td>Pentium 4 or equivalent, 2.8 GHz</td>
<td>Core 2, 2.6 GHz or higher</td>
</tr>
<tr>
<td>Hard disk space</td>
<td>80 GB</td>
<td>160 GB</td>
</tr>
<tr>
<td>System memory</td>
<td>1 GB</td>
<td>2 GB</td>
</tr>
<tr>
<td>Screen resolution</td>
<td>1024 x 768 (Windows XP)</td>
<td>1280 x 1024</td>
</tr>
<tr>
<td></td>
<td>1280 x 1024 (Windows 7)</td>
<td></td>
</tr>
<tr>
<td>Screen colors</td>
<td>256 colors</td>
<td>24-bit True Color</td>
</tr>
<tr>
<td>Ports for connecting instrument</td>
<td>1 RS232 serial port and 1 USB port</td>
<td>1 RS232 serial port and 1 USB 2.0 port</td>
</tr>
<tr>
<td>(required for Instrument Control</td>
<td></td>
<td></td>
</tr>
<tr>
<td>license only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Port for connecting the HASP key</td>
<td>1 USB port</td>
<td>1 USB 2.0 port</td>
</tr>
<tr>
<td>Other software</td>
<td>Internet Explorer 6.0 or later</td>
<td>Internet Explorer 8.0</td>
</tr>
<tr>
<td></td>
<td>Microsoft Excel 2003 or later</td>
<td>Microsoft Excel 2007</td>
</tr>
</tbody>
</table>

**NOTE:** For Windows 7, the Instrument Control version of Bio-Plex Manager 6.1 can be run only on 32-bit; it is not compatible with 64-bit.
Required Screen Resolution

Your computer screen resolution must be set to at least 1024 x 768 pixels for correct display of the Bio-Plex Manager interface. The status bar and some dialog boxes will not display properly at lower resolutions. If your display is currently set to a lower resolution:

1. Go to the Windows Start menu, select Settings, and select Control Panel.
2. Open the Display control panel.
3. In the Display Properties dialog, select the Settings tab (see Figure 3).
4. Drag the Screen Area slider to the right (toward More) until you have selected 1024 x 768 pixels. Click OK to accept the settings.

Figure 4. Changing the screen resolution settings
Installing the Software

To install or reinstall the software, insert the Bio-Plex Manager CD into the CD-ROM drive on your computer.

NOTES
- Before installing Bio-Plex Manager 6.1, we recommend that you first uninstall any existing version of Bio-Plex Manager on your computer.
- We recommend that you turn off any antivirus protection software before installation. Such software, if active, can greatly slow the progress of the installation. If you are unable to turn off your antivirus protection software, allow 15 minutes for complete installation. Do not cancel the installation during this period.

The Bio-Plex Manager Installation Program opens, displaying a navigation screen for performing the installation.

Microsoft.NET

Microsoft.NET is automatically installed on your computer when you install Bio-Plex Manager. It is required to support the logistic curve-fitting features of Bio-Plex Manager.

Bioplexdata.mdb File

During installation, you will be prompted to save the application database file (bioplexdata.mdb) to a location on your hard drive or a file server. This database file contains logs of calibration, validation, and instrument operations activity for your instrument.
- For more information about the Calibration Log, see page 34
- For more information about the Validation Log, see page 45
- For more information about the Instrument Operations Log, see page 51

You can save the bioplexdata.mdb file to any folder on your computer. The default location is the Bio-Plex Manager application folder. If your computer is connected to multiple instruments, each instrument must have a separate bioplexdata.mdb file saved in a different folder.

For more information about the calibration, validation, and instrument operations logs in Bio-Plex Manager 6.1 Security Edition, see Controlling the System on page 25.
NOTE: The bioplexdata.mdb file is not compatible with versions of Bio-Plex Manager earlier than 4.0. If you have an earlier version of the software, installing 4.0 or later will copy the data from your existing database file (bioplex.mdb) into the new database. A copy of your old database will remain in the application folder.

Luminex LXR Directory and Files

A directory called Luminex is automatically created in the Program Files folder on your computer during installation. Inside this folder is a folder called LXR that contains various applications for monitoring and communicating with the array reader and platform. A Windows service called LXService is also installed and started. This service enables automatic communication with the instrument when you open Bio-Plex Manager.

Hardware Protection Key (HASP Key)

A hardware protection key, also known as a HASP key, is required to run Bio-Plex Manager. The HASP key determines the license (Instrument Control, Desktop, or Network) and the edition (Standard or Security) of your Bio-Plex Manager. A complete list of HASP key part numbers and the software versions they enable is in the Bio-Plex Manager 6.1 Software Upgrade and Configuration Guide.

Instrument Control or Desktop HASP keys must be attached to a USB port on the computer running the software. Network HASP keys must be attached to a USB port on the network file server computer.

The HASP key has a driver that is automatically installed when you install Bio-Plex Manager.

Uninstalling

To uninstall Bio-Plex Manager from your computer, use the Windows Add/Remove Programs function. Click the Windows Start button, select Settings, select Control Panel, double-click Add/Remove Programs, and follow the instructions for removing the program.
4 Starting the System

Before starting Bio-Plex Manager™ 6.1 software, make sure the Hardware Protection Key is attached to your computer, and switch on the array reader, the HTF (if one is being used), and the microplate platform. This turns on the optics inside the array reader and enables communication between the array reader and software.

NOTE: Avoid using other applications while Bio-Plex Manager is communicating with the array reader. Running other applications may interrupt communication between Bio-Plex Manager and the array reader.

Starting Bio-Plex Manager

To start Bio-Plex Manager, click the application icon on your desktop or select Bio-Plex Manager 6.1 from the Programs directory on your Windows Start menu. The software opens and attempts to connect to the array reader and platform.
Connecting with the Array Reader and Microplate Platform

The computer running Bio-Plex Manager software is connected to the array reader by a USB cable, and to the microplate platform by a serial cable. See the figure below for a diagram of the cable connections.

Figure 5. System cable connections
Starting Bio-Plex Manager

Communication between the Array Reader and Microplate Platform

Communication between the computer and the array reader and microplate platform is automatically established when you open Bio-Plex Manager. If Bio-Plex Manager is unable to communicate with the instrument, a dialog box prompts you to check the cable connections.

**Figure 6. Connection Error dialog**

Make sure the instrument is turned on, check the cable connections, and then click Reconnect in the dialog. If you are still unable to connect, try restarting the computer, array reader, and platform. You can also choose the Run Diagnostic option found under the Instrument menu. This produces a report which can help Bio-Rad Technical Support determine the cause of the problem.

**Figure 7. Run Diagnostics Report**
If you do not want to automatically connect to the array reader and platform when you open the software, select the Do not connect at startup checkbox. This is useful if you are not connected to an instrument or want to use the software without connecting to the instrument. To re-enable automatic connection at startup, select Reconnect from the Instrument menu (see next section).

**Disconnecting and Reconnecting**

Communication between the computer and the array reader and platform is closed when you exit Bio-Plex Manager. If you need to disconnect from the array reader and platform without shutting down Bio-Plex Manager software (for example, to troubleshoot the instrument), go to the Instrument menu and select Disconnect.

To reconnect to the array reader and platform while Bio-Plex Manager is running, select Reconnect from the Instrument menu. This dialog also enables automatic connection each time you start the software, if it has been disabled (see previous section).
Disconnecting with Sleep Mode

When your computer goes into sleep mode, the instrument is disconnected from Bio-Plex Manager. When you awaken your computer from sleep mode, you will not be able to reestablish the connection to the instrument using the Reconnect option on the Instrument menu, and you will need to restart Bio-Plex Manager.

Bio-Plex Manager overrides any sleep mode settings on your computer. Therefore, as long as it is running, your computer will not go into sleep mode. However, Bio-Plex Manager does not prevent you from actively putting your computer into sleep mode. It is recommended that you do not do this as long as Bio-Plex Manager is running.

Menu and Toolbars

Bio-Plex Manager includes a menu bar and main toolbar at the top of the application window.

The pulldown menus contain all the major functions of the software. Note that these menus change depending on whether you are displaying a Protocol window, a Results window, or neither.

You can move quickly between any number of open Bio-Plex Manager windows. Hold down the Ctrl key, then press Tab.

The main toolbar includes the major instrument controls, including Start up & Calibrate, Shut Down, Wash, Unclog, etc. The various Protocol and Results windows also contain their own toolbars, with commands specific to those windows. These are described in greater detail in the following chapters.

Status Bar

The Instrument Status Bar shows the current state of the instrument (Calibration, Warm Up, Ready, Pressurizing, etc.). It includes a Cancel button for canceling the current operation (see page 51).

Figure 8. Instrument status bar

When the array reader performs an operation, the time remaining for the operation shows in the instrument status bar.
The Bio-Plex Manager software status bar is below the instrument status bar, and provides information about the command under the cursor. This information is continuously updated as you move your cursor over the software window.

The software status bar also shows the current user and, if you are using the Security Edition of the software, whether you are in Secure Mode (shown as a "locked" symbol 🛠️) or Standard Mode (shown as "unlocked" 🛠️). See page 5 of this manual, and the Bio-Plex Manager 6.1 Software Upgrade and Configuration Guide for more information about the Security Edition.

The software status bar also shows the Caps Lock, Scroll Lock, and Num Lock keyboard status.

Quick Guide

When Bio-Plex Manager first opens, a Quick Guide toolbar appears in the upper right corner of the screen. You can use the Quick Guide to guide you through the typical workflow, from start up and calibration through shut down.

![Figure 9. Bio-Plex Quick Guide](image)

By default, the Quick Guide opens automatically when you start Bio-Plex Manager. To disable, deselect the Show at startup checkbox at the bottom of the guide.

To open the Quick Guide after closing, select Quick Guide from the View menu.
Sample Needle Adjustment

See the Bio-Plex 200 System Hardware Instruction Manual or the Luminex manual for instructions on installing the sample needle.

**WARNING:** To protect hands and fingers, keep them out of the microplate platform when the needle is not in the down position.

The height of the sample needle must be adjusted when the microplate type has changed, and/or when the sample needle is replaced. The MCV plate included with your system provides a method for adjusting sample needle height for standard flat-bottom plates (catalog #171-025001), filter plates (Millipore catalog #MSBVS1210), or PCR plates.

Follow these steps to adjust the sample needle height.

1. Turn on the array reader and microplate platform.
2. Launch the Bio-Plex Manager software.
3. Click Instrument in the menu bar and choose Adjust Needle. The following dialog box appears.

**Figure 10. Adjust Needle dialog**

4. Click Eject/Retract to eject the plate holder.
5. Place the MCV plate on the microplate platform with the black arrow facing toward the array reader.
6. Click on the Eject/Retract button to retract the plate.
7. Tape the access door of the microplate platform open. It will be necessary to be able to see inside the access door.
8. Select the plate type to adjust the needle height appropriately. Choose Standard Plate if you are using a Bio-Plex Pro™ flat-bottom microplate for magnetic beads or the Millipore filter plate. Your other choice is PCR Plate.

9. In the Adjust Needle window, click on the Up/Down button. The needle will move to the down position.

10. With the needle in the down position, loosen the needle height adjustment thumbscrew at the top of the needle so that the needle housing can move up and down freely.

**NOTE:** All adjustments to the needle height must be made when the needle is in the down position.

11. By holding onto the needle height adjustment thumbscrew on the needle arm, manually move the needle so that it just touches the bottom of the needle adjustment well of the MCV plate. Move the needle up and down gently a couple of times to verify that the needle is barely touching the bottom of the well.

12. Tighten the needle height adjustment thumbscrew so that it is no longer possible to manually move the needle up and down. Take care to ensure that the needle does not move while you are tightening the screw. Do not overtighten.

13. In the Adjust Needle window, click on the Up/Down button to move the needle up and down. Look inside the microplate platform at the MCV plate. The needle should just touch the MCV plate at the bottom of the cutout (use flashlight for better viewing). Readjust the needle height if necessary.

14. Save these settings. This allows Bio-Plex Manager to warn you which type of plate the system will use, before it starts a run.

15. When the needle is adjusted properly, click the Eject button.

16. Remove the MCV plate from the microplate platform.
Sample Needle Adjustment

17. Perform a Wash Between Plates step to remove any air introduced into the lines.
5 Controlling the System

This chapter covers the Bio-Plex Manager™ 6.1 software commands that control basic system functions, such as instrument start up, warm up, calibration, validation, and shut down.

NOTE: The startup, warm up, and calibration functions must be performed prior to running an assay with Bio-Plex Manager, all of which together take about 45 minutes. The Start up & Calibrate function allows you to complete these steps with one command.

WARNINGS:

- The sheath fluid container and the waste fluid container should be closely monitored
- The sheath fluid bottle must be placed at the same level as the array reader, unless you are using the Bio-Plex High-Throughput Fluidics (HTF) or Luminex Sheath Delivery System (SDS). The fluid level should be below the air inlet connection and above the sheath outlet connection. Always check the sheath fluid level before starting a run or procedure
- If you are using the Bio-Plex HTF or Luminex SDS, it should sit on the counter next to the array reader, while the sheath fluid cube should be placed 3-4 feet below the array reader (for example, on the floor)
- The waste fluid container receives waste from the system. Do not allow the waste container to overflow. Empty the waste bottle each time the sheath fluid bottle is filled. The waste container should be placed on the bench next to the instrument. Never place this container on top of the instrument. All waste containers should have vented caps
Bio-Plex MCV Plate IV

Bio-Plex Manager 5.0 and later requires the use of the Bio-Plex MCV (Maintenance, Calibration and Validation) Plate IV. This plate contains wells marked for the different types of fluids used in validation, washing, calibration, and other functions. The Bio-Plex MCV Plate IV has been modified from the previous MCV plate to work with Bio-Plex Validation Kit 4.0 and its Reporter and Classify bead sets. It also includes two open needle wells for adjusting needle heights for microplates or PCR plates.

NOTE: Bio-Plex Manager 5.0 and later require the use of the Bio-Plex MCV Plate IV, the Bio-Plex Validation Kit 4.0, and the Bio-Plex Calibration Kit.

Figure 12. Bio-Plex MCV Plate IV

When a particular procedure such as calibration requires you to add solutions to the Bio-Plex MCV Plate IV, the dialog box describing the procedure includes a diagram of the MCV Plate IV with the wells to be loaded highlighted in blinking yellow.

Figure 13. Highlighted wells in diagram indicate wells to be filled
Startup is a series of fluidic functions that prepares the array reader to acquire data. This process requires the Bio-Plex MCV Plate IV, distilled water, and 70% isopropanol. Startup takes approximately 10 minutes.

**NOTE:** The startup procedure can be performed while the optics are warming up, but no validations, calibrations or runs should be performed before the optics are warmed up. This takes an estimated time of 30 minutes.

Click the Start Up button on the main toolbar or select the command from the Instrument menu. Follow the step-by-step directions in the dialog box for preparing the MCV Plate IV.

*Figure 14. Start Up dialog*

Insert the prepared plate into the microplate platform and click OK to begin the startup process.
Optics Warm Up and Shut Down

To ensure accurate and reproducible results, the optics (that is, the lasers) in the array reader must warm up for at least 30 minutes prior to calibration, validation, and reading assays. Optics warm up begins when you first turn on the array reader.

You can proceed with the array reader startup procedure described in the previous section while the optics are still warming up. However, if you try to perform calibration, validation, or an assay reading, you will receive a warning message.

You can cancel the warm up procedure using the Cancel Operation command on the Instrument menu or the Cancel button in the status bar; however, this is not recommended. Results for identical readings may vary if the optics have not reached optimal operating temperature.

NOTE: If you attempt to start a reading during warm up, you can eject the plate carrier using the Eject/Retract Plate command on the main toolbar and remove the plate for storage until warm up is complete, without canceling the warm up procedure.

If the array reader is idle for more than four hours, the optics automatically power down (though the array reader itself remains on). Depending on the length of the shutdown, a full 30-minute warm up period may be required before more readings can be taken.

Click the Warm Up button on the main toolbar or from the Instrument menu to begin warm up after automatic power down.

If you attempt to perform a reading after automatic power down, you receive a warning message and the optics begin warming up.
Calibration

Calibration of the array reader is essential for optimal performance and day-to-day reproducibility of results. Calibration is required:

- Each day after the startup procedure is complete and the optics have warmed up
- If the array reader temperature changes by more than 2°C during the course of the day. (If the temperature changes by more than 2°C, a message box prompts you to recalibrate)
- Before data acquisition, if you switch between Bio-Plex Manager and Luminex software installed on the same computer (see page 6)

**NOTE:** Before calibrating, make sure that optics warm up is complete.

The Bio-Plex Calibration Kit contains calibration microspheres (CAL1 and CAL2 beads) with stable fluorescent intensities in the RP1, CL1, and CL2 wavelength ranges. The calibration process uses these microspheres to adjust voltage settings for optimal and consistent microsphere classification and reporter readings over time and across different instruments. Current calibrated settings are automatically applied to any new session.

Calibration using Bio-Plex Manager requires the Bio-Plex MCV Plate IV, CAL1 beads and CAL2 beads from the Bio-Plex Calibration Kit, and distilled or deionized water. The CAL1 beads calibrate the array reader’s doublet discriminator and classification channels, while the CAL2 beads calibrate the array reader’s reporter channel for reporter fluorescence detection.
Opening the Calibration Dialog Box

To begin calibration, click the Calibrate button on the main toolbar or select Calibrate from the Instrument menu. The Calibrate dialog box opens.

At the top of the dialog box, enter your name in the field. If you are using the Security Edition of the software in Secure Mode, your user name will be listed and grayed out.

The time and date of the last calibration using Bio-Plex Manager are listed, as is the temperature at the time of that calibration. If the temperature has not changed by more than 2ºC in a single day, it is not necessary to recalibrate the instrument.

Next, select the calibration type by clicking on the CAL1 & CAL2, CAL1 Only, or CAL2 Only button. You should perform both CAL1 and CAL2 calibration daily.

Selecting/Entering Calibration Control Numbers

Under Select Control Numbers in the Calibrate dialog box, you can either select existing control numbers for your CAL1 and CAL2 microspheres, or enter new control numbers.
Select existing control numbers from the pulldown list, and the target values for the control numbers appear in the appropriate fields.

When you receive a new Bio-Plex Calibration Kit, you must add the new CAL1 and CAL2 control numbers and target values to the Calibrate dialog. These numbers are printed on the bottles containing the beads.

**NOTE:** It is critical that you enter the correct target values for your CAL1 and CAL2 calibrators. Entering incorrect values results in an incorrectly calibrated array reader, which adversely impacts assay results.

To add a new CAL1 control number, click the Add button under CAL1 Control Number in the Calibrate dialog. The Add New CAL1 Control Number dialog box opens.

![Add New CAL1 Control Number](image)

**Figure 16. Adding a new CAL1 control number**

In the dialog, enter the control number from the CAL1 bottle in the Enter Control Number field. If the expiration date is printed on the bottle, select the option button next to the date field under Expiration Date and click the pulldown button next to the field to open the calendar selection box.

![Calendar selection box](image)

**Figure 17. Calendar selection box**

Scroll through the calendar using the scroll buttons at the top. Click to select a particular date. Use the up/down arrow keys to highlight and change individual date components.
Next, enter the DD, CL1, and CL2 target values for the control number, as printed on the bottle, in the appropriate fields.

**NOTE:** Use only the DD target value on the Bio-Plex CAL1 bottle. Using Bio-Rad's calibrators is highly recommended, because other manufacturers' DD target values have not been validated.

Click Add to close the dialog box and save your changes.

To add a new CAL2 control number, click the Add button under CAL2 Control Number in the Calibrate dialog box. The Add New CAL2 Control Number dialog box opens.

![Add New CAL2 Control Number](Image)

Figure 18. Adding a new CAL2 control number

In the dialog, enter the control number from the CAL2 bottle in the field. Select the expiration date, if printed on the bottle, as described above. Next, enter the Low RP1 target value for the control number, as printed on the bottle, in the RP1 field.

**NOTE:** The CAL2 calibration bottle label lists two RP1 (also known as PMT, for photomultiplier tube) target values: Low RP1 and High RP1. The High RP1 target value cannot be used in Bio-Plex Manager 5.0 or higher. All calibration is done at the Low RP1 target value, which must fall between 3000 and 4000. The High RP1 target value remains on the bottle label because it can be used with earlier versions of Bio-Plex Manager. Assays that require calibration using the High RP1 target value can be run by selecting the checkbox labeled “Run at High RP1 Target” in the Run Protocol window.

When you are done, click Add to close the dialog box and save your changes. Your new control numbers are added to the selection lists in the main Calibrate dialog.

To delete a particular control number, first select it in the Calibrate dialog box, and then click the Delete button.
Setting Up the Calibration

When you have specified the control numbers of your calibration microspheres and specified the type of calibration you want to perform (CAL1 & CAL2, CAL1 Only, or CAL2 Only), click OK in the Calibrate dialog.

Another dialog box lists step-by-step instructions for preparing the Bio-Plex MCV Plate IV.

Figure 19. Preparing the Bio-Plex MCV Plate IV for CAL1 & CAL2 calibration

NOTES: When preparing the MCV Plate IV, do the following:

- Important: Before vortexing, remove the calibration beads from 2 to 8°C (36 to 46°F) storage, and allow them to warm to room temperature. Vortex each bottle for 30 seconds. Proper suspension of the microspheres is essential for efficient calibration.
- Never dilute the calibration beads, and be careful to limit their exposure to light. Store at 2 to 8°C immediately following calibration.
- Load 6 drops of beads (approximately 200 μl) per reservoir (CAL1 or CAL2).
- The DI H₂O well of the MCV Plate IV holds about 3 ml of distilled or deionized water.
Performing the Calibration

Click the Eject/Retract Plate button to eject the microplate platform plate carrier. Place the MCV Plate IV in the carrier with the arrow facing toward the platform, and then retract the plate. Click OK to start the calibration process.

As calibration proceeds, the status bar at the bottom of the Bio-Plex Manager window monitors the progress of calibration. The number of beads per second should be 100 or higher. Fewer beads per second may indicate a problem with the fluidics system.

Because calibration beads are highly concentrated, calibration is followed by three wash cycles using distilled water.

An alert box notifies you whether calibration has succeeded or failed. You also receive an alert which informs you how many days have elapsed since you last ran a validation procedure.

If the calibration process failed, check the MCV Plate IV to verify that the correct beads were added to the wells. Then perform a fluidics wash and repeat the above steps. For more information, consult the Troubleshooting chapter.

Logging the Calibration

The Calibration Log provides a list of past calibration dates and times, results, instrument settings, and other data obtained by Bio-Plex Manager. These data are stored in a log file called `bioplexdata.mdb`. By default, the file is saved in the main Bio-Plex Manager application folder on your computer.

**NOTE:** This database is not compatible with versions of Bio-Plex Manager earlier than 4.0. If you have an earlier version of Bio-Plex Manager, installing version 4.0 or later copies data from your existing database (`bioplex.mdb`) into the new database. A copy of the old database remains in the application folder.
To open the Calibration Log, go to the View menu and select Calibration Log. The Calibration Log viewer opens.

Each calibration is listed by date and time. If you are using Bio-Plex Manager Security Edition in Secure Mode, the User and Access Level columns list information about the user who was logged into the application when each calibration was performed. The Result column notes the result of each calibration, including whether it passed or failed.

**NOTE:** If you see a drastic change in a detector’s voltage from one calibration to the next, it could indicate a problem with the instrument. A steadily increasing detector voltage may indicate that the laser is decreasing in intensity.

On the toolbar, click Calibration Detail to display additional information for each calibration, including bead count, system temperature and pressure, and the reader software and firmware versions. Click Calibration Log to return to the default view.

For CAL1-only calibrations, the RP1 column displays an entry of NA (not applicable). For CAL2-only calibrations, the DD, CL1, and CL2 columns display entries of NA.
To print the calibration report, select Print from the File menu. Print Preview displays the report as it will appear in a printout. Print Setup allows you to select some standard print settings.
Start Up and Calibrate

Each time you use Bio-Plex Manager, the array reader must go through the start up, warm up, and calibration procedures. The Start up & Calibrate command allows you to perform these steps with a single command. Click the Start up & Calibrate button on the Quick Guide or main toolbar, or select the command from the Instrument menu.

Refer to the following for more information on the individual functions:

- Start Up on page 27
- Optics Warm Up and Shut Down on page 28
- Calibration on page 29

If you prefer, you may perform each function separately. The individual functions are available on the main toolbar or from the Instrument menu.
Wash Between Plates

You should wash the fluidics lines between each plate reading to prevent traces of sample or other debris from building up inside the system.

Click the Wash Between Plates button on the Quick Guide or main toolbar, or select the command from the Instrument menu. A dialog box guides you through the steps for preparing the MCV Plate IV for a wash procedure.

Add 70% isopropanol and distilled water to the appropriate reservoirs, insert the plate in the microplate platform, and click OK. This procedure performs a series of fluidics operations and takes several minutes. After initial system pressurization (5 to 20 seconds), the time remaining in the operation displays in the Bio-Plex Manager status bar.

Figure 22. Steps for washing between plate readings

Add 70% isopropanol and distilled water to the appropriate reservoirs, insert the plate in the microplate platform, and click OK. This procedure performs a series of fluidics operations and takes several minutes. After initial system pressurization (5 to 20 seconds), the time remaining in the operation displays in the Bio-Plex Manager status bar.
Remove Air Bubbles

Microscopic air bubbles in the cuvette may cause a sudden shift in the bead regions during an assay reading. If the array reader detects such a shift, the reading stops and you are prompted to perform an alcohol wash to force air bubbles out of the system.

Click the Remove Bubbles button on the main toolbar or select the command from the Instrument menu. A dialog box guides you through the steps for preparing the MCV Plate IV for the procedure.

Figure 23. Steps for removing air bubbles from the fluidics system

Add 70% isopropanol and distilled water to the appropriate reservoirs, insert the plate in the microplate platform, and click OK. This procedure performs a series of fluidics operations and takes several minutes. After initial system pressurization (5 to 20 seconds), the time remaining in the operation displays in the Bio-Plex Manager status bar.
Bio-Plex Manager Software 6.1 User Guide | Controlling the System

**Unclog**

If the array reader detects an unusually low bead count during a reading, you are prompted to perform an Unclog operation to remove possible obstructions from the fluidics lines.

1. Click the Unclog button on the main toolbar or select the command from the Instrument menu. An instruction box guides you through preparation of the MCV Plate IV.

2. Add 70% isopropanol solution and distilled water to the appropriate reservoirs.

3. Add 5 drops of CAL1 beads to the CAL1 reservoir.

4. Insert the plate in the microplate platform, and click OK.

This procedure performs a series of fluidics operations and reads a sample of CAL1 beads to verify that the fluidics are operating properly. It takes several minutes. After initial system pressurization (5 to 20 seconds), the time remaining in the operation displays in the Bio-Plex Manager status bar.

Figure 24. Steps for unclogging the fluidics system

---

Validation

Validation of the array reader is a formal process for documenting that the instrument is fit for its intended use and that it is kept in a state of maintenance and calibration.

**NOTE:** Validation is performed after startup and calibration have been performed. Validation is dependent on successful calibration for accuracy.

You should perform a validation reading:
- Once a month
- Each time you move the array reader, or
- To diagnose any problems with the array reader that cannot be solved by other procedures (calibrating, washing, unclogging, etc.)

**Validation Kit**

Bio-Plex Manager requires the use of Bio-Plex Validation Kit 4.0 to perform validation. It must be used in conjunction with the Bio-Plex MCV Plate IV. Each Bio-Plex Validation Kit consists of reagents and procedures to evaluate:
- Optical alignment
- Reporter channel performance
- Efficiency of multiplexing
- Integrity of fluidics

The Bio-Plex Validation Kit validates the operation of all of the primary components of the array system, and can also be used to discriminate between assay and instrumentation problems.

**Validation Kit Control Number**

Each Bio-Plex Validation Kit has a control number linked to the specifications for the kit. You must use the mini-CD included in the kit to install the control number on your computer. After installation, you can select the control number in Bio-Plex Manager, as described in the following section.

See the *Bio-Plex Validation Kit 4.0 Instruction Manual* for more information.
Setting Up a Validation Run

To set up a validation reading, click the Validation button on the main toolbar or select the command from the Instrument menu. The Validation dialog box opens.

![Validation dialog](image)

Enter your user name in the top field. If you are using the Security Edition of the software in Secure Mode, your user name is listed and grayed out.

Control Number Selection

In the Validation dialog box, select the Control Number for your specific Bio-Plex Validation Kit from the Control Number pulldown list. The expiration date for the control number is listed below the field.

If the control number is not available in the list, or the list is too long and you want to limit it to the control numbers you are using, click the Add/Remove button.

![Add/Remove Control Numbers dialog](image)
The Add/Remove Control Numbers dialog lists all the available validation control numbers. To make control numbers available in the Validate dialog pulldown list, add them to the Selected List. To select all the numbers in the Available List, click the Add All>> button. To add control numbers individually, double-click them, or select multiple numbers using Shift + Click and Ctrl + Click key combinations, and click the Add>> button. Use the <<Remove and <<Remove All buttons to unselect them. At least one control number must remain in the Selected List.

When you click OK, the control numbers in the Selected List are added to the pulldown list in the Validate dialog.

To view the specifications for a control number, select the number from the pulldown list and click the Show Specifications button. The Control Number Specifications dialog box lists the validation specifications.

**Validation Type Selection**

In the Validate dialog, select the type of validation you want to perform using the Validation Type option buttons: All, Optics, Fluidics, Reporter, and Classify.
Performing a Validation Run

When you have made your selections in the Validation dialog, click OK. The dialog box for the selected type of validation opens.

Validation Results

After a run, the Validation Results dialog box automatically opens. You can also view this dialog by going to the View menu and selecting Validation Results.
Validation

The Validation Results dialog box includes tabs for each type of validation. If you selected and performed All Validations, all the tabs will be available. Otherwise, only the tab for the validation you performed (Optics, Fluidics, Reporter, or Classify) will be available and displayed.

Click Create Report to generate and display a Microsoft Excel spreadsheet showing the validation results. Note that Microsoft Excel 2000 or higher must be installed on your computer for this function to work. (Excel comes preinstalled on all computers supplied with the Bio-Plex suspension array system.)

See the Bio-Plex Validation Kit 4.0 Instruction Manual for interpreting the results of a validation run.

Validation Log

Each validation run is recorded in the Validation Log. This log is stored in a secure database file called bioplexdata.mdb. By default, this file is saved in the main Bio-Plex Manager application folder on your computer.

NOTE: If you have an earlier version of Bio-Plex Manager, installing version 4.0 or later will copy the data from your existing database (bioplex.mdb) into the new database. A copy of your old database will remain in the application folder.

To view this log, go to the View menu and select Validation Log.

![Validation Log Viewer](image)

*Figure 30. Validation Log Viewer*
The validation results are listed by date and time in the upper window, and the specifications associated with each Control Number are listed in the lower window. If you are using Bio-Plex Manager Security Edition in Secure Mode, the User and Access Level columns list information about the user who was logged into the application when each validation was performed.

Use the buttons in the upper left corner of the window to view the different validation types (Optics, Fluidics, Reporter, and Classify).

To print the Results window, click the Print Report Results button.

To print the Specifications window, click the Print Specifications button.

To show or hide the specifications data in the Validation Log viewer, click the Show/Hide Specifications Window button.

To create a spreadsheet report for a particular validation run, click the row for the run in the Results window. It will appear selected, as will the specifications associated with the Control Number for that run in the lower window.

Then click Create Report.
A Microsoft Excel spreadsheet is automatically generated and displayed showing all the validation data for that run. Note that Microsoft Excel 2000 or higher must be installed on your computer for this function to work.

Figure 31. Validation results spreadsheet (Microsoft Excel)
Platform Heater

The microplate platform has a heater for warming samples. The heater has an operating range of 35°C to 60°C (95°F to 140°F), and can be controlled through Bio-Plex Manager.

To access the heater controls, select Platform Heater from the Instrument menu, or click the button on the main toolbar.

Figure 32. Platform Heater dialog

In the Platform Heater dialog, click the Turn Heater on checkbox to turn on the heater, and set the target temperature within the range 35 to 60°C using the scroll buttons.

To automatically turn the heater off at the end of a run, select the Turn Heater off after run checkbox.

The dialog box and the Bio-Plex Manager status bar indicate the current platform temperature. The status bar also indicates whether the heater is turned on.

Figure 33. Status bar indicating the heater is on

If the heater is in the process of warming up or cooling down, the temperature is shown in red. If the heater is on and has reached the specified temperature, the temperature is shown in green. If the heater is off and is at ambient temperature, the temperature is displayed in black.

NOTE: If you initiate a run before the heater has warmed up or cooled down (that is, the temperature is shown in red), you have the option of waiting until the specified temperature is reached or proceeding with the run immediately.
Instrument Information

The array reader continuously monitors its internal temperature, voltage, pressure, and other systems for diagnostic purposes. You can access this information by clicking the Information button on the main toolbar or selecting Information from the Instrument menu.

![Figure 34. Instrument Information dialog](image)

Click the tabs in the dialog to access information about the instrument. See the hardware manual for detailed instrument specifications.

Eject/Retract Plate

The Eject/Retract Plate command on the main toolbar and Instrument menu ejects and retracts the plate carrier in the microplate platform.

Note that every function that requires insertion of a plate into the platform (for example, startup, wash, calibrate, etc.) includes an Eject/Retract button in its dialog box.

Additional Instrument Functions

The Additional Functions submenu under the Instrument menu contains secondary instrument fluidics functions. Selecting one of these commands opens a dialog box to guide you through the procedure. Many of these functions require the use of the Bio-Plex MCV Plate IV.
NOTE: Major fluidics functions, such as Wash Between Plates, Remove Bubbles, and Unclog, consist of combinations of the following functions. To perform each of the following functions, select it from the Additional Functions submenu of the Instrument menu and follow the steps in the dialog box that appears.

WASH

The Wash command performs a single fluidics system wash using distilled or deionized water. It can be used to remove traces of sample in the fluidics pathway. Note that this procedure is less comprehensive than Wash Between Plates (page 38).

DRAIN

This command completely drains the fluidics system of the array reader—for example, if you need to move the instrument. Make sure you have enough room in your waste fluid container to prevent overflow.

PRIME

This command primes the fluidics system with sheath fluid.

SANITIZE

This command performs a comprehensive cleansing of the fluidics system using 10% bleach.

ALCOHOL WASH

This command performs a single fluidics system wash using 70% isopropanol.

ALCOHOL FLUSH

This command performs a comprehensive cleaning of the fluidics system using 70% isopropanol.

BACK FLUSH

This command flushes sheath fluid through the fluidics system in the opposite direction of sample flow, to remove particle obstructions from the cuvette.
Cancel Operation

The Cancel button, located in the status bar at the bottom of the Bio-Plex Manager window, can be used to cancel many of the instrument functions, including calibration, validation, or any of the fluidics functions. Click the Cancel button to cancel the current operation. An alert box prompts you to confirm the cancellation.

Figure 35. Cancel button in the status bar

Shut Down

The shutdown procedure consists of a series of functions designed to clean the fluidics lines and prevent a buildup of debris within the system.

To initiate this process, select Shut Down from the main toolbar or Instrument menu, and follow the instructions in the dialog box.

Figure 36. Shut Down dialog

Instrument Operations Log

Each instrument operation you perform with Bio-Plex Manager is recorded in the Instrument Operations Log. This log is stored in a secure database file called bioplexdata.mdb. By default, this log is saved in the main Bio-Plex Manager application folder on your computer.
NOTES: If you install Bio-Plex Manager 4.0 or later, the data from your existing database (bioplex.mdb) copies into the new database (bioplexdata.mdb). A copy of your old database will remain in the application folder.

This Instrument Operations Log did not exist in Bio-Plex Manager versions before 4.0, so if you are installing Bio-Plex Manager 6.1 over versions earlier than 4.0, no Instrument Operations data will be copied.

To view this log, go to the View menu and select Instrument Operations Log. The log viewer opens.

![Instrument Operations Log Viewer](image)

Figure 37. Instrument Operations Log Viewer

Each instrument operation is listed by date and time. If you are using Bio-Plex Manager Security Edition in Secure Mode, the User and Access Level columns list information about the user who was logged into the application when each operation was performed.

To print the log, click the Print button 🖨️.

To copy the information in the log to the Windows clipboard and paste it into another document, drag your cursor over the rows and columns in the table to select them, and use the Ctrl + C key command to copy the data.
6 Preparing Protocols

Protocol Files

A protocol file contains the parameters of a Bio-Plex Manager™ 6.1 software reading. It specifies the analytes used in the reading, the plate wells to be read, sample information, the values of standards and controls, and instrument settings.

When the reading is complete, the parameters in the protocol file are copied into the Results file, along with the data from the reading.

You can save protocol files and reuse or modify them for other readings. Raw data from the most recent reading is stored in the protocol file, and you can generate a new Results file from this data.

Creating/Opening Protocol Files

To create a new protocol file, click the New Protocol button on the main toolbar or Quick Guide, or select New Protocol from the File menu. A new Protocol window opens.

To open an existing protocol file, click the Open Protocol button on the Quick Guide or main toolbar, or select Open Protocol from the File menu. Locate and select the file using the standard Windows Open dialog.
Standard protocol files have the file extension *.pbx. Secure protocol files, created using Bio-Plex Manager Security Edition, have the file extension *.spbx.

Multi-assay Standard Edition Protocols (see page 56 for more information) have the file extension *.mpbx, and those saved with the Security Edition have the file extension *.spbx.

**NOTES:**
- Secure protocol files can be opened only as read-only files using the Standard (non-Security) Edition version of Bio-Plex Manager.
- Protocol files created or modified by the current Bio-Plex Manager cannot be opened by earlier versions of the software.

You can generate a new protocol file from the settings stored in a Results file (see page 143 for information about Results files). The new protocol may include the data from the Results file or not, depending on the option you select. From the File menu, select New Protocol from Results - Exclude Data, or select New Protocol from Results - Include Data.

### Saving Protocols

To save the settings in a protocol, click the Save button on the main toolbar or select Save from the File menu.

After you have performed a reading (see Running the Protocol on page 108), the data from that reading are also saved with the protocol file. These data are overwritten in the protocol file whenever you rerun the protocol. To preserve the data from multiple readings, you must save separate Results files (see page 144).

Use Save As on the File menu to save a protocol under a different name. You can create a new protocol by opening an existing protocol, modifying the settings, selecting Save As, and specifying a new name for the modified protocol.

### Reducing the File Size of Protocols

Protocol files that include all the data from a reading can be very large (>5 MB). Much of this file size is due to the raw bead event data from the reading, which is used to generate the bead map and histogram displays. If you require a smaller file size (for instance, to send the protocol file via email), you can save a copy of the file without this raw bead event data, but with the other numerical data from the reading intact.
NOTE: We strongly recommend keeping a copy of the original protocol file with the raw bead event data intact. These data are necessary for changing the DD gate range in the Results file, and can also be exported in XML file format from the Results file for further analysis.

In the Save As dialog box, select the Compressed mode checkbox to save the protocol file without the bead map and histogram data. All other data are preserved.

![Save As dialog for protocols](image)

**Figure 38. Save As dialog for protocols**

**NOTE:** This compressed file option is not available for secure protocol files generated using the Security Edition of the software.
Multi-Assay Protocols

Bio-Plex Manager 6.1 has the ability to run multiple assays at one time. You describe each assay, using Describe Protocol, in the same way as describing single assays.

If you have chosen New Multi-Assay Protocol from the File menu, the information you enter for each assay becomes its own tab, as outlined in red in the figure below.

*Figure 39. New Multi-Assay Protocol tabs*

When an assay tab is clicked, the window displays all information connected with the corresponding independent assay.

The assay number of the assay being displayed also appears in the title bar.

Uses for Multi-Assay Protocols

This functionality allows you to test the same, or different, samples with two or more separate assays simultaneously. You can also run the same assay under different conditions; for example, when you are in the optimization phase of assay development.
Multi-Assay Protocols

Creating a Multi-Assay Protocol

1. Choose New Multi-Assay Protocol from the File menu. This action creates two tabs on the left pane, called Assay 1 and Assay 2.
   
2. Enter the protocol settings for Assay 1, then save.
   
3. Click on the Assay 2 tab, currently located at the bottom of the left pane. It will jump to a position under the tab for Assay 1.
   
4. Enter the protocol settings for the second assay into the right hand pane, then Save.

**NOTE:** Results of multi-assay protocols are always stored in separate results files. Each assay results file is stored under its own descriptive name, such as Bio-Plex Pro Human Group II.rbx.

**NOTE:** Choosing the New Results from Protocol command from the File menu will generate results only for the assay that is currently open.

Changing a Protocol from Single to Multi-Assay

A Multi-Assay Protocol can also be created from a single assay protocol.

1. Open the single assay protocol and right click on the Protocol Settings tab in the left pane of the Protocol window.
   
2. Select Add Assay. A message will open telling you that a new Multi-Assay Protocol must be created.
   
3. Select Yes, then complete the protocol settings for each assay.
Protocol Window

The Protocol window steps you through a series of windows.

Figure 40. Protocol window

The buttons are numbered to guide you through defining your protocol:

1. Describe Protocol (optional) [see page 59].
2. Select Analytes [see page 59].
3. Format Plate [see page 68].
4. Enter Standards Info [see page 78].
5. Enter Controls Info [see page 96].
6. Enter Samples Info (optional) [see page 98].
7. Run Protocol [see page 108].
Click each setting button and enter the necessary information, then select the next setting. After all the settings have been specified, you are ready to run the protocol.

**Step 1. Describe Protocol**

The Protocol description window displays when you first open a protocol. (Otherwise, click the Describe Protocol button to display this window.) Entering a description of your protocol is optional.

If you are using the Standard Edition of the software, the Author field contains your computer login name. You can enter a new name in the field, if desired, and a description of the assay reading. If you are using the Security Edition, the field contains your user name, which cannot be changed. Enter a description of the assay reading in the Description field.

The Assay Lot field can be used to maintain a record of the lot number of the assay. If you are using the Security Edition, Supervisor-level users are the only users who can edit the Assay Lot field in the Describe Protocol window. If you want to control the lot number associated with a protocol, enter it on the Describe Protocol window. Then, whenever the protocol is run, the assigned lot number will be associated with the results. If, however, the protocol will be used with different assays, then leave the field blank on the Describe Protocol window. Any users who run the protocol will be able to enter the assay lot number for that particular experiment in the Run Protocol window, and this information gets stored with the results.

Supervisor-level users can change the Assay Lot value in both the Describe Protocol and Run Protocol windows. It is assumed that when a value is entered in the Describe Protocol window, the purpose is to associate a particular lot number with both the protocol and the results, and the Assay Lot field is synchronized in both places. If the Supervisor then changes the value in the Run Protocol window, the value in the Describe Protocol window is updated with this new value.

If you are using the Standard Edition of the software, there is no restriction on who may edit the Assay Lot field when setting up or running the protocol.

**Step 2. Select Analytes**

In this step, you select the analytes that you want reported in the reading.
NOTE: During a reading, the array reader always detects all the analytes in the sample, including any you have not selected. However, analytes that were detected but not selected will, by default, not appear in the final reports and tables. After a reading, you can go back and correct your selections in the Protocol window and/or the Results file, and the detected analytes will appear in the tables.

Click the Select Analytes button to view the analyte selection window.

![Select Analytes window](image)

Bio-Plex Manager groups analytes by panels. Preconfigured panels of analytes are built into the software; these panels correspond to off-the-shelf Bio-Plex assays, and include human, mouse, and rat cytokines and phosphoproteins, plus the newer human angiogenesis, diabetes, isotyping and acute phase assays. You can add to these existing panels of analytes, or create new panels that contain only the analytes you use in your experiments.

Bio-Plex cytokine, phosphoprotein, and total target assays are available as custom-mixed x-Plex™ assays. For repeat sample testing, these multiplex assays are offered in one or ten 96-well plate formats. Select from the current list of available assays, and Bio-Rad will mix and quality-test the coupled beads and detection antibodies to order. You can obtain product information and a catalog number for your custom-designed x-Plex assay by going to www.bio-rad.com/bio-plex/x-plex.

First select the panel of analytes that you want reported, then select the specific analytes.

**SELECTING ANALYTES**

Go to the Panel pulldown menu and select from the list of preconfigured panels. The analytes in the selected panel display in the Available list.
Protocol Window

Each analyte is listed by name and region number. The region number refers to the region of a fluorescent color map used to identify the analyte’s bead set. Each bead set is embedded with specific quantities of two fluorescent dyes; the combination of these fluorochromes, as detected by the array reader, places the bead set within a unique region on the color map, thereby identifying the set and its associated analyte.

To move an individual analyte into the Selected list, double-click it. Double-click an analyte in the Selected list to move it back.

Hold down the Shift or Ctrl key and click multiple analytes in the Available list to select them as a group. Then click the Add >> button to move them over to the Selected list. Use the << Remove button to return multiple selected analytes back to the Available list.

Use Add All >> to move all the available analytes into the Selected list, and << Remove All to move them back.

Figure 42. Selecting the analytes to be reported

**NOTE:** Some analytes share the same region. Only one analyte per region can be added to the Selected list.

**CUSTOMIZING ANALYTES AND PANELS**

Bio-Plex Manager comes preconfigured with a selection of panels and analytes that Bio-Rad provides as Bio-Plex assays. You can edit these and/or create new ones.

**NOTE:** If you have assay kits for analytes that are not included in Bio-Plex Manager, you must add these analytes using the commands described in this section.
CREATING A NEW PANEL OF ANALYTES

Click the Add Panel button in the Select Analytes toolbar to create a new panel of analytes.

![Add Panel dialog box]

Enter a name for the new panel in the top field. Select the matching Assay type from the Assay drop-down menu, which is used to ensure the correct defaults. Then click Add to add the analytes. The Add Analyte dialog box opens.

![Add Analyte dialog box]

**Figure 43. Creating a new panel of analytes**

**Figure 44. Adding a new analyte**

Enter the bead region number of the first analyte in the Region field, and the analyte name in the Name field.

**NOTE:** The bead region number must be correct for proper detection of analytes. Confirm this number is correct before proceeding.

Click Add Continue to add the analyte to the panel and continue adding more analytes. When you have entered your last analyte, click the Add button to add it to the list and close the Add Analyte dialog.

After you add several analytes to the panel you are creating, you can use the Sort buttons at the bottom of the Add Panel dialog to sort them.
Click an analyte in the list to select it, then click the appropriate arrow to move it up or down in the list.

**Figure 45. Sorting analytes**

You can also remove an analyte from the list by selecting it and clicking the Remove button, or you can remove all analytes, by clicking the Remove All button.

To edit an analyte in the list, select it, then click the Edit button. A dialog box opens in which you can change the analyte region and name.

When you are finished creating the panel, click OK to save your changes and return to the Protocol window.

**IMPORTING A PANEL OF ANALYTES**

Follow these steps to import a new panel.

1. Open Excel and create a Regions and Analytes list as shown. You may choose to include the Panel name, as shown, or omit it.

2. Save this as a CSV file by choosing Save As from the File menu. Choose CSV (MS-DOS) from the Excel Save as type drop-down list.

**Figure 46. Saving a CSV File in Excel**
3. Import this CSV file into Bio-Plex Manager by choosing the import button in the Add Panel dialog.

![Add Panel Dialog Box](image1)

**Figure 47. Add Panel Dialog Box**

4. Navigate through your file system to where you have saved the CSV file.

5. Click on the file to highlight, and press the Open button.

![Importing the CSV File](image2)

**Figure 48. Importing the CSV File**
6. The new panel will be added to the list of panels in Bio-Plex Manager.

![Add Panel dialog box](Figure 49. Imported Panel)
EDITING A PANEL OF ANALYTES

To edit an existing panel of analytes, first select it from the Panel pulldown menu in the Select Analytes window. Then click the Edit Panel button. The Edit Panel dialog box opens.

![Edit Panel dialog box]

Figure 50. Editing a panel

Use the New, Edit, Remove, Remove All, and Sort buttons as described on the preceding pages to change the analytes in the panel.

If you change the Panel Name, the changes are saved under the new name, and the old panel will not be overwritten.

**NOTE:** The preconfigured Bio-Plex panels (Human Cytokines, Mouse Cytokines, etc.) can be edited but not overwritten; therefore, you must change the panel name to preserve your changes. When you are satisfied with your changes, click OK.
DELETING AND RENAMING CUSTOM PANELS

To delete a custom panel of analytes:
1. Select it from the Panel pulldown menu in the Select Analytes window.
2. Click the Remove Panel button  You are asked if you are sure you want to delete the panel.

Figure 51. Delete Panel Alert

To rename a custom panel of analytes:
1. Select it from the Panel name pulldown menu.
2. Click the Rename Panel button  .
3. Enter a new name in the pop-up dialog box, and click OK.

Figure 52. Rename Panel Dialog

COMBINING PANELS OF ANALYTES

To combine entire panels of analytes (for example, Human Cytokines I and Human Cytokines II) without going to the trouble of creating custom panels:
1. Select the panels individually from the pulldown list.
2. Use the Add All>> command to move the analytes from each panel into the Selected list.
3. Save the entire protocol as you would normally.

Your analyte selections are saved when you save the protocol.
Step 3. Format Plate

After you have selected analytes, you are ready to specify the format of your 96-well microtiter plate using the plate template in the Protocol window. The formatting in the plate template tells the array reader which wells to read, and tells Bio-Plex Manager how to analyze the different sample types in each well.

**NOTE:** Only formatted wells will be read by the array reader. Be careful to format all the wells that you want to read before running a protocol.

Click the Format Plate button in the Protocol window to display the plate template and the formatting controls.

![Plate Formatting view](image)

**Figure 53. The plate template and formatting toolbar (Plate Formatting view)**

The Format Plate window has two views: the Plate Formatting view and the Plate Groupings view. You can toggle between the views using the tabs above the plate diagram. As you toggle, the plate template remains the same, but the commands toggle between formatting controls and grouping controls.

- Plate formatting tools are used to define the types of wells in a plate (sample, control, standard, blank, etc.)
- Plate groupings tools are used to organize the well types into groups, with one member of each group defined as the Reference (or Primary) member, as in a Western blot kinase assay. The ratio of each member’s fluorescent intensity to the fluorescent intensity of the Reference can then be calculated.

**NOTE:** Plate formatting is required to perform a reading, because the array reader will read only formatted wells, whereas plate groupings are optional and can be defined later.
PLATE FORMATTING

To format the well types on the plate, select the Plate Formatting tab. Then use the buttons on the toolbar above the plate template to define the wells on the microtiter plate. These formatting commands are also located on the Format Options menu.

Figure 54. Plate formatting tools (Plate Formatting view).

The different well types you can select are:

- Unknown sample
- Standard
- Control
- Blank
- Undefined*

*Remember that all undefined wells are not read by the array reader.

DEFINING UNKNOWN SAMPLE WELLS

To define wells containing unknown samples, first click the Unknown Sample button , then click or drag the wells in the template. Use the Autofill buttons as described on the following page for defining multiple unknown wells and/or replicate groups of unknowns.

Figure 55. Defining unknown sample wells
Note that the cursor changes to an Unknown Sample cursor as you move it over the template. As you select each well, it is marked with a square and a number at the center. The square identifies the well as containing an unknown sample, and the number identifies the specific sample.

The Set Number of Unknown Samples command is available only in the Security Edition of the software. For more information about the Security Edition, see the Appendix on page 219.

**WELL NUMBERING AND REPLICATE GROUPS**

For unknowns, standards and controls, wells with different numbers contain different samples. Wells with the same number contain the same sample, and are defined as a replicate group. For each replicate group, a mean value is calculated in the Report table, along with the standard deviation and coefficient of variation.

**AUTOFILLING WELL NUMBERS**

To define multiple single wells as different samples, you can click them individually, or select Autofill Across or Autofill Down and drag the cursor over the wells to number them sequentially.

*Figure 56. Defining multiple sample wells with Autofill*

Note that Autofill Across numbers the wells sequentially left to right, then top to bottom, while Autofill Down numbers them sequentially top to bottom, then left to right.
DEFINING A REPLICATE GROUP

To define multiple wells as a replicate group, select Turn Off Autofill from the formatting toolbar or Format Options menu, then drag your cursor over several wells that contain the same sample. The wells are labeled with the same number.

Figure 57. Defining a replicate group of unknowns

For each replicate group, a mean value is calculated, along with the standard deviation, standard error, and coefficient of variation.

AUTOFILLING REPLICATE GROUPS

If you have multiple replicate groups of wells in rows or columns, you can autofill these by selecting Autofill Across or Autofill Down as before, and then entering the number of wells in the replicate group (up to 96) in the number field next to the autofill buttons. (You can also select well numbers up to 10 from the pulldown menu.)

Figure 58. Entering the number of replicate wells in an Autofill sequence

Now when you drag your cursor, the sequential sets of replicate wells are defined.

Figure 59. Autofilling a sequence of replicate groups

For each replicate group, a mean value is calculated, along with the standard deviation, standard error, and coefficient of variation.
CHANGING A REPLICATE GROUP

To change the replicate group of a well or group of wells:

1. Click the Select tool, and click or drag the wells you want to change. The wells appear highlighted.
2. Right-click the selection, and select Set Replicate Group from the context menu.
3. In the pop-up box, select the desired replicate group number from the pulldown list.
4. Click OK. The selection is changed to the specified group number.

Figure 60. Selecting a different replicate group

RESEQUENCING WELL NUMBERS

If your well numbering is out of sequence and you want to correct it, select Resequence Well Names from the Format Options menu. All the wells in the plate are renumbered sequentially, based on whether you have selected Autofill Across or Autofill Down. This is a cosmetic change, and does not affect the analysis in any way.

DEFINING STANDARD WELLS

Standard wells contain analytes of known concentration, which are used to generate a standard curve of fluorescence intensity versus analyte concentration. The regression equation for the curve is then used to calculate the concentrations of your unknowns.
Protocol Window

To define the wells containing standards in your microtiter plate, click the Standard button , then click or drag the wells in the template. Use the Autofill buttons as described on page 70 to define multiple standard wells and/or replicate groups of standards.

![Figure 61. Defining a row of standard wells](image)

**NOTES:**
- The cursor changes to a Standard cursor as you move it over the template. Standard wells are marked in the template by a circle with a number inside it.
- After you have defined the standard wells, you are ready to enter the concentrations of the standards as described on page 91.

**DEFINING CONTROL WELLS**

Control wells contain samples of known concentration; the expected vs. observed concentrations of the controls can be calculated at the end of the reading.

To define the wells containing controls in your microtiter plate, click the Control button , then click or drag the wells in the template. Use the Autofill buttons as described on page 70 to define multiple control wells and/or replicate sets of controls.

![Figure 62. Defining a row of control wells](image)
Note that the cursor changes to a Control cursor as you move it over the template. Control wells are marked in the template by an octagon with a number inside it.

**NOTE:** After you have defined the control wells, you are ready to enter the concentrations of the controls as described on page 96.

### Defining Blank Wells

In certain types of assays such as the Bio-Plex phosphoprotein assay, it may be useful to subtract the assay background from the readings of standards, controls, and unknown samples. To do this, you can prepare “blank” wells containing all the assay components except sample. Wells prepared as blanks are read along with the rest of the assay, and then Bio-Plex Manager subtracts the mean background reading of these wells from the fluorescence intensity values of the wells containing standards, controls, and unknowns.

To format blank wells in the plate template, click the Blank button, then click or drag the blank well(s) in the template. Note that the cursor changes to a Blank cursor as you move it over the template.

![Figure 63. Defining a row of blank wells](image)

Blank wells are marked in the template with a diamond shape containing the letter B.

Multiple blank wells in a template are treated as a single replicate group. A mean value, standard deviation, standard error, and coefficient of variation are calculated for the group, and the mean is used as the background value.

### Deleting or Changing Well Formatting

To delete the formatting from a well or set of wells, select Undefined from the toolbar or Format Options menu, then click or drag the well(s) you want to clear. To clear the formatting from all wells in the template, select Clear Plate from the Format Options menu. To change the formatting of a well or group of wells, simply select the appropriate tool and overwrite the old formatting, as if you were defining the wells for the first time.
Plate Groupings

After you have formatted the wells (see previous section), you can organize them into groups and identify one member of each group as the Reference, or Primary member. You can then calculate the ratio of each member’s fluorescence intensity to the fluorescence intensity of its Reference. This type of analysis is similar to that performed in Western blotting.

Click the Plate Groupings tab to display the plate grouping tools.

![Plate Groupings view](image)

**Figure 64. Plate Groupings view**

The buttons on the toolbar are used to group the wells on the microtiter plate diagram and identify the Reference well(s). These formatting commands are also located on the Format Options menu.

![Tools in the Plate Groupings view](image)

**Figure 65. Tools in the Plate Groupings view**

First, select the ratio you want to calculate for each group — Reference/Member or Member/Reference — using the Ratio field pulldown list.
DEFINING A GROUP

To define an assay group, click the Group button and drag the cursor across the wells you want to group.

NOTES:
- Wells must be defined as Unknown samples, Standards, Controls, or Blanks before they can be grouped.
- You can group across well types (for example, a single group can include Standards, Unknown samples, Controls, and/or Blanks).
- Replicate wells are automatically placed in the same group (even if you drag over only one well in the replicate set).

Figure 66. Defining a group of wells

The grouped wells change color to indicate their grouping, and the first member of the group is highlighted to indicate that it is defined as the Reference well.

Each group you create will be designated with a different color.

To remove individual members of a group or the entire group, click the Ungroup Samples button and click or drag over the members/group.

Note that you can also use the Select tool to first select a group of wells, and then use the Set Sample Group command on the Format Options menu or context menu to select the group.
CONTEXT MENU

Right-click and drag over a number of formatted cells to bring up a context menu, that allows you to change several settings, including dilution factor, replicate group, and sample description.

![Context Menu Diagram](image)

Figure 67. Right-click context menu

DEFINING THE REFERENCE

To change the Reference member of the group, click the Reference button and click the desired Reference member in the group. For replicates, all replicate wells of the same number within the group are automatically designated as the same Reference.

You can also use the Select tool to first select the Reference well within a group and then use the Set Sample as Reference Member command on the right-click context menu to set the Reference.

PRINTING THE PLATE FORMAT

To print the plate format for your records, select Print from the File menu, or click the Print button on the main toolbar. For a preview of the printed format, select Print Preview from the File menu.
Step 4. Enter Standards Info

This section describes how to enter information about your standards. To enter information for standard wells defined on the current plate, make sure the Standards Info tab is selected.

Standards are analytes of known concentration. They are used to generate a standard curve of values using one of the several regression methods built into Bio-Plex Manager. This curve is used to calculate the concentrations of your unknowns.

The standards you select depend on the performance characteristics of your assay, and the type of curve-fitting model you want to use. Due to variations in assay preparation, we recommend using a minimum of eight standard concentrations to generate the standard curve. See the appropriate Bio-Plex Assay Instruction Manual for recommendations of standard concentrations. To see what manuals are available, visit www.bio-rad.com/bio-plex.

The minimum number of non-zero standards required for each type of regression method available in the software is shown in the following table.

<table>
<thead>
<tr>
<th>Method</th>
<th>Minimum number of standards</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logistic-5PL</td>
<td>6</td>
</tr>
<tr>
<td>Logistic-4PL</td>
<td>5</td>
</tr>
<tr>
<td>Cubic spine</td>
<td>4</td>
</tr>
<tr>
<td>Linear (linear and semi-log)</td>
<td>2</td>
</tr>
<tr>
<td>Point to point (linear and semi-log)</td>
<td>2</td>
</tr>
</tbody>
</table>

Before entering the concentration values of your standards, you must select the analytes that you will be analyzing in the reading as described on page 59. If your current plate contains your standards, you must also identify the standard wells as described on page 72.
Click the Enter Standards Info button in the Protocol Settings pane to enter information about your standards.

Figure 68. Entering information about standards

The Enter Standards Info window allows you to define standards on your current microtiter plate, and/or import external standards data from another plate. Use the tabs above the data fields to select between standards on the current plate and external standards.

NOTE: You can define standards on the current plate and import external standards in the same protocol. This is useful if you want to run standards for some analytes on the current plate, but include external standards for other analytes in your concentration calculations. Note that if external standards and current standards are defined for the same analyte, the external standards will always be used to calculate the concentrations of that analyte.

**Standard Lots**

You can create, reuse, and import standard lots to ensure repeatable results between experiments and/or researchers in a workgroup.

This function eliminates the need for you to enter or re-enter this data manually.

Click the Enter Standards Info button in the Protocol Settings pane. Choose the Standards Info tab.
The Standard Concentration Lot window is at the top of the screen.

**LOADING A STANDARD LOT INTO YOUR PROTOCOL**

If you have previously saved a standard lot or it is otherwise present in your current version of Bio-Plex Manager, you can quickly load it into your protocol by using the load function.

This will result in the following window which will display all the lots loaded into your version of Bio-Plex Manager. Choose the lot you want to use and press OK. This will load the concentration and dilution information associated with this lot.
MANAGING STANDARD LOTS

You can import new lots, export lots to collaborators, or delete lots on your Bio-Plex Manager by using the Manage Standard Lots function.

Figure 72. Manage Standard Lots
Pressing the Manage Standard Lots button brings up a dialog that allows you to import, export and delete standard lots.

Figure 73. Manage Standard Lots screen

Importing Standard Lots—Standard lots will be added continually to the Bio-Rad web site, which can be accessed in the help menu of Bio-Plex Manager. Download the lot file (which is in XML format) from the web site to your PC and then choose Manage Lots (above) and press the Import button from the resulting window. You can import all or a subset of the lots present in this file.

Exporting Standard Lots—You can export all or a selected number of lots to collaborators by pressing the Export button. When you export the lots they are saved in an XML format which can be sent to other users of Bio-Plex Manager for import.

Deleting Standard Lots—Unneeded standard lots are deleted by pressing the Delete button.
ENTERING STANDARD LOTS MANUALLY

If your lot is not preloaded in the software or you cannot find it on the Bio-Rad website, you can enter the information manually from the product insert. You can save any manually entered standard information as a new standard lot, as described above.

Kits fall into two categories; those which have various starting concentrations and those which have the same starting concentration for each analyte.

When starting concentrations vary across all analytes—There are a number of ways to edit values and apply dilutions. The following outlines the most efficient approach.

1. Enter the starting concentration of each analyte directly in the spreadsheet within the interface. Enter each analyte before proceeding to the next step. Make sure the “Apply same concentration to all analytes” box is unchecked (default)
2. Once each analyte's starting concentration is entered, apply the dilution factor which is appropriate for your experiment.

Figure 74. Applying the Dilution Factor

3. The software will calculate all the concentrations for each analyte at each dilution, as seen below.

Figure 75. Bio-Plex Manager calculates concentrations
When starting concentrations are the same across all analytes—follow the following steps.

1. Check the box next to Apply same concentration to all analytes. This is not the default setting.

2. Enter the starting concentration in the box indicated in the image below.
3. Enter the dilution factor and press calculate.

4. The software calculates all the concentrations for each analyte and at each dilution, as seen below.
**DELETING STANDARDS**

To delete your Standards entries, click in the spreadsheet title called “Std” to highlight all entries as shown below. Press the Delete button on your keyboard.

![Deleting Standards Entries](image)

*Figure 76. Deleting Standards Entries*
SELECTING EXTERNAL STANDARDS

This section describes how to select a Results file from which to import external standards data into a protocol.

Click the Select External Standards tab. In the window, click the Fill Available List button, navigate to the directory containing the Results file with your standards of interest, and select the file. (Note that the Open dialog displays only Results files.)

To delete all standards from the Available list, click the Clear Available List button.

To make the available external standards accessible in the current protocol, you must add them to the Selected External Standards list (right-hand pane). To add all of the standards in the Available column, click the Add All>> button. To add available standards individually, double-click them, or select multiple analytes using Shift + click and Ctrl + click key combinations and click the Add>> button.

(Use the <<Remove and <<Remove All buttons to deselect them.)
NOTE: Each external standard you select must match the region of a selected analyte in the protocol. For example, if you selected analytes in regions 19, 32, 52, and 73 in the Select Analytes window (page 59), you can select only external standards in those same regions. (Note that the analyte name does not have to match, only the region.) Also, each analyte must come from a different region.

When you are finished, the Selected External Standards list should include all the analytes that you want to use as external standards, and their source file(s).

![Figure 78. Selected external standards](image)

Click the External Standards Info tab to enter additional information about your external standards.
NOTE: The Standards Info and External Standards Info tabs contain the same fields, but you cannot alter the concentrations under the External Standards Info tab (they appear grayed out), as shown in Figure 79.

Figure 79. Standards Info window (top) and External Standards Info window (bottom)
The analytes that you selected in the Select Analytes window appear in the Assign Standards Information table. The most efficient method for entering standard concentrations is to enter them directly into the table. Enter the highest concentration into the first row for each analyte.

Figure 80. Selecting a standard analyte

**NOTE:** For the settings described on the following pages, you can select different settings for each analyte, or select the same settings for all analytes.

Use the controls shown in the red rectangle to access your standard lots.

To save a Standard Lot for reuse, name it and enter an expiration date, if required. The calendar under the Expiration Date pulldown menu enables you to set a specific date.

**Save** places your new Standard Concentration Lot into the Load Standard Lot window so it can be reused.

**Figure 81. Load Standard Lot window**

**Load** . . . brings up the Load Standard Lot window so that you can choose between previously-saved standard lots.

**Manage Standard Lots** . . . brings up the Manage Standard Lots window that allows you to import or export your standard lots. You can also select any number of Standard Lots for deletion.
ENTERING CONCENTRATIONS
(FOR CURRENT STANDARDS ONLY)

To calculate them automatically from a dilution series, select Enter Automatically.

Enter the high standard concentration (S1) into the first row of the table, for each analyte. Then select the Dilution Factor, check the Apply dilution to all analytes box, and click Calculate. The table fills with the standard concentrations.

If you are using external standards, the concentrations are automatically entered, and you can skip to the next section on selecting concentration units (page 93). To enter concentrations, make sure the Standards Info tab is selected.

ENTERING CONCENTRATIONS MANUALLY

You can enter your concentrations manually. The table lists your standard wells (S1, S2, S3, etc.) These are the wells that you defined in the Format Plate window (page 68). For the selected analyte, enter the concentration for each standard in the concentration column.

If the Apply same concentrations to all analytes checkbox is selected, the concentration values you enter are applied to all the analyte standards. Deselect the checkbox if you want to enter different concentrations for each analyte standard.

You can also enter additional information about your standards in the description column for each well.

NOTE: You can use the Cut, Copy, and Paste commands on the Edit menu to copy your descriptions and concentrations among analytes. You can also copy and paste from and to other applications, such as Microsoft Word or Excel. Click a cell, row, or column in the table to copy and paste.

If you are entering different concentrations for each analyte standard, repeat the procedure by selecting each analyte from the pulldown menu as described above.
CALCULATING CONCENTRATIONS AUTOMATICALLY

If a dilution series was created for the standards, the software can automatically calculate the concentrations of each standard.

1. Select the appropriate Most Concentrated Standard well number. (The most concentrated standard must be in either the first standard well or the last.)

2. Enter the concentration of the most concentrated standard in the Concentration of S1 field and the dilution factor for the remaining standards in the Dilution Factor field.

NOTE: Calculations are made by dividing by the dilution factor, so do not enter fractional values for the dilution factor. If each standard is half the concentration of the previous standard, enter 2 for the dilution factor. If each standard concentration is one-fourth the previous, enter 4, and so on.

3. Click the Calculate button when all the information is entered. The concentrations in the table are automatically updated.

If the Apply same concentrations to all analytes checkbox, below the concentrations table, is selected, the concentration values are applied to all the analyte standards. Deselect the checkbox if you want to enter different concentrations for each analyte standard, and repeat the steps.
CONCENTRATION UNITS

You can enter the units of concentration in the Concentration Units field (units are not required and do not affect calculations). These units appear in your reports. If all your analytes have the same concentration units, select the Same Units for All Analytes checkbox.

REGRESSION METHODS

Using the Std Regression Curve pulldown list, choose from among seven different regression methods to generate the standard curve (page 168):

- Logistic-5 PL
- Logistic-4 PL
- Linear
- Cubic spline
- Point to point
- Linear (semi-log)
- Point to point (semi-log)

Figure 84. Selecting a regression method

You can change your selection later in the Standard Curve window of the Results file. See page 170 for a more detailed discussion of regression methods.

You can also select the regression-curve axis scale from four different combinations of linear and logarithmic scales. Select the axis scale from the Axis Transformation pulldown list.

Figure 85. Selecting a regression-curve axis transformation

Note that the axis transformation only changes how the curve is displayed, not the calculated values.

NOTE: The regression method and axis transformation you select in the Protocol window is used to calculate your initial results. However, these settings do not affect the reading, and you can change these settings and recalculate your results after a reading is complete.

Finally, if you want to use different regression methods for different analytes, deselect the Same Regression Type for All Analytes checkbox. Then, when you select a different analyte from the pulldown list, you can select a new regression method as well.
LOGISTIC WEIGHTING

If you select a logistic curve fitting method (Logistic-5PL or Logistic-4PL), the software automatically weights the points in the curve. Click the Logistic Weighting button to access the weighting algorithm controls.

Figure 86. Logistic Weighting dialog

There are eight models for calculating the variance in the logistic weighting algorithm:

- Linear Variance
- Logarithmic Variance
- Exponential Variance
- Power Law Variance (default)
- Linear CV
- Logarithmic CV
- Exponential CV
- Power Law CV

COEFFICIENT A

Weighting coefficient $a$ will be calculated automatically using the following equation:

$$ a = .002 \times \text{pow} \left( \frac{m_{YMax} + m_{YMin}}{2} + \text{blank},.2 \right) $$

Alternatively, you can enter your own value by deselecting the Auto calculate coefficient $a$ checkbox and entering a value in the Coefficient $a$ field.

COEFFICIENT B

Weighting coefficient $b$ has a default value of 1.8. You can enter a different value in the Coefficient $b$ field.
RECOVERY PERCENTAGE RANGE

Because the standard curve (page 168) is critical for calculating the concentrations of your unknowns, Bio-Plex Manager includes a mechanism for assessing the fit of the curve to the standards. This is the recovery percentage. See Standard Curve Optimizer on page 199 for how Bio-Plex Manager incorporates Recovery Range data automatically.

For each analyte standard, an observed concentration is back-calculated from the standard curve and the fluorescence intensity. This is divided by the expected concentration as entered in the Enter Standards Info window and multiplied by 100 to give the recovery percentage:

\[
\text{Recovery percentage} = \frac{\text{Observed conc}}{\text{Expected conc}} \times 100
\]

Recovery percentages are also used with controls (page 96) to determine the overall accuracy of an assay.

In the Enter Standards Info window, use the Acceptable Recovery Percentage Range pulldown menu to select an acceptable recovery range.

![Acceptable Recovery Percentage Range](image)

*Figure 87. Selecting the recovery percentage range*

For example, if you select a range of 70 to 130%, the observed concentration should be within 70 to 130% of the expected concentration.

The actual recovery rate for each standard and control is shown in the Obs/Exp * 100 column of the Report table (see page 160). Unknown concentrations that fall in regions of the curve where standards fall outside the selected range will be reported as OOR< or OOR> in the Conc in Range column of the Report table. (See Report Table Error Codes on page 234.)
Step 5. Enter Controls Info (Optional)

Controls are samples of known concentration whose values are measured during a reading in the same manner as the unknown samples. You can then compare the calculated concentrations of the controls after a reading with the expected concentrations to determine the overall accuracy of the assay. (This is sometimes called the "spiked" recovery method, because you are "spiking" your assay with known quantities of analytes.)

In this step, you enter the concentration values of your controls. First, you must select the analytes you will be analyzing in the reading as described on page 59, and identify the plate well(s) containing your controls as described on page 73.

NOTE: Only formatted wells are read by the array reader. Be sure to define all your control wells before running a protocol.

Click the Enter Controls Info button in the Protocol window to enter information about your controls.

![Figure 88. Enter Controls Info dialog](image)

The analytes you selected in the Select Analytes window are available under the Analyte pulldown menu. Select the first analyte for which you want to enter controls.
The table lists your control wells (C1, C2, C3, etc.). These are the wells that you defined in the Format Plate window (page 68). Enter the concentration of the selected analyte in the Conc column for each well.

If the Same Conc. Values for All Analytes checkbox is selected, the concentration values you enter are applied to all the available control analytes. Deselect the checkbox if you want to enter different concentrations for each control analyte. You can enter additional information about your controls in the description column for each well.

If you are performing a dilution of your controls, you can enter a dilution factor for each control in the Dilution column. Note that a control diluted 1 in 2 would have a dilution factor of 2. This feature allows for parallelism studies, whereby a control diluted by different dilution factors is analyzed to verify that the final concentration is the same for all samples.

If you are entering different concentrations for each analyte standard, repeat the procedure by selecting each analyte from the pulldown menu as described above.

To enter the same dilution factor for all controls, enter the value in the Dilution Factor field, and click the Set All Dilution Factors button. The dilution factor you enter for one analyte is automatically applied to all analytes.

**NOTE:** You can use the Cut, Copy and Paste commands on the Edit menu to copy your descriptions, concentrations, and/or dilutions between analytes. You can also copy and paste from and to other applications such as Microsoft Word or Excel. Click a cell, row, or column in the table to copy and paste.
Step 6. Enter Sample Info (Optional)

Before entering information about your unknown samples, select the analytes you are analyzing in the reading, as described on page 59, and then define the plate well(s) containing your unknown(s), as described on page 69.

NOTE: Only formatted wells are read by the array reader. Be sure to define all your unknown sample wells before running a protocol.

Click the Enter Sample Info button in the Protocol window to enter information about your unknown samples.

Figure 91. Enter Sample Info dialog

The information table lists all the unknown sample wells as defined in the plate template for the reading (page 69).

You can enter a description and a dilution factor for each unknown in the appropriate columns. Note that a sample diluted 1 in 2 would have a dilution factor of 2. To enter the same dilution factor for all unknowns, enter the factor in the Dilution Factor field and click the Set All Dilution Factors button.

NOTE: You can use the Cut, Copy, and Paste commands on the Edit menu to copy your descriptions and/or dilutions from and to other applications such as Microsoft Word or Excel. Click a cell, row, or column in the table to copy and paste.
7 Running Protocols

After you have prepared the Protocol as described in the previous chapter, you are ready to run it.

Click the Run Protocol button in the Protocol window to select the final settings and run the Protocol.

WARNINGS:

- When performing the following operations, the sheath fluid container and the waste fluid container should be closely monitored.
- The sheath fluid bottle must be placed at the same level as the array reader, unless you are using the HTF (High-Throughput Fluidics). (see the next Warning). The fluid level should be below the air inlet connection and above the sheath outlet connection. For more information, refer to the Bio-Plex 200 System Hardware Instruction Manual. Always check the sheath fluid level before starting a run or procedure.
- If you are using the HTF, it should sit on the counter next to the array reader, while the sheath fluid cube should be placed ~3–4 feet below the reader (for example, on the floor).
- The waste fluid container receives waste from the system. Do not allow the waste container to overflow. Empty the waste bottle each time the sheath fluid bottle is filled. Do not place it on the instrument. All waste containers should have vented caps.
Run Protocol Window

The Run Protocol window has controls for performing the run, and two views for displaying the status of the run: the Raw Data table view and the Histogram/Bead Map view.

Click the Show/Hide Histogram/Bead Map button to display only the Raw Data table, or the histogram/bead map display with the Raw Data table below it (maximize the window to see both the table and the display).

![Run Protocol window—Raw Data table view](image1)

![Run Protocol window—Histogram/Bead Map view](image2)

The Histogram and Bead Map (see page 111) provide graphical data about a run, and are continually updated throughout the run. The Raw Data table (see page 119) displays the raw data of the reading after it is complete.

The controls for performing the run are described in the following sections.
Bead Count

The Beads field in the Run Protocol window lists the number of beads to be detected before a reading is complete. Note that this number can be beads detected per region or total beads detected, depending on the pulldown selection.

If you select per region as the counting method, you can enter a number between 1 and 10,000 in the Beads field. For most assays, including the Bio-Plex cytokine assay, we recommend a value of 50 beads per region. This ensures that at least 50 beads in each region will be acquired before sample acquisition is complete. If the region has less than 25% of the specified beads per region or there are fewer than 20 beads (whichever number is greater), a low bead warning is triggered. If you specify a bead count that is less than 20, then a low bead warning is triggered any time the bead count is less than the specified number.

If you select total as the counting method, you can enter a number between 1 and 100,000 in the Beads field. Note that if you choose to measure total beads, the instrument will stop acquisition as soon as it has acquired the total number of beads in any combination of bead sets. If you are detecting multiple analytes, this means that some bead sets may be under represented in the final tally.

NOTE: For the Bio-Plex™ phosphoprotein assay, we recommend specifying 25 beads per region to avoid triggering a low bead count warning.

Sample Timeout

The Sample Timeout field works in conjunction with the Beads field to ensure that a well reading does not continue for an extended length of time. If the specified bead count in the Beads field is not reached for a particular well (that is, because the well does not contain all of the selected analytes), the array reader will continue the well reading until the time limit specified in the Sample Timeout field. If no Sample Timeout is specified, a default time based on the sample volume is used.

You can enter a time limit in seconds from 0 to 200, or make a selection from the pulldown list. Select <none> or enter 0 if you want no time limit. The Sample Timeout value for each well will be noted in the Raw Data table.
Reservoir Functions

The Bio-Plex Manager™ 6.1 software reservoir functions allow you to incorporate standard maintenance processes directly into the Run Protocol. This enables you to perform the Run Protocol without needing to replace the microplate with the MCV plate. The maintenance processes you can select with the Reservoir Functions window are:

- Wash
- Wash between plates
- Prime
- Drain
- Back flush
- Sanitize
- Alcohol wash
- Start up
- Shut down
- Remove bubbles

NOTE: Two of the most common functions users want performed after the plate is run are Shut Down and Wash Between Plates. For users’ convenience, these functions can also be selected directly from the Run Protocol window.

These functions are available to the Protocol before the run and after the run. When running the Protocol, the status bar indicates which function is in process.

Figure 94. Reservoir Functions dialog
Skip Functions

The Run Protocol - Reservoir Functions window contains a drop-down menu that allows you to skip reservoir functions built into existing Protocols when they are not necessary.

For instance, if you have paused to troubleshoot before a plate run, and know that the Protocol calls for the instrument to perform a function you performed manually, you may choose to skip that function in order to save time.

You can choose to skip the following functions:
- Functions that will happen before a plate run
- Functions that will happen after a plate run
- All instrument functions

**NOTE:** If you are running multi-assay Protocols, the reservoir functions can be run between the assays as well.

**NOTE:** Other MCV functions and operations, such as Calibration, Validation, Alcohol flush, and Unclog, require using the MCV plate.

The available volume in the reservoir limits the number of times each function can be performed with a Protocol. The total allowable number of repetitions for each function includes the total of functions selected Before Plate Run, Between Assay Run, and After Plate Run tabs.

The following table shows the total allowable number of repetitions for those individual functions that use reagent from the reservoir.

<table>
<thead>
<tr>
<th>Reservoir Function</th>
<th>Max. # of Operations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wash</td>
<td>20</td>
</tr>
<tr>
<td>Alcohol Wash</td>
<td>6</td>
</tr>
<tr>
<td>Sanitize</td>
<td>2</td>
</tr>
</tbody>
</table>

To access these functions, use the Reservoir Functions button from the Run Protocol dialog.

In the Reservoir Functions dialog, in the Before Plate Run tab, select a function in the Available column and move it to the Selected column by using the right arrow button. Do the same in the After Plate Run and Between Assay Run tabs. You can change the order of the functions by selecting one and moving it up or down with the arrow buttons. Click OK.

To save these settings as the default for future Protocols, select the Save As Default for New Protocol checkbox.
Standard Curve Optimization

When Protocols are run, by default, the software will optimize the fit of the standard curves. This can be turned off from the Run Protocol window, if optimizing is not desired. In Security mode, only users with permissions are allowed to change this setting. For more information on standard curve optimization see Standard Curve Optimizer on page 199.

Advanced Run Settings

Click the Advanced Settings button to access additional reader settings and controls.

![Advanced Run Settings dialog](image)

Figure 95. Advanced Run Settings dialog

Bead Map Selection

Bio-Plex Manager software identifies each bead in an assay by its classification region—that is, the region in the bead map where the bead falls, based on its fluorescence as measured by the classification channels in the array reader (see page 115). The default bead map is the 100-region map, which is appropriate for assays that use xMAP microspheres (such as Bio-Plex assays, most Bio-Plex Pro assays, and Bio-Plex COOH beads). A 25-region map is also available.

The 25-region map includes select regions from the default 100-region map. The result is that the regions are larger and more spread out. The 25-region map is not available when creating a new panel, as it applies only to a specific subset of pre-installed Bio-Rad assays. It will be applied correctly to these preinstalled assays.
**Sample Size**

The Sample Size is the amount of sample that will be aspirated from the microplate well by the reader. The default sample size of 50 μl is recommended. You can specify a sample size as small as 10 μl or as large as 200 μl.

**NOTE:** To avoid air uptake, make sure the sample needle is properly aligned (see page 21) and that each well to be read contains at least 125 μl of sample. The maximum sample volume per well is approximately 140 μl. (The array reader rinses an additional 160 μl into each well after a reading is complete; the maximum well capacity is 300 μl.)

**Save Options**

You can automatically save the Results file generated by the reading. With the Auto Save After Run checkbox selected, when you click Start to begin a reading, you are prompted to enter a name for the Results file.

**NOTE:** In Bio-Plex Manager Security Edition, Secure Mode, this checkbox is selected and cannot be deselected.

If the Auto Save After Run checkbox is selected, you can also select the Auto Export After Run checkbox. With this checkbox selected, Bio-Plex Manager automatically generates an XML file and saves it as specified in the XML Export Properties dialog.

**Sampling Errors**

During a reading, the system continuously monitors the flow of beads, the bead count, the bead regions, and the platform temperature. If the system detects a problem in any of these areas, it can stop the reading and trigger a warning. This feature is enabled if any or all of the checkboxes under Sampling Errors are selected.
Select the Pause Run If Error Occurs checkbox to select all the possible error conditions, or select/deselect the individual error condition checkboxes. By default, these are not selected (that is, the run will not pause for any error condition).

Figure 96. Sampling Errors checkboxes in Advanced Settings window

NOTE: All errors are logged in the Raw Data and Report tables, whether or not the checkboxes are selected (see page 120).

The reading errors and their possible causes are listed in the following table.

<table>
<thead>
<tr>
<th>Error</th>
<th>Possible Cause</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Low bead number</td>
<td>Too few beads in the assay; buffer volume in well is too low; plate was not shaken properly before analysis; microbubbles in the cuvette.</td>
</tr>
<tr>
<td>2. Aggregated beads</td>
<td>Bead clumping in the assay; sheath fluid is empty; waste reservoir is overfull.</td>
</tr>
<tr>
<td>3. Classify efficiency</td>
<td>Microbubbles in the cuvette; beads have become photobleached; percentage of beads outside the selected bead region is too high.</td>
</tr>
<tr>
<td>4. Region selection</td>
<td>Incorrect beads were selected in the Protocol or assay; too few beads are present in the assay.</td>
</tr>
<tr>
<td>5. Platform temperature</td>
<td>Platform temperature has fluctuated ± 2°C during the reading.</td>
</tr>
</tbody>
</table>

*See Troubleshooting on page 215 for a detailed list of reading errors, causes, and suggested solutions.

With the checkboxes selected, the reading stops and an alert box describes the problem and suggests steps for correcting it. After you have performed the suggested steps, you can rerun the reading.

NOTE: If you are rerunning wells in Rerun/Recovery Mode, you may want to disable the Low bead number checkbox, because wells that have already been read once contain fewer beads.
Doublet Discriminator Gates

During a reading, a doublet discriminator (DD) channel measures the amount of light scatter from particles that flow past the red laser. The light scatter is directly proportional to particle size, and an internal DD “gate” is designed to identify particles smaller or larger than a single microsphere, including microspheres that are clumped or aggregated.

In the Advanced Run Settings dialog, the default DD Gates range for the 100-region map is dependent on the type of bead used. For the 5.5 micron, non-magnetic, polystyrene beads the gates are 4335–10000, whereas the gates for the 6.5 micron, magnetic beads are 5000–25000. Some Bio-Rad assays are built on a larger 8.1 micron, magnetic bead which uses DD gates of 5000–32000.

If you are using different-sized beads or want to change the default settings, you can change the size of the gate by selecting the Override Gates checkbox and entering new values in the Low and High fields.

You can also change the range by dragging the red lines on the Run Protocol window histogram (see page 149).

NOTES:

• The values in the Low and High fields are channel numbers corresponding to the amount of light scatter from a particle. If you want to manually change the range, you need to know the approximate channel numbers corresponding to the size of the beads you are using
• You can change the DD gate range in the Protocol before a reading or in the Results file after a reading (see page 113). If you change the DD gate range in the Results file, a record of the range during the reading is preserved
• You can set the gates on only the DD channel, not the RP1, CL1, or CL2 channel
• For Bio-Plex assays or Luminex-type assays from other manufacturers, the default DD gate settings should work well. However, if you are developing your own assay, the position of the DD peak may shift and thus the DD gates may need to be shifted accordingly. Note that you can adjust the DD gate range after a reading in the Results file and reanalyze the data

Plate Loading Guidelines

Before starting the run, note the following plate handling guidelines and warnings:
WARNINGS:

- Protect your assay microspheres from light. Once photobleached, the beads are no longer usable. Proper care of microspheres must be observed to maintain the benefits of your product warranty.
- When using a filter plate, avoid touching the bottom of the wells when wrapping the plate. Sample may wick or leak from the bottom of the well, causing problems when reading the plate.
- Make sure that you have added at least 125 μl of sample to all the wells specified in your plate template before starting a reading. If the array reader attempts to draw sample from an empty well, air is sucked into the sample loop and injected into the flow chamber. As a result, bubbles form in the cuvette and interfere with the analysis. If this happens, perform a Remove Air Bubbles procedure (page 39) and rerun the Protocol.
- Shake the microplate on a plate shaker for 30 seconds prior to performing a reading.

Running the Protocol

1. When you have selected all of your Protocol options and prepared your microplate, click Start.
   The microplate platform automatically ejects.
   NOTE: If you are running the Security Edition, you are prompted to enter your Electronic Signature after you click Start.

   ![Figure 97. Run Protocol dialog](image)

2. Place the microplate on the microplate platform.
Running the Protocol

3. In the Save As dialog, enter the name of the Results file, and click Save. If you selected reservoir functions, the Run Protocol Reservoir Function window opens. If you did not select any reservoir functions, skip to Step 5.

4. In the Run Protocol Reservoir Function window, follow the steps described and choose any functions you want to skip from the Skip Functions drop-down list. Click Next.

5. Check that the needle height is set for the type of plate you are using, either Standard or PCR plate.

6. Enter your user name in the field. If you are using the Security Edition of the software in Secure Mode, your user name will be entered and cannot be changed.

7. Enter the Assay Lot number. If you are using the Security Edition of the software and this field is filled in, only a Supervisor or Service user may change it.

8. If your microplate has a barcode number or other type of ID number, enter it in the Plate ID field.

9. Click OK to begin the reading.

The following conditions may delay the start of a reading:
- If the array reader optics have not warmed up, the reading is delayed until warm up is complete
- If the pressure is too low in the fluidics system, you receive a warning message prompting you to check the sheath fluid level, hose connections, etc.
- If the platform heater is not at the specified temperature, a warning message will appear and you will be prompted to wait for the temperature to reach the specified temperature

When the reading begins, the sample needle lowers, draws sample from a plate well, and retracts to its original position. The sample is drawn from the needle into the sample loop and the reading is taken.

After initial system pressurization (5 to 20 seconds), a typical well reading may take up to 2 minutes; in most cases, individual wells are read in a matter of seconds.
Status Bar

As the sample is analyzed, the status of the reading displays in the status bar at the bottom of the Bio-Plex Manager window.

Figure 98. Status bar during a reading

The status bar provides a running count of both the Number of beads and the Beads per second. Within these categories, the array reader keeps track of the following information:

- The Region fields monitor only those beads that fall within one of the regions you selected in the Protocol (page 60)
- The Gate fields monitor all beads that pass an internal discriminator gate (DD gate range) designed to eliminate particles smaller or larger than a microsphere (including microspheres that are clumped or aggregated)
- The Total fields report all particles measured by the array reader, including those that do not pass the internal discriminator gate

Manually Stopping a Reading

While the sample is being read, the Start button changes to a Stop button in the Protocol window. You can click Stop to cancel the reading. An alert box notifies you that you can generate a report with the incomplete results, or rerun the Protocol as described on page 123.

Generating Results from a Protocol

The reading stops when you click Stop, when an error stops the reading, or when all samples have been analyzed. At the end of the reading, the sample needle lowers and the syringe pump purges the sample loop and needle using sheath fluid. Then it sends a fraction of sheath fluid (approximately 160 μl) back into each well.

At the end of a complete reading, the Results are automatically calculated and displayed.

Note that the Results file automatically is saved if you selected Auto Save After Run (page 105) in the Protocol. Otherwise, you must save your Results as a separate step (see Saving a Results File on page 144).
To generate a new Results file from a Protocol, select New Results from Protocol from the Run Protocol toolbar or the File menu.

### Histogram and Bead Map

The histogram and bead map provide a graphical display of the raw data from a reading. These graphs are continuously updated during the reading in the Run Protocol window of a Protocol file. They also can be displayed after a reading in the Raw Data window of a Results file.

The histogram and bead map share window space with the Raw Data table. If the histogram and bead map are not visible, click the Show/Hide Histogram/Bead Map button to display them.

![Figure 99. Histogram and bead map](image)

You can see some rows of the Raw Data table below the histogram and bead map display if you maximize the window.

During a run, the well number being read is displayed in blue in the upper left corner of the histogram. After the run, select the wells to display by selecting rows in the table below the graphs.
When viewing the histogram and bead map, you can choose to display all analytes, each analyte separately, or all beads that pass through the discriminator gate. Make your selection from the pulldown menu above the histogram.

![Histogram](image)

**Figure 100. Selecting the analyte(s) to display**

To print the histogram and/or bead map, click the Print Histogram/Bead Map button. This opens a small dialog in which you can select the histogram, bead map, or both to print.

**Histogram**

The histogram plots the number of events per channel number for the selected well, analyte(s), and channel type. An event is generated when particles such as a bead or aggregated beads pass through the path of the lasers. Each event generates signals in different channels:

- The fluorochromes embedded in each bead generate signals in the Classification 1 and Classification 2 channels
- The fluorescent molecules bound to the analytes generate a signal in the Reporter 1 channel
- The light scatter of each bead generates a signal in the Doublet Discriminator channel. The amount of light scatter is directly proportional to bead size

The signals are reported as channel numbers. In the histogram, the y-axis represents the events, and the x-axis represents the channel numbers from 1 to 32,766 for the selected channel type.
DOUBLET DISCRIMINATOR GATE RANGE

The Doublet Discriminator (DD) range specified under the Run Protocol Advanced Settings (see page 107) is shown on the histogram as two red lines perpendicular to the x-axis. In the Protocol window, you can change the DD gate range by positioning your cursor over the red lines and dragging them to the right or left. This also changes the range as listed in the Advanced Settings dialog.

NOTE: The DD gate range cannot be changed while the Protocol is running.

Figure 101. Changing the DD gate range

You can show or hide the gate lines by right-clicking on the histogram and selecting Show or Hide from the Gate context menu.

To reset the gates to their default values, click the Restore Default Gates button above the histogram.

SELECTING THE CHANNEL TYPE

You can change the histogram to display different channel types. Click the histogram with the right mouse button and select X-Axis from the context menu.

Figure 102. Histogram right-click context menu

From the X-Axis submenu, select from the following channel types:

- The Doublet Discriminator channel measures the forward light scatter from particles as they pass through the red laser. Light scatter correlates to particle size; this channel allows you to discriminate single beads (“singlets”) from aggregated beads in the histogram. This is the default selection
• The Reporter 1 channel measures fluorescence from the reporter molecules bound to the analytes on each bead as they pass through the green laser. The amount of fluorescence per bead type is directly proportional to the amount of analyte present in the assay. This can be useful for viewing the distribution of the fluorescence signal of a particular analyte.

• The Classification 1 channel measures fluorescence from the first classification dye embedded in each bead as it passes through the red laser.

• The Classification 2 channel measures fluorescence from the second classification dye embedded in each bead as it passes through the red laser.

**NOTE:** Changing the channel type changes the channel numbers and the histogram display.

**SCALING THE HISTOGRAM DATA**

If the histogram is too big or too small to fit comfortably within the display range, click the Auto Scale button on the histogram toolbar. The height of the y axis changes to better fit the data. You can also select this command from the right-click context menu.

Select Set Scale from the right-click histogram context menu to manually set the range of the y-axis. In the pop-up box, enter the maximum number of events to display on the y-axis between 20 and 100,000.

The default view of the data is log scale. From the toolbar, click the Log/Linear button to change the display from logarithmic to linear. Click again to return to log scale.

**MAGNIFYING AND RESIZING THE HISTOGRAM**

Click the Zoom button on the histogram toolbar to magnify the display.

With Zoom selected, the cursor changes to a hand symbol when you position it over the histogram. Drag the hand cursor to view different magnified regions of the histogram.
Click the Maximize button to maximize the histogram portion of the window within the larger Protocol window. Click the Restore button to return the histogram to its default state.

Figure 103. Histogram maximized in the Protocol window

**Bead Map**

The bead color map is a density dot plot of the events in a reading for a selected well. Different colored dots in the map represent different numbers of events at those data points. The number of available regions in the bead map (25 or 100) is listed above the map, and is based on the selection in the Advanced Settings dialog (see page 104).

In the default bead map, the x-axis is the Classification 1 channel and the y-axis is the Classification 2 channel. These channels measure the embedded fluorochromes in each bead, which are used to identify the bead set and corresponding analyte. The resulting data point clusters in the map represent the different bead sets in the assay and their associated analytes.

**NOTE:** Each bead set generates a cluster of data points, rather than a single point, because of minute variations in fluorochrome levels and intensity among the beads in a set.
The white areas on the map indicate the expected regions of the selected analytes. If you move your cursor over these areas, the name of the analyte appears in a pop up window. The data point clusters should fall within these regions.

If one or more clusters do not fall within the white areas, there may be a problem with the beads such as photobleaching, or the analyte selections in the Protocol may be incorrect. If all the data clusters have shifted out of the white regions, there may be microbubbles in the cuvette. See the Troubleshooting chapter on page 215 for troubleshooting suggestions.

In this way, the map can be used to confirm that the bead sets are correctly selected, measured, and identified.

**Changing the X- and Y-Axes of the Map**

You can change the channel types of the axes. Right-click the bead map and select one channel from the x-axis submenu, and the other channel from the y-axis submenu. The available channels are:

- **Doublet Discriminator** — This channel measures light scatter from the beads as they pass through the red laser. Light scatter correlates to particle size.
- **Reporter 1** — This channel measures the reporter molecules bound to the analytes on each bead.
- **Classification 1** — This channel measures the first classification dye embedded in each bead.
- **Classification 2** — This channel measures the second classification dye embedded in each bead.
If you are developing your own assay, you may want to plot the Reporter 1 channel against the Doublet Discriminator channel to evaluate the distribution of the reporter signal. This yields information about the specificity of the antibodies in the assay.

**Figure 105. Changing the channel displayed on the x-axis**

**SCALING THE BEAD MAP DATA**

The default view of the data is log scale. From the toolbar, click the Log/Linear button to change the display from log to linear. Click again to return to log scale.

**MAGNIFYING AND RESIZING THE BEAD MAP**

Click the Zoom button in the bead map toolbar to magnify the display.

With Zoom selected, the cursor changes to a hand symbol when you position it over the map. Drag the hand cursor to view different magnified regions of the bead map.

Click the Maximize button to maximize the bead map portion of the window within the larger Protocol window. Click the Restore button to return the bead map to its default state.

**Bead Map Display Options**

To access additional Bead Map display settings, right-click the bead map and select Options.
DENSITY FILTERING

Each colored dot in the bead map represents a certain number of events measured by the reader at that data point. Different colors are used to distinguish among different numbers of events. You can adjust the display so that data points with low numbers of events are not shown, or to set the number of events at before which the data point color changes.

Figure 106. Bead map display options

**NOTE:** These settings only change the bead map display, and do not affect the underlying data in any way.

First, enter a number in the Level Multiplier field. This number is used exponentially to determine the number of events required before a data point changes color. For the default value of 2, the color level changes at 2, 4, 8, 16, etc. events.

If you want to filter lower numbers of events from the display, select the Filter Levels checkbox and use the arrow keys next to the Display Above Level field to select the exponent level below which no data points will be displayed. For example, if the Level Multiplier is set to 2, and the Display Above Level field is set to 3, data points are not displayed until 8 or more events are registered; the first color level occurs at 8 events, the second color level occurs at 16 events, the third color level occurs at 32 events, etc.

The color levels in the display are, in ascending order, dark blue, purple, dark green, light blue, blue, light green, orange, black, and brown.

LOGARITHMIC/LINEAR DISPLAY

Select whether you want to display the bead map data on a logarithmic or linear scale using these option buttons.
The Raw Data table displays the raw numerical data of a reading, as well as all instrument settings and information related to the system hardware and software used in the reading (version numbers, voltage, temperature, gain, etc.).

NOTE: The instrument hardware and software information included in the Run Info window of previous Bio-Plex Manager versions is now provided in the Raw Data table.

This table is available in both the Run Protocol window and in the Raw Data window of the Results file. (Note that you can only print and export the Raw Data table from a Results file, not a Protocol window.

The first few lines of this table are visible below the bead map and histogram. Alternatively, hide the histogram/bead map display by clicking on the Show/Hide Histogram/Bead Map button to maximize the table.

<table>
<thead>
<tr>
<th>Well</th>
<th>fluorescenee</th>
<th>analyte 1</th>
<th>analyte 2</th>
<th>analyte 3</th>
<th>analyte 4</th>
<th>analyte 5</th>
<th>analyte 6</th>
<th>analyte 7</th>
<th>analyte 8</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>10</td>
<td>20</td>
<td>30</td>
<td>40</td>
<td>50</td>
<td>60</td>
<td>70</td>
<td>80</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>11</td>
<td>21</td>
<td>31</td>
<td>41</td>
<td>51</td>
<td>61</td>
<td>71</td>
<td>81</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>12</td>
<td>22</td>
<td>32</td>
<td>42</td>
<td>52</td>
<td>62</td>
<td>72</td>
<td>82</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>13</td>
<td>23</td>
<td>33</td>
<td>43</td>
<td>53</td>
<td>63</td>
<td>73</td>
<td>83</td>
<td></td>
</tr>
</tbody>
</table>

**Figure 107. Raw data from a reading**

During a reading, the table is filled in line by line as each well is read. After the reading is complete, all the data are displayed.

In the table, the fluorescence intensities (FI) of the analytes you selected are listed for each well number.

**NOTE:** During a reading, the array reader always detects all the analytes in the sample, including any that you have not selected. However, analytes that were not selected in the Protocol are not included in the table, even if they were detected. After a reading, you can go back and change your selections under Select Analytes, and the new analytes, if detected, will appear in the table.

For online Help information about the Raw Data table, click the Display Help for Table Legend button.
Bead Statistics

To display statistical data for the individual beads as well as the entire well, click the Show/Hide Bead Statistics Columns button on the table toolbar. The number of beads collected for each analyte displays in parentheses after the analyte fluorescence intensity.

![Bead Statistics Table]

*Figure 108. Analyte fluorescent intensity and bead count*

With Show/Hide Bead Statistics Columns selected, the following columns are also displayed:

- Total—total bead count in the well
- Region—number of beads that fell within defined regions
- Gate—number of beads that passed the DD gate (see page 107)
- % Agg Beads—percentage of aggregated beads in the well calculated as (100 – [Gate/Total*100])

*Figure 109. Well data*

**NOTE:** The number in the Region column is flagged by an asterisk (*) if that well did not acquire the number of beads per region specified for the reading.

Sampling Error Codes

During a reading, the flow of beads, bead count, bead regions, and platform temperature are continuously monitored. The Sampling Errors column reports errors in any of these areas for each analyte. These errors are reported in the table even if you chose not to pause the run due to an error condition (see page 105).

The sampling error codes in the column are listed in the following table.

<table>
<thead>
<tr>
<th>Error Code</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Low bead number detected in the well</td>
</tr>
<tr>
<td>2</td>
<td>Aggregated beads detected in the well</td>
</tr>
</tbody>
</table>
Raw Data Table

<table>
<thead>
<tr>
<th>Error Code</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Bead classification efficiency problem detected in the well</td>
</tr>
<tr>
<td>4</td>
<td>Region selection problem detected in the well</td>
</tr>
<tr>
<td>5</td>
<td>Platform temperature problem detected</td>
</tr>
</tbody>
</table>

**Raw Data Display Options**

To select the columns to display in the Raw Data table, and other display settings, click the Raw Data Display Options button or select the command from the Table Options menu.

*Figure 110. Raw Data Display Options dialog*

In the Raw Data Display Options dialog, select the columns to display using the checkboxes. You can also choose between predefined report settings by selecting Standard or Diagnostic in the Report Scheme field; these selections display different sets of columns.

Select the Show Bead Region Counts and Show Histogram and Bead Map checkboxes to set these display options as the default for the Raw Data table.

Select the Save Settings as Default for New Protocol checkbox to use the selections in this dialog as the default for new Protocol files.
Set Number Format

In the Raw Data Display Options dialog, click the Set Number Format button to select the number format for each column in the Raw Data table.

![Set Column Number Format dialog](image)

Figure 111. Set Column Number Format dialog

In the dialog, select the column from the pulldown list, then specify the number of decimal places for the value of that column in the Decimal Places field. Select the Scientific Notation checkbox to display the number in scientific notation. Select the Same Number Format for All Columns checkbox to use the selected number format for all the columns.

**NOTE:** Changing the number format changes only how the numbers are displayed and printed, and does not affect calculations in any way.

Click OK to make the changes, or Reset Defaults to return all columns to their default number formats.

Other Table Formatting

To display the description of each sample in the table, click the Show/Hide Description Column button above the table. The Description column displays.

To automatically size the columns to fit the width of the text, click the Autofit button on the toolbar.

Copying the Raw Data

You can copy the contents of the table to the Windows clipboard. Select rows, columns, cells, or the entire table, then select Copy from the Edit menu. The values you copy can be pasted into other Windows applications.
**Rerun/Recovery Mode**

After a reading has stopped—because of an error or user intervention, or because the reading is complete—the Rerun/Recovery Mode checkbox in the Run Protocol window will be selected. This allows you to rerun some or all of the samples.

With Rerun/Recovery Mode selected, checkboxes appear next to each well number in the Run Protocol table. Select the checkboxes next to the wells you want to read again.

**NOTE:** To rerun wells in a filter plate, you must first vacuum the wells using the vacuum filter apparatus. The beads remain on top of each filter plug after vacuuming. Resuspend the beads with 125 μl of resuspension buffer in each well. See the *Bio-Plex Cytokine Assay Manual* for detailed instructions.

Each well may be read twice without adversely affecting the results.

Because there are fewer beads in a well that has already been run once, be sure to select 100 beads per region or fewer in the Run Protocol settings (see page 101). Also, click the Advanced Settings button and deselect the Low bead number error condition checkbox (page 104). Otherwise, a low bead error may stop the reading.

Click Start to begin the reading.
8 Using the Security Edition

Bio-Plex Manager™ Security Edition

Bio-Plex Manager™ 6.1 Security Edition software works in conjunction with the built-in security features of the Windows XP Professional or Windows 7 operating systems to provide a secure environment for the maintenance, verification, and tracking of all electronic records generated by the application. These records include Protocol and Results files, and the calibration, validation, and instrument operations logs. The tools provided in the software include:

- Access controls and authority checks via the use of user identification codes and passwords
- Electronic record security via the use of protected directories
- Time- and date-stamped audit trails
- Electronic signature of electronic records (user authentication)

When properly configured and administered, these tools ensure compliance with the rules for secure handling of electronic records as outlined in Title 21, Part 11, of the Code of Federal Regulations (CFR).
Background on 21 CFR Part 11

Effective August 20, 1997, the United States Food and Drug Administration (FDA) released Part 11 “Electronic Records; Electronic Signatures” of Title 21 of CFR. This rule states the conditions under which the FDA considers electronic signatures and electronic records to be trustworthy, reliable, and equivalent to traditional handwritten signatures.

Bio-Plex Manager Security Edition is designed to enable organizations and institutions using the Bio-Plex suspension array system (or Luminex system) to comply with the rules laid out under 21 CFR Part 11. It enables system administrators to ensure that Bio-Plex Manager operates in compliance with 21 CFR Part 11 within a “closed system.” A closed system is defined as “an environment in which system access is controlled by the persons who are responsible for the content of electronic records that are on the system” (Section 11.3 (b) (4).

NOTES:
- The security controls built into Bio-Plex Manager Security Edition must be properly configured and administered by the system administrator(s) in your organization. Otherwise, the system will not be secure and will not be in compliance with 21 CFR Part 11
- Bio-Rad makes no claim that Bio-Plex Manager Security Edition is CFR-compliant in and of itself, nor does it guarantee compliance for the user. Your organization must establish policies and standard operating procedures that work in conjunction with the tools provided by Bio-Rad to ensure compliance with 21 CFR Part 11

Standard Mode vs. Secure Mode

Bio-Plex Manager Security Edition can run in Standard Mode, in which all the security and audit trail features are disabled so that software functions like the standard version of Bio-Plex Manager, or it can run in Secure Mode, with the security functions enabled. This chapter assumes you are running the software in Secure Mode, unless otherwise noted.

When you are in Standard Mode, the status bar displays an “unlocked” symbol. When you are in Secure Mode, the status bar display a “locked” symbol.
Installing and Starting Bio-Plex Manager Security Edition

System Requirements

Bio-Plex Manager Security Edition has the same system requirements as the Standard Edition, except that the security functions are not supported under the Windows XP Home Edition operating system. The software must be installed on a computer running the Windows XP Professional or Windows 7 operating system for full Secure Mode functionality.

Installing and Starting Bio-Plex Manager Security Edition


When you start Bio-Plex Manager in Secure Mode, you are prompted to log in with your user name and password.

NOTE: User names and passwords must be set up on your computer or computer network as described in the Bio-Plex Manager 6.1 Upgrade and Configuration Guide before you can use the application in Secure Mode. This guide is provided on your software CD.

Users, Passwords, and User Levels

In Secure Mode, Bio-Plex Manager Security Edition requires that users log in with a user name and password to run the software. User names and passwords are set up by your Windows system administrator as described in the Bio-Plex Manager 6.1 Upgrade and Configuration Guide.

NOTES:

- Contact your Windows system administrator about issues regarding your user name and password
- Each user is assigned to a particular user level. There are six user levels in Bio-Plex Manager Security Edition, and each level gives the user access to specific features and functions of the software

A table listing the specific features and functions accessible at each user level is provided on page 219 in the Appendix. The following is a general summary of each user level.

- Administrator — Users at this level can enable or disable Secure Mode. Administrator-level users also can view log files. Access to all other features and functions of the software is restricted
Bio-Plex Manager Software 6.1 User Guide | Users, Passwords, and User Levels

- **Supervisor** — Users at this level have full access to all features and functions of the software, except that they cannot enable or disable Secure Mode
- **Service** — Users at this level have full access to all features and functions of the software, except that they cannot enable or disable Secure Mode
- **Clinician 2** — Users at this level can perform instrument operations, run existing Protocols, and view Protocol files, results files, and log files. They can also change the number of unknown samples in the plate format (using the Set Number of Unknown Samples command) and enter sample descriptions. All other access is restricted
- **Clinician 1** — Users at this level can perform instrument operations, run Protocols, and view Protocol files, Results files, and log files, but cannot change any settings. All other access is restricted
- **Reviewer** — Users at this level can view and sign Protocol and Results files, and can view log files. All other access is restricted

**User Level Restrictions**

If you attempt to select a command or perform an action not allowed by your user level, you receive a pop-up warning. In addition, many fields and settings that are restricted by your user level appear grayed out in the application.

**User Information**

To display information about the current user, including user name, domain, full name, and access level, go to the Tools menu and select User Info. You can also click the user name displayed in the application status bar.

![User Information dialog](image)
Enabling and Disabling Secure Mode

Only users with Administrator-level access can enable or disable Secure Mode. Enabling or disabling Secure Mode requires that you close all documents and restart the application.

When Secure Mode is enabled, the status bar displays the locked symbol.

![Secure Mode](image)

Figure 114. Secure Mode disabled (left) and enabled (right)

To enable Secure Mode, go to the Tools menu and select Preferences. In the Preferences dialog, select the Enable Secure Mode checkbox to enable Secure Mode, or deselect the checkbox to disable it.

If your user name and password are set up on a Windows network server, enter the network domain where they reside in the Domain to Be Used for Authentication field. Contact your Windows system administrator if you are unsure of your domain.

**NOTE:** Local groups can be set up on the local machine and authenticated using domain users. Click the box to use local user groups for establishing user security levels.

When you click OK, you are prompted to sign in as an Administrator-level user to authenticate the change. You then need to restart the software.

User Authentication

Bio-Plex Manager Security Edition requires user authentication (entering a user name and password) at key points during operation. User authentication creates an electronic audit trail of user activity that cannot be altered or deleted.

![Log In](image)

Figure 115. Log In dialog
Bio-Plex Manager Software 6.1 User Guide | Electronic Records

Users are required to enter their user name and password when they:

- Start the application
- Start a reading
- Unlock the application
- Sign a document, such as a Protocol or Results file

Different users may authenticate operations. For example, a Clinician 1-level user may be logged into Bio-Plex Manager, but a Supervisor-level user may enter his user name and password to authenticate a particular reading. Note that in this case, the Clinician 1-level user will remain logged onto the application.

Your organization must establish its own guidelines for user authentication of specific operations.

Electronic Records

Bio-Plex Manager Security Edition supports the creation and control of secure "electronic records," as defined by 21 CFR Part 11. In Bio-Plex Manager, the following are electronic records:

- Protocol files
- Results files
- Calibration Log (included in the bioplexdata.mdb file)
- Validation Log (included in the bioplexdata.mdb file)
- Instrument Operations Log (included in the bioplexdata.mdb file)

These records are accessible only through Bio-Plex Manager and its associated utilities.

File Security and Validation

The files used by Bio-Plex Manager Security Edition cannot be opened or edited using other programs. Bio-Plex Manager checks the integrity and validity of a file each time it opens. If a file becomes damaged or shows signs of tampering with an outside application, it will not open in Bio-Plex Manager.
Calibration, Validation, and Instrument Operations Logs

These logs provide a permanent chronological record of all calibration, validation, and instrument operations events. You can view, copy, and print the data from these logs. They are available from the View menu in Bio-Plex Manager.

NOTE: If the application is in Secure Mode, each event in a log includes the name and access level of the user who performed/authorized the action. If the application is in Standard Mode, the event is flagged as having occurred outside Secure Mode and the access level is labeled as “unrestricted.”

These logs are stored in a database file called bioplexdata.mdb, which by default is saved in the main Bio-Plex Manager application folder on your computer (you can specify a different location during installation).

NOTE: The bioplexdata.mdb database is not compatible with versions of Bio-Plex Manager earlier than 4.0. If you have an earlier version of the software, installing version 4.0 or later will copy the data from your existing database (bioplex.mdb) into the new database. A copy of your old database will remain in the application folder.

For more information about the Calibration Log, see page 34.
For more information about the Validation Log, see page 45.
For more information about the Instrument Operations Log, see page 51.

Secure Protocol and Results Files

Bio-Plex Manager Security Edition supports the creation of Secure Protocol and Results files. Secure files are documents that have been electronically “signed” by a user. Once signed, these files are controlled documents that cannot be overwritten by Bio-Plex Manager and that preserve a built-in audit trail of all saved changes.

Unsigned Protocol and Results Files

When you create a new Protocol file in Bio-Plex Manager Security Edition, it is initially unsigned and is not a secure file. Protocol or Results files created with previous versions of the software or created in Standard Mode are also unsigned, uncontrolled documents, and you are notified that these files are not secure when you open them in Secure Mode. You can save and overwrite these files without restrictions and no audit trail will be generated for any changes.
If you make changes to a signed Protocol or Results file and save them as a new file, the new file will not be signed; however, the audit trail (see page 137) will be preserved in the new file and the file will remain a secure file.

**NOTE:** You cannot generate a new unsigned, uncontrolled Results file in Secure Mode; all Results files generated in Secure Mode must be signed.

**Signed Protocol and Results Files**

Protocol and Results files become secure files when they are electronically signed using a user name and password. Once signed, these files become read-only; you can make changes to the file, but they must be saved under a different file name. An audit trail of changes is built into each Secure Protocol and Results file.

Secure Edition Protocol files have the file extension *.spbx. Secure Edition Results files have the file extension *.srbx.

To sign a Protocol or Results file, go to the File menu and select Sign Document. The Electronic Signature dialog will open. This dialog opens automatically when a Results file is generated from a Protocol file.

![Figure 116. Electronic Signature dialog](image)

**NOTE:** In the dialog, the signing party enters his or her user name and password in the appropriate fields. (This may be someone other than the current user.) The reason for signing the document must be entered in the text field. Typical reasons may include review, approval, responsibility, or authorship.
Calibration, Validation, and Instrument Operations Logs

When you click OK, a Save As dialog opens.

![Save As dialog for Secure Protocol files](image)

**Figure 117. Save As dialog for Secure Protocol files**

Enter a name for the file or use the default name and click Save.

After a file has been signed, it is flagged as read-only and cannot be modified. Any subsequent changes must be saved as a new file. Also, any changes made to a file after it has been signed will generate an audit trail documenting each change, as described starting on page 137.

A new file generated from a signed file can be signed again to verify and lock in any changes made to it. As before, the new signed file is flagged as read-only and any subsequent changes must be saved under a new file name.
Document ID Number and Signature

Each signed Protocol and Results file has a unique document identifier (Document ID) number. To view this number, go to the File menu and select Document Properties.

![Document Properties dialog](image)

**Figure 118. Document Properties dialog**

The Document Properties dialog also provides information about the signature.

The full name of the user who signed the document is displayed in the title bar of the File window.

![Signed and read-only status of file shown in title bar](image)

**Figure 119. Signed and read-only status of file shown in title bar**
Calibration, Validation, and Instrument Operations Logs

All printouts and exports of a signed document also include the signature and Document ID number.

Adjusting the Number of Unknown Samples in a Protocol

A Supervisor-level user can create a “master” Protocol file with a defined plate format, including a set number of unknown sample wells. A Clinician 2-level user can then open the Protocol and adjust the number of unknown samples to be read in a particular reading. This enables Clinician 2-level users to use the same Protocol file in multiple readings with different numbers of samples.

NOTES: Clinician 2-level users do not have access to the other plate formatting tools in Protocols. See Defining Unknown Sample Wells on page 69 for information on defining unknown sample wells and replicates in Protocols.

With the Protocol file open and the Format Plate window displayed, click the Set Number of Unknown Samples button in the formatting toolbar or select the command from the Format Options menu.

Figure 120. Document ID and signature in an Excel export file
In the Set Number of Samples dialog, the maximum number of unknown samples defined in the plate template will be noted next to the field.

![Set Number of Unknown Samples dialog](image)

**Figure 121. Set Number of Unknown Samples dialog**

The maximum number of unknown samples is determined by the number of formatted unknown sample wells and the number of wells per replicate group defined in the template. For example, a template with 48 wells defined as unknowns and four wells per replicate will have a maximum number of 12 samples.

Enter the number of samples to use in a particular reading in the field and click OK. The plate format will change to indicate the new number and layout of the sample wells. Only those wells will be read during a reading.

**NOTE:** You can specify only the number of unknown samples using this command—not standards, controls, or blanks.

If you save the Protocol file after changing the number of unknown samples, the number of samples you specified will become the new maximum number of samples. To preserve the original number of unknown samples, save the changed Protocol file under a different name.

### Generating a Results File from a Protocol File

The Results file must be signed before a reading can begin. In Secure Mode, the Auto Save After Run checkbox in the Run Protocol window (see page 100) is automatically selected and cannot be deselected. You are prompted to sign and save the Results file at the start of each reading.
NOTE: In Secure Mode, each reading, including reruns of plate wells, generates a new Results file that cannot be overwritten.

You are also prompted to sign and save the Results file if you select the New Results from Protocol command from the File menu (see page 143).

Audit Trail

Any changes made or actions performed after a Protocol or Results file has been signed automatically generates an audit trail documenting each change/action. If you make changes to a signed, read-only file and save it as a new file, the audit trail is preserved in the new file (with the signature of the previous file noted as part of the audit trail). Also, the audit trail for a Protocol file is preserved in the Results file generated from that Protocol.

All major actions and changes are audited. Examples of auditable actions include:

- Signing a file
- Changing Protocol settings (plate format, analyte selection, etc.)
- Changing the standard curve regression type, variance model, etc.
- Flagging outliers
- Performing readings (audited in the Results file)

Minor changes that affect only the display, such as selecting different columns in the Report Table or changing the axis transformation in the Standard Curve, are not audited.
Each change you make to a signed Protocol or Results file or a new file saved from a signed file must be documented in the Reason for Change dialog. The information in this dialog is used to generate the audit trail. The dialog opens automatically whenever you make a change and either save the document or switch among subwindows in the Protocol or Results file.

**Reason For Change**

---

<table>
<thead>
<tr>
<th>Date/Time</th>
<th>Action</th>
<th>User</th>
<th>Access Level</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>10:00 EST, 12:20 PM</td>
<td>Format Wells</td>
<td>OF Supervisor Name</td>
<td>Supervisor</td>
<td>5.0.0.504 + 1.0.0.0</td>
</tr>
</tbody>
</table>

**What is your reason for this change?**

---

*Figure 123. Reason for Change dialog, used to generate the audit trail*

The dialog notes the date and time of each auditable action and describes the change/edit made. You must enter a reason for each change in the bottom field.

If you have made more than one change, use the Next and Back buttons to scroll through the changes. When you have entered a reason for each change, click the Finished button.
Viewing the Audit Trail

To view the audit trail for a Protocol or Results file, go to the View menu and select Audit Trail. The audit trail is displayed in a subwindow of the Protocol or Results file.

Figure 124. Audit trail for a Protocol file

Figure 125. Audit trail for a Results file

The audit trail notes the date and time of each action, the user, the access level, the action, a description of the action (automatically generated by the software), the reason for the action (entered by the user), and the version of the software.
The audit trail also notes each time the file has been signed. In the example below, note that each time the file was signed and made read-only, the audit trail was continued in the new file.

<table>
<thead>
<tr>
<th>User</th>
<th>Access Level</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alfred Nobel</td>
<td>Supervisor</td>
<td>Sign File</td>
</tr>
<tr>
<td>Bio-Plex Supervisor</td>
<td>Supervisor</td>
<td>Modify Advanced Run Settings</td>
</tr>
<tr>
<td>Bio-Plex Supervisor</td>
<td>Supervisor</td>
<td>Modify Control(s) Info</td>
</tr>
<tr>
<td>Bio-Plex Supervisor</td>
<td>Supervisor</td>
<td>Modify Control(s) Info</td>
</tr>
<tr>
<td>Bio-Plex Supervisor</td>
<td>Supervisor</td>
<td>Modify Sample(s) Info</td>
</tr>
<tr>
<td>Alfred Nobel</td>
<td>Supervisor</td>
<td>Sign File</td>
</tr>
<tr>
<td>Bio-Plex Supervisor</td>
<td>Supervisor</td>
<td>Remove Standard Analysis(s)</td>
</tr>
<tr>
<td>Bio-Plex Supervisor</td>
<td>Supervisor</td>
<td>Format Wells</td>
</tr>
<tr>
<td>Alfred Nobel</td>
<td>Supervisor</td>
<td>Sign File</td>
</tr>
</tbody>
</table>

**Figure 126. Example of a Protocol audit trail with signatures**

To display the complete contents of the Description and Reason cells in the table, hold your cursor over a table cell and the information for that cell is displayed in a context pop-up box. Or you can click the Expand Audit Entries button in the Audit Trail window toolbar to expand all the cells.

**Figure 127. Example of a pop-up information box in the audit trail**

To copy the contents of the audit trail to the Windows clipboard, click the Copy to Clipboard button in the window toolbar. To print the audit trail, click the Print button.

**Protected Directories**

Your Windows system administrator may set up protected directories on your computer or computer network for the secure storage of Protocol and Results files. These protected directories must be set up using Windows tools, and are keyed to your Windows user name and password (which may be different than your Bio-Plex Manager user name and password). Consult your system administrator for information about protected directories.
Locking Bio-Plex Manager

If you are stepping away from the computer and want to prevent anyone else from using Bio-Plex Manager Security Edition, you can lock the application. Once locked, the application can only be unlocked by the user who locked it or a Supervisor-level user.

**NOTE:** Locking Bio-Plex Manager will not shut down the application or end any instrument operations that are in progress.

To lock the application, go to the Tools menu and select Lock Application. You will be notified that the application is locked, and the Log In dialog will be displayed.

To unlock the application, enter your name and password and click OK.

Logging Off

When you close Bio-Plex Manager Security Edition, you will be automatically logged off. You can also log off without closing the application.

Note that you cannot log off while the array reader is in operation. Logging off will close all open documents. You will be prompted to save any changes before logging off.

To log off, go to the Tools menu and select Log Off Application. You will be notified that you have successfully logged off and the Log In dialog will be displayed.

If a Supervisor-level user unlocks the application, that Supervisor-level user will then be logged in as the current user.
9 Analyzing the Results

Results Files

After a reading is complete, a Results file generates and opens automatically. The Results file contains the data from a reading, the Protocol parameters used to collect that data, and analysis tools for interpreting the data. It includes all the information necessary to analyze raw data, including a description of the assays, well types, concentrations, dilutions, and the regression method used for calculating the concentrations of unknowns from standards. It also includes information about the instrument and the run conditions at each well at the time of data acquisition.

In the Results file, you can change many of the parameters copied from the original Protocol file—including the plate format, analyte selection, standards info, etc.—and recalculate the results. However, you can change only the parameters of wells that have already been read, and you can calculate only results based on the analytes that were present in the sample.

NOTE: If you selected Auto Save After Run in the Protocol window, the Results file is automatically saved after a reading. Otherwise, you must save your Results file as a separate step.

To generate a Results file from an incomplete reading or a previous reading, open the Protocol file that contains the raw data for that reading and select New Results from Protocol from the Run Protocol toolbar or the File menu.
Opening a Results File

To open an existing Results file, click the Open Results button on the Quick Guide or main toolbar, or select Open Results from the File menu. Locate and select the file using the usual Windows Open dialog.


NOTES:
- Secure Edition Results files can be opened only as read-only files using the Standard Edition of Bio-Plex Manager™
- Results files created or modified by the current version of Bio-Plex Manager cannot be opened by earlier versions of the software
- From Bio-Plex Manager, you can import a Luminex xPONENT file. For more information, see Importing Luminex xPONENT Output Files on page 194

Saving a Results File

To save a Results file, with the file open, click the Save button on the main toolbar or select Save or Save As from the File menu.

Reducing the Size of a Results File

Results files that include all the data from a reading can be very large (>5 MB). Much of this file size is due to the raw bead event data from the reading, which is used to generate the bead map and histogram displays. If you need a smaller file size (for example, to send via email), you can save a copy of the file without this raw bead event data, but with the other numerical data from the reading intact.

NOTE: We strongly recommend keeping a copy of the original Results file with the raw bead event data intact. These data are necessary for changing the DD gate range in the Results file (see page 149), and for exporting the data in XML file format.
In the Save As dialog box, select the Compressed Mode checkbox to save the Results file without the bead map and histogram data. All other data are preserved.

![Save As dialog for Results files](image)

Figure 128. Save As dialog for Results files

**NOTE:** This compressed file option is not available for Secure Protocol files generated using the Security Edition of the software.
Results Window

The Results window is divided into subwindows, each containing different options for viewing, formatting, and calculating your data.

Figure 129. Results window

Navigate among the different subwindows using the buttons along the left side of the Results window:

- Raw Data  (see page 150)
- Report Table   (see page 153)
- Standard Curve   (see page 168)
- Graphing Functions  (see page 175)
Custom Reports

The custom report function is located in the view menu and is active when you are viewing a results file.

Choose from available report templates by using the pull down menu, or by navigating to a folder location.

Bio-Rad plans to release custom report templates for specialized applications periodically via the web. Bio-Plex Manager 6.1 includes the Gene Manager, an Excel-based analysis application designed for genotype (including SNP) and Present vs. Absent analysis. It contains its own online help documentation and is launched from the Custom Report dialog box.

Sample results files with genotype data are present in the Bio-Plex Manager example file directory. The default directory is C:\Program Files\Bio-Rad\Bio-Plex Manager\Example Files.

You can save different versions of Gene Manager with your own analysis preferences, which show up in the list of available reports. This is particularly useful if you are continually rerunning the same assay.
Viewing/Changing the Protocol Settings

In the Results window, you can review and in some cases change the plate formatting, analyte selections, sample concentrations, etc., from the original Protocol file to display different data or recalculate data in the Results file tables. These controls are located in the toolbar across the top of the Results window.

NOTE: Any changes you make in the Results file will not change the original Protocol file or the data from the reading. They will change only how these data are displayed in the Results file tables.

Click the Describe Protocol button in the Results toolbar to review or change the description of the Protocol, as described on page 59.

Click the Select Analytes button in the Results toolbar to review the analyte selection or select different analytes, as described on page 59.

NOTE: During a reading, the array reader always detects all the analytes in the sample, including any you have not selected. However, analytes that were detected, but not selected, will not appear in the final reports and tables. After a reading, you can go back and change your analyte selections, and any detected analytes will appear in the tables.

Click the Format Plate button in the Results toolbar to review or change the formatting of the plate. Plate formatting is described on page 68.

NOTE: Only formatted wells are read by the array reader. You must define all the wells you want to read before running a Protocol. However, you can change the formatting of a defined well (for example, from unknown to standard) after a reading, and the analysis of that well will change.

Click the Enter Controls Info button in the Results toolbar to review or change the concentrations of the controls, as described on page 96.

Click the Enter Sample Info button in the Results toolbar to review or change the sample information, as described on page 98.
Changing the Doublet Discriminator Gate Range

You can change the doublet discriminator (DD) gate range (see page 107) in the Results file and recalculate the data based on the new range. The original DD gate range set in the Protocol file and used during the reading is preserved and can be displayed in the Raw Data table.

To reset the DD gate range, go to the Edit menu, open the Reanalyze Results submenu, and select Change DD Gates. The Change DD Gates dialog opens, displaying the histogram and bead map with controls for changing the DD gate range. (See page 111 for a complete description of other histogram and bead map controls.)

![Change DD Gates dialog](image)

In the Change DD Gates dialog, first select the well you want to change or select the Same DD Gates for All Formatted Wells checkbox. Also, you can select a specific analyte, all gated analytes, or all analytes from the pulldown menu above the histogram. Then either drag the red dashed lines in the histogram display to adjust the DD gates, or enter new values in the DD Low and/or DD High fields. Click the Update Gates button.

When you have made your changes, click OK. The data in the Raw Data table (see next section) recalculate based on the new settings.
Raw Data

The Raw Data window in the Results file includes the same histogram, bead map, and numerical Raw Data table as the Run Protocol window. These features are described in the previous chapter on the following pages:

- Histogram and bead map—see page 111
- Raw Data table—see page 119

Figure 133. Raw Data window in Results file

The Raw Data window in the Results file includes additional exporting and printing functions not available in the Protocol window.

Setting the Plate ID

If you have an identification number for the microplate used in a reading, you can specify the ID number in the Results file. Right-click anywhere in the Raw Data table and you can select Set Plate ID from the context menu.

Figure 134. Set Plate ID dialog
In the dialog, enter the plate ID number in the Plate ID field. If you want to associate the same ID number with all the wells in the reading, select Apply Plate ID to All Wells checkbox. If you want to associate different ID numbers with different wells, select the well for this number from the Well pulldown list. Click OK to save the changes.

The plate ID number is displayed for each well in the Raw Data table.

**Exporting the Raw Data**

To automatically export your raw data to Microsoft Excel, click the Export to Excel button in the toolbar or select the command from the File menu. This command automatically launches Excel and displays a spreadsheet containing your data.

![Excel spreadsheet with exported data](image)

*Figure 135. Example of an Excel spreadsheet with exported data.*

You can also export the raw data to a text file. With your raw data displayed, go to the File menu and select Export Table to File. This command opens a Save As dialog box in which you can specify a file name and location for the text file.

**NOTE:** You can copy any or all values in the table to the Windows clipboard. Select the entire table, or the desired rows, columns or entries, and select Copy from the Edit menu. The values you copy can be pasted into other Windows applications.
Raw Data Table Error Codes

If data cannot be measured or a sampling error occurs in a well, it will be flagged in the Raw Data table. The possible error conditions in the table are listed below.

<table>
<thead>
<tr>
<th>Column</th>
<th>Error Code</th>
<th>Cause</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td>***</td>
<td>No data present</td>
</tr>
<tr>
<td>Sampling</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Errors</td>
<td>1</td>
<td>Low bead number detected in the well</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>Aggregated beads detected in the well</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>Classify efficiency problem detected in the well</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>Region selection problem detected in the well</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>Platform temperature problem detected in the well</td>
</tr>
</tbody>
</table>

Printing the Raw Data

You can print the Raw Data table using the Print command on the main toolbar or File menu. Print Preview on the File menu displays the table as it will appear in the printout.
Report Table

The Report Table provides detailed information about the analytes in your samples.

Click the Report Table button to open the Report Table window.

Toolbar

The toolbar allows you to make formatting changes to your samples, and to change your report table in many ways. The figure below shows the toolbar functions.

![Phosphoprotein 6-Plex (Read-Only) - Report Table](image)

**Figure 136. Report Table Toolbar**

The first six tools allow you to adjust any plate formatting or Protocol settings. See Viewing/Changing the Protocol Settings on page 148.

The Normalization Settings button allows you to normalize your data. See Data Normalization, on page 207.

The Export button allows you to export your data to Excel or a word processing application. See Exporting the Report Table on page 163.

The Report Table Display Options button accesses the remainder of the toolbar functions. See the Display Options section starting on page 154.

The Show/Hide Outliers button allows you to view or hide outlier data. See Showing/Hiding Outliers on page 161.

The Organize by Type or Group button is discussed on page 156.

The Single or Multiple Analytes button is discussed on page 155.

The Show Replicates button is discussed on page 156.

The Sort button allows you to sort the table data alphanumerically. See Sorting Report Table Data on page 163.
Display Options

Click the Report Table Display Options button, or select Report Table Options from the Table Options menu, to select columns to display in the Report Table. This dialog box also contains many other display settings, which are described below.

![Report Table Display Options dialog](image)

Figure 137. Report Table Display Options dialog

SELECTING COLUMNS TO DISPLAY

See Report Table Column Descriptions on page 158 for definitions. Use the checkboxes to select which columns to display in the Report Table Display Options dialog.
PREDEFINED REPORT SCHEMES

These selections display different sets of columns. Select Quantitative or Qualitative in the Report Scheme field to choose among predefined Report Table displays. Use the Norm Qualitative column if your data are normalized.

NOTE: The predefined Norm Qualitative column is designed to be used with gene expression.

SINGLE OR MULTIPLE ANALYTE LAYOUT

You can view the Report Table either in Single Analyte and Multi Analyte view, and you can also toggle between them.

Click the Single Analyte Layout in the toolbar, or choose Layout Table with Single Analyte from the Table Options menu. Select an analyte to review from the Analyte pulldown list above the table.

Figure 138. Selecting an analyte for a Single Analyte Report Table

Click the Multiple Analyte Layout button in the toolbar, or choose Layout Table with Multiple Analytes from the Table Options menu. The multiple analyte view shows columns for all analytes. Use the horizontal scroll bar at the bottom of the window to scroll sideways through analytes.

Figure 139. Multiple analyte table view
ORGANIZING BY TYPE OR GROUP

Click the Organize by Type button or go to the Table Options menu and select Organize Table by Sample Types, to highlight the divisions between the unknowns, standards, controls, etc. in the report.

Click the Organize by Group button or go to the Table Options menu and select Organize Table by Sample Groups, to highlight the divisions between defined groups (see page 75) in the report.

NOTE: Type and Group selections will override the Sort function. For example, if you select Type organization, any sorting will be within each type of sample.

EXPAND REPLICATE INFO

If you have defined multiple wells as a replicate group in the Format Plate window, the wells will be listed together in the Well column, and mean data values for those wells will be reported in the relevant columns for the selected analyte (unless the wells have been flagged as outliers; see below).

Click the Expand Replicate Info checkbox in the Report Table Display Options dialog, to review the data for each well in a replicate group.

Or, click the Show Replicates button in the toolbar to expand the data for each well in a replicate group. The mean values, as well as the individual well values, are reported for each replicate group.

<table>
<thead>
<tr>
<th>Type</th>
<th>Well</th>
<th>F</th>
<th>F Eugp</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>B</td>
<td>27.3</td>
<td>27.3</td>
</tr>
<tr>
<td>2</td>
<td>S1</td>
<td>15194.5</td>
<td>15167.0</td>
</tr>
<tr>
<td>3</td>
<td>S2</td>
<td>15159.8</td>
<td>15162.5</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Type</th>
<th>Well</th>
<th>F</th>
<th>F Eugp</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>D</td>
<td>27.2</td>
<td>27.2</td>
</tr>
<tr>
<td>2</td>
<td>S1</td>
<td>15084.3</td>
<td>15087.0</td>
</tr>
<tr>
<td>3</td>
<td>A1</td>
<td>15172.5</td>
<td>15174.3</td>
</tr>
<tr>
<td>5</td>
<td>S5</td>
<td>14.0</td>
<td>14.0</td>
</tr>
<tr>
<td>6</td>
<td>S1</td>
<td>15129.9</td>
<td>15102.5</td>
</tr>
<tr>
<td>7</td>
<td>A1</td>
<td>15084.2</td>
<td>15086.8</td>
</tr>
<tr>
<td>8</td>
<td>A2</td>
<td>15101.0</td>
<td>15101.0</td>
</tr>
<tr>
<td>10</td>
<td>S2</td>
<td>15176.5</td>
<td>15161.3</td>
</tr>
<tr>
<td>11</td>
<td>S2</td>
<td>15181.0</td>
<td>15182.8</td>
</tr>
</tbody>
</table>

Figure 140. Hidden vs. expanded data for replicate wells

EXCLUDING/DISPLAYING TABLE ERROR CODES

Error codes such as ***, OOR, ---, or * appear in the Report Table, if data cannot be measured or calculated, or if a sampling error occurs. To hide error codes in the table, select the Exclude Table Error Codes checkbox.
Click the Display Help for Table Legends button on the toolbar, to get definitions for any error conditions.

**SETTING NUMBER FORMATS**

Click the Set Number Format button in the Report Table Display Options dialog to set the number format for any column in the Report Table. The Set Column Number Format dialog opens.

![Set Column Number Format dialog](image)

In the dialog, select a column from the pulldown list, then specify the number of decimal places for the value of that column in the Decimal Places field. Select the Scientific Notation checkbox to display the number in scientific notation. Select the Same Number Format for All Columns checkbox to use the selected number format for all columns. Click OK to make the changes, or Reset Defaults to return all columns to their default number formats.

**NOTE:** Changing the number format changes only how the numbers are displayed and printed, and does not affect calculations in any way.

**SAVING SETTINGS AS A NEW PROTOCOL**

To use the selections in this dialog as the default in Results files generated from new Protocols, select the Save Settings as Default for New Protocol checkbox.
Report Table Column Descriptions

The columns in the table show the analyte data for each well or replicate group of wells. The available Report Table columns are defined below:

- **Type** — sample type (unknown, standard, blank, etc.) and number, based on plate formatting
- **Well** — well number; all wells are listed for a replicate group (see next section)
- **Outlier** — contains a checkbox for flagging the well or group of wells as an outlier. See page 161
- **Description** — description you entered for each standard, control, or sample in the Protocol
- **FI** — median fluorescent intensity of the analyte
- **FI — Bkgd** — median fluorescent intensity minus background (measured using the defined blank wells) of the analyte
- **Std Dev** — standard deviation of a replicate group of wells
- **Std Err** — standard deviation of a replicate group of wells divided by the square root of the number of replicates
- **%CV** — coefficient of variation of a replicate group of wells. If this value is high, you may want to review the individual FI values and select the appropriate member of the replicate group as an outlier (see next section)
- **Norm Ratio** — normalized ratio. See Data Normalization on page 207 for more information on normalizing data
- **Norm Ratio Std Dev** — standard deviation of the Norm Ratio values for all the wells within a sample’s replicate group
- **Norm Ratio Std Err** — the normalized standard deviation, Norm Ratio Std Dev, divided by the square root of the number of replicate wells within the sample’s replicate group
- **Norm Ratio %CV** — the normalized standard deviation, Norm Ratio Std Dev, divided by the normalized ratio of the sample’s replicate group
- **Norm FI** — normalized fluorescent intensity. See Data Normalization on page 207 for more information on normalizing data
- **Norm FI Std Dev** — standard deviation of the Norm FI values for all the wells within a sample’s replicate group
- **Norm FI Std Err** — the normalized standard deviation, Norm FI Std Dev, divided by the square root of the number of replicate wells within the sample’s replicate group
- **Norm FI %CV** — the normalized standard deviation, Norm FI Std Dev, divided by the normalized FI of the sample’s replicate group
**Report Table**

- **Conc in Range** — observed concentration that falls within the range of standard concentrations, given a specified recovery range. Values outside the range are flagged as ***. See page 160 for how Conc in Range relates to the Obs/Exp * 100 Column.
- **Obs Conc** — observed concentration of the analyte, calculated from its fluorescent intensity and the standard curve. Note that the observed concentrations of standards are back-calculated from their fluorescent intensities and the standard curve.
- **Obs Conc Std Dev** — observed concentration of the analyte, with the standard deviation of the replicate group of wells.
- **Obs Conc Std Err** — observed concentration of the analyte, with the standard deviation of a replicate group of wells, divided by the square root of the number of replicates.
- **Obs Conc % CV** — observed concentration of the analyte, with coefficient of variation of a replicate group of wells. If this value is high, you may want to review the individual FI values and select the appropriate member of the replicate group as an outlier.
- **Exp Conc** — expected concentration of the analyte standard or control, as specified in the Enter Standards Info window or Enter Controls Info window, respectively.
- **Obs/Exp * 100** — recovery rate for the observed versus expected concentrations of the standard or control (see page 160).
- **Group** — defined group of the selected well (see page 72).
- **Ratio** — a calculation performed when you have grouped samples in the plate formatting section. This calculation is the ratio of the member-to-reference measured values, or vice versa. (For more information, see Ratio (Simple) and the Grouping Function, on page 226 of the Appendix).
- **Dilution** — specified dilution factor of the analyte.
- **Bead Count** — number of beads counted in region for the analyte.
- **Bead Mean** — mean fluorescent intensity of the beads counted in region for the analyte.
- **Bead Std Dev** — standard deviation of the bead mean.
- **Bead Std Err** — standard error of the bead mean.
- **Bead %CV** — coefficient of variation of the bead mean.
- **Trimmed Mean** — bead mean, excluding the top 5% and bottom 5% of fluorescent intensities.
- **Trimmed Std Dev** — standard deviation of the trimmed mean.
- **Trimmed Std Err** — standard error of the trimmed mean.
- **Trimmed %CV** — coefficient of variation of the trimmed mean.
- **Sampling Errors** — error codes for a reading (see page 105).
Obs/Exp * 100 Column

Because the standard curve (see page 168) is critical for calculating the concentrations of unknowns, the Obs/Exp * 100 column in the Report Table allows you to assess how well the curve fits the standards. This column is also used with controls (page 96) to determine the overall accuracy of an assay.

The (Obs/Exp) * 100 column shows the recovery rate for the observed vs. expected concentration of each standard. This number should fall within the recovery percentage range selected in the Enter Standards Info window. For example, if you selected a recovery range within 80 to 120%, the observed (back-calculated) concentration of a standard should be within 80 to 120% of the expected concentration. Values outside this range are flagged in the Conc in Range column.

Click Report Table Options and select the (Obs/Exp) * 100 checkbox to display this column.

Concentration in Range Column

The concentration in range column (Conc in Range) provides a method for determining which unknown concentrations are reliable based on the recovery range of the standards (see the Obs/Exp * 100 section above).

This column shows only observed concentration values that fall within the range of valid standards; values that do not fall in the range are displayed as OOR< or OOR>. (The concentration in range values of the back-calculated standards are also shown, for comparison purposes.)
Report Table

For example, if only standard concentrations from 1.9 to 8,100 pg/ml fall within the specified recovery range, then only unknown concentrations that fall within this range are displayed in the Conc in Range column.

Refer to Standard Curve Optimizer on page 199 for information about how the Conc in Range column can help you optimize your Standard Curve fit.

**Showing/Hiding Outliers**

In some cases, you may want to exclude a well or replicate group of wells from statistical calculations (for example, when the %CV of a set of replicates is high, or the observed concentration of an analyte is out of range). The Report Table Outlier column allows you to flag a well or replicate group of wells as an outlier.

Click the Show/Hide Outliers Column button in the toolbar to show or hide the column.

Each row in the column contains a checkbox. When you check the checkbox, the data for the selected analyte is excluded and the table is automatically recalculated.

Note that flagging a well as an outlier for the selected analyte does not flag it as an outlier for all analytes. To do this, right-click the outlier checkbox for the well, and select Set Outlier (All Analytes) from the context menu.

![Figure 143. Selecting a well as an outlier for all analytes](image)

Now the well data for all analytes are excluded from calculations. To remove the outlier flag for all analytes, right-click the well and select Clear Outlier (All Analytes) from the context menu.
If you flag a replicate group of wells as an outlier, data for the entire group are excluded. If you click the Show Replicates button, you can flag each well in the group as an individual outlier. If you do this, the outlier checkbox for the entire group appears checked and grayed out, indicating that part of the group has been flagged.

![Figure 144. A single well in a replicate group flagged as an outlier](image)

### Resizing the Columns

To automatically size the columns to fit the width of the text, choose Autofit from the Table Options menu in the toolbar.

### Context Menus

There are two context menus available from the Report Table. Right-clicking within a header cell brings up a menu that allows you to show/hide a column, abbreviate analyte names, or view the Report Table Options dialog.

![Figure 145. Report Table header context menu](image)

Right-clicking within a body cell in the Report Table brings up a context menu that allows you to set a Plate ID, set a specific analyte as an outlier, or view the Report Table Options dialog.

![Figure 146. Report Table cell context menu](image)
Sorting Report Table Data

To sort the table data alphanumerically, click the heading of the column that you want to sort, then click the Sort button. Clicking twice will invert the order.

Copying the Report Table

You can copy the contents of the table to the Windows clipboard. Select rows, columns, cells, or the entire table, then select Copy from the Edit menu. The copied values can be pasted into other Windows applications.

Printing the Report Table

You can print the Report Table for the selected analyte (or multiple analytes, when in Multiple Analyte Layout) using the Print command on the main toolbar or File menu. You can print the Report Table for all analytes (when in Single Analyte Layout) using the Print All Analytes command on the main toolbar or File menu. Print Preview displays the table as it will appear in the printout.

Exporting the Report Table

To export the data in the Report Table to an Excel workbook, or tab-defined text file, click the Export Report Table button in the toolbar. The Table Export Options dialog opens.

Figure 147. Table Export Options dialog
Export Format

Select Single Analyte Layout to display all the data for each analyte in individual worksheets.

Figure 148. Example of an Excel workbook, single analyte layout

Select Multiple Analyte Layout to display one or more columns of data (for example, FI) for all analytes in a single worksheet.

Figure 149. Example of an Excel workbook, Multiple Analyte Layout

Select 96-Well Plate to display each analyte in a worksheet, laid out like the wells in a 96-well plate (rows A–H and columns 1–12).
Note that this selection exports only a single column of data at a time.

Figure 150. Example of an Export worksheet, 96-well layout
Click the Advanced Export Options button to access additional options.

Export a Subset of the Data
If you selected 96-Well Plate or Multiple Analyte Layout above, select which columns you want to export; you can select one column or all visible columns, by choosing from this pull-down list. You can export only the selected analyte, or export them all.
If you have selected Single Analyte Layout, All Analytes is the only choice available.

**Export Preferences**

Select Excel Workbook to export the data to a Microsoft Excel file, as described above, or Text File (Tab Delimited) to export to a tab-delimited text file (see Figure 152 for an example).

![Figure 152. FL — Bkgd data, multiple analytes, 96-well plate format, exported to a text file](image)

If you are exporting to Excel, Microsoft Excel automatically launches when you click OK and a worksheet appears.

If you are exporting to a text file, a Save As dialog will open when you click OK. Select the desired directory and name and click Save to complete the operation.
**Use Multiple Worksheets**

If you selected Excel Workbook and are generating multiple tables of data, select this checkbox to export each table to a different worksheet within the workbook. Otherwise, all tables appear on the same worksheet.

Choose from the following settings, based upon how you want your data presented:

- **Single Analyte** — This choice generates a workbook with one worksheet for each analyte.
- **Multiple Analyte** — If you check the Use Multiple Worksheets checkbox in the Advanced Export options dialog, you will generate a workbook with one worksheet for each column (FI, FI-Bkgd, etc.), with data for all analytes. If you leave the Use Multiple Worksheets checkbox unchecked, all of the data appears on one large worksheet, which can be viewed by scrolling with the elevator bar.
- **96-well** — If you check the Use Multiple Worksheets checkbox in the Advanced Export options dialog, you will generate a workbook with one worksheet for each analyte. If you leave the Use Multiple Worksheets checkbox unchecked, all of the data appears on a single worksheet.

**Exclude Standard Curves**

Standard curve images are automatically exported to Excel, by default. You can exclude them from the export by checking the box next to Exclude Standard Curve.

**Exclude Column Headers/Footers**

Select the Exclude Column Headers/Footers and Page Headers/Footers checkbox to exclude this information from the exported file.

**Exclude Table Error Codes**

See page 234 for a table of possible Report Table Error Codes.

The error code symbols (OOR< >, ***, ----, *) before concentration values in the Report Table can interfere with macros in some types of spreadsheets, including Excel. Select this checkbox to exclude these symbols from the exported file. If this option is selected, table cells with error codes are exported as empty cells.
Standard Curve

The Standard Curve window displays the standard curve for each standard analyte in the Results file, and allows you to change the regression model as well as various curve display controls for each analyte. (Curve settings are initially selected in the Enter Standards Info window in a Protocol; see page 78.)

Click the Standard Curve button to open the Standard Curve window.

![Standard Curve Window](image)

**Figure 153. Standard Curve**

In the graph, standards defined on the current plate are displayed as blue squares, while external standards are displayed as red circles. If both standard curves are displayed on the graph, Outliers and partial outliers will be displayed on the curve as indicated in the legend below the curve.

The equation for the selected regression method as well as some curve fit statistics (fit probability, residual variance) will be displayed below the standard curve. Equations for standards defined on the current plate are shown in blue, while equations for external standards are displayed in dark red. Any curve-fitting errors will also be displayed below the curve in red.

Use the Analyte pulldown list to display the curve for a selected analyte.

Above the curve, use the Labels pulldown list to select from a variety of different labels for the points in the curve. If both external and current standards are displayed in the graph, labels will only be displayed for the external standards.
Standard Curve

Use the Error Bars pulldown list to select from several types of error bars (such as 1-Std Dev, 2-Std Err) to plot for each point in the curve. If there is only one replicate for a point, the bar will have a value of zero. If both external and current standards are displayed in the graph, error bars will be displayed for the external standards only.

Use the Regression Type pulldown list to choose from seven different regression models to generate the standard curve (see next section).

**NOTE:** Changing the regression type will automatically recalculate all the data in the Report Table. If you are unsure whether your data have been recalculated, select Refresh Calculations from the View menu.

Use the Axis Transformation pulldown list to select the standard curve axis scale. Four combinations of linear and logarithmic axis scales are available.

**NOTE:** Changing the axis transformation will only change the display of the curve—not the calculated data.

You can use a different regression model for each analyte. Deselect the Same Regression Type for All Analytes checkbox, select a different analyte from the pulldown list, and select the regression type to use for that analyte.

From the Curve Options menu, select the Swap XY Axes to change the x and y axes of the curve.

From the Curve Options menu, select the Show Conc Range Lines to display this range as dotted lines on your graph.

Select the Show Unknown Samples checkbox to display your Unknown samples as green triangles in your graph.

Select the Show Control Samples checkbox to display your Control Samples as yellow triangles in your graph.

The Curve Fit area contains automated optimization controls discussed in greater detail in Standard Curve Optimizer on page 198. You can optimize individual or all analytes, undo the optimization, and clear outliers from your display.

To display all the data for each standard sample point in the curve, position your cursor over the point. A pop-up box will list the data.

*Figure 154. Pop-up data for a standard sample point in the curve*
Regression Methods

There are seven regression types for calculating the standard curve:

- Logistic-5PL
- Logistic-4PL
- Linear
- Cubic spline
- Point-to-point
- Linear (semi-log)
- Point-to-point (semi-log)

The minimum number of nonzero standards required for each regression method type is shown in the following table.

<table>
<thead>
<tr>
<th>Method</th>
<th>Minimum number of standards</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logistic-5PL</td>
<td>6</td>
</tr>
<tr>
<td>Logistic-4PL</td>
<td>5</td>
</tr>
<tr>
<td>Cubic spline</td>
<td>4</td>
</tr>
<tr>
<td>Linear (linear and semi-log)</td>
<td>2</td>
</tr>
<tr>
<td>Point to point (linear and semi-log)</td>
<td>2</td>
</tr>
</tbody>
</table>

If you do not have the minimum number of standards for the selected method, an error message will be displayed in red below the standard curve.

Figure 155. Example of two Logistic-5PL curves, for standards on the current plate, and external standards
**LOGISTIC-5PL**

This version of the five-parameter logistic equation has been developed by Brendan Scientific, creator of StatLIA immunoassay software. The Logistic-5PL regression type yields the best results for most assays; therefore, this is the default in Bio-Plex Manager. However, there may be cases in which the Logistic-4PL equation gives slightly better results.

The Logistic-5PL equation is:

\[ y = d + \frac{a - d}{1 + \left(\frac{y}{c}\right)^g} \]

where:
- \( x \) is the concentration,
- \( y \) is the response,
- \( a \) is the estimated response at infinite concentration,
- \( b \) is the slope of the tangent at midpoint,
- \( c \) is the midrange concentration or midpoint,
- \( d \) is the estimated response at zero concentration, and
- \( g \) is an asymmetry factor.

**LOGISTIC-4PL**

In certain cases, in which the curve is a perfectly shaped S, the Logistic 4PL regression may give better results. However, the Logistic-5PL regression has been shown to be the most robust routine for most Bio-Plex assays.

The Logistic-4PL equation is:

\[ y = d + \frac{a - d}{1 + \left(\frac{y}{c}\right)^d} \]

where:
- \( x \) is the concentration,
- \( y \) is the response,
- \( a \) is the estimated response at infinite concentration,
- \( b \) is the slope of the tangent at midpoint,
- \( c \) is the midrange concentration or midpoint, and
- \( d \) is the estimated response at zero concentration.
LINEAR

The Linear equation is:

\[ y = a + bx \]

where \( a \) is the intercept and \( b \) is the slope of the line.

The simplest method for determining concentrations from a standard curve is to construct a plot using the linear portion of the response curve. The \( R^2 \) integrity value may be used to determine the overall goodness of the linear fit. A linear regression with an \( R^2 \) value of greater than 0.99 is considered a very good fit.

The primary advantage of this method is that it is extremely simple. The primary disadvantage is that the linear range of concentrations is small compared to that which may be obtained using nonlinear regression.

The linear curve is available in linear and semi-log versions.

CUBIC SPLINE

Cubic spline curves are smooth curves that go through every data point. The model is a cubic polynomial on each interval between data points. In some cases, a spline curve can work well as a standard curve for interpolation. However, because the curve is calculated individually for every pair of points, it does not correspond to any single equation.

The cubic spline curve is applicable to a wide range of assays; however, there are no built-in biochemical restrictions on the curve shape, and values cannot be extrapolated.\(^1\)\(^2\)

POINT-TO-POINT

No single equation is available for the point-to-point method. The slope of each segment of the curve between data points is calculated independently.

The Point-to-Point curve is available in linear and semi-log versions.

---


\(^2\) The GraphPad Guide to Nonlinear Regression. Harvey Moltusky, PhD. GraphPad Software, San Diego, CA.
Linear vs. Logistic Regression Methods

In terms of performance, the primary difference between linear and logistic regression models is that the linear range in which concentrations can be accurately predicted is much smaller. In most cases, the overall response of the assay is best modeled using a logistic fit and the Logistic-5PL model will yield the best results. For more information, see Principles of Curve Fitting from the website (www.bio-rad.com) or from Technical Support.

Nevertheless, in certain cases, you may want to use linear regression to analyze the data. For most cytokines, the linear portion of the curve is well within the biological range of concentrations expected for patient samples. Thus, the linear regression may be useful for serum. The main advantage of a linear regression is that fewer points (as few as 2) can be used.

Copying the Standard Curve

To copy a bitmap image of the curve to the Windows clipboard, right-click in the Standard Curve window, and select Copy Graph to Clipboard. You can then paste this image into your spreadsheets or other documents, using the Paste command in your other applications.

Exporting the Standard Curve

To export a standard curve to Excel, follow the steps below.

1. Select the Export Standard Curve icon from the toolbar.

2. Select your choice of exporting an individual analyte, or all analytes, in the Export Standard Curve dialog. Legends, the standard curve equation, fit probability and residual variance display below the chart.
You can also copy the regression method equation from below the standard curve by dragging your cursor over the equation to highlight it, and then selecting Copy from the Edit menu or right-click Context menu.

![Figure 157. Copying regression method equation](image)

### Printing the Standard Curve

You can print the standard curve for the selected analyte using the Print command on the main toolbar or File menu. You can print the curves for all analytes using the Print All Analytes command on the main toolbar or File menu.

When you select a print command, a dialog box will open, allowing you to specify the page layout of the printed curve. The layout diagrams show the number of curves that can be printed on a page. If you are printing the curve for a single analyte, that curve will be sized based on the layout you select (for example, the layout will size the curve at one-quarter the full size of the page). The regression type will be printed below each curve.

![Figure 158. Print Standard Curve dialog](image)

Select a layout and click OK to display the standard Windows Print dialog.
Graphing Function

Click the Graphs button to display your Results data as graphs. You can choose one of two default graphs from the Graphs drop-down menu: All Unknowns & Controls, or All Samples for single or multiple analytes.

The y-axis for each default graph is the FI Result value, but you can change to a different parameter by choosing from the Result (y-axis) drop-down menu. Bar graphs represent the mean values displayed with error bars that indicate one standard deviation above and below the mean.

Figure 159. Unknowns and Controls graph, with FI y-axis
Figure 160. All Samples graph with Std Dev y-axis

Perform any data normalization functions before displaying your graphs.
If you want to see ratios among samples, or other normalization options, click the Normalization Settings button. See Data Normalization on page 207 for more information.
Choosing Graph Options

View

Select the Graph Options button to choose the type of graph that best displays your Results data. These options are in the View area.

![Graph Options dialog](image)

Figure 161. Graph Options dialog

Sample Label

You can identify samples of the graph either by their Type (X1, C1, S1) or by their description (which you enter for each sample). Choose either Type or Description from the Sample area at the bottom of the Graph Options dialog, shown above.
Under the Graph Options dialog, you can choose among four basic views, as shown in the four figures below. Click the appropriate button in the View field to display your choice.

- **Samples across a single analyte** — In this view a single analyte is represented for each sample and the selected result (such as FI, Norm ratio, etc.) is used as the y-axis parameter.

![Mo IL-3 (18)](image)

*Figure 162. Samples across a single analyte*

- **Samples across multiple analytes** — Samples are grouped by analyte along the x-axis and the result (such as FI, Norm ratio, etc.) used as the y-axis parameter.

![Graph](image)

*Figure 163. Samples across analytes view*
Graphing Function

- **Analytes across a single sample** — In this view a single sample is represented for each analyte and the selected result (such as FI, Norm ratio, etc.) used as the y-axis parameter.

![Figure 164. Analytes across a single sample view](image)

- **Analytes across multiple samples** — Analytes grouped by sample along the x-axis and the selected result (such as FI, Norm ratio, etc.) used as the y-axis parameter.

![Figure 165. Analytes across multiple samples view](image)

To choose between plain or 3-dimensional graph bars, choose from the Graph Type drop-down menu.
To gain room for your graphs, you can click the Hide Legends checkbox from the Graph Options menu.

To adjust y-axis values so that the data will be comparable throughout a series of graphs, click the Adjust data to same y-axis scale checkbox.

To change the y-axis display from linear to logarithmic, click the Logarithmic y-axis checkbox.

To adjust legends to accommodate the number of columns in your graph, click the x-axis labels orientation drop-down menu from the Graphs Options dialog. You can select vertical or horizontal legends, or legends angled at 30, 45, or 60 degrees.

**Viewing Information within Graphs**

To browse through many analyte graphs, click the green arrows to the left and right of the Analytes field in the toolbar. This displays a series of analyte graphs without having to search and select from a long list.

*Figure 166. Viewing a series of analyte graphs*

Analyte names, sample names, user-defined descriptions, and values are always available for view. Place your cursor over a specific column for a moment and the data display.

*Figure 167. Click to view data from graphs*
You can zoom into any graph by dragging a marquee around specific bars. Click the Zoom out button on the toolbar to return to the previous magnification.

Figure 168. Marquee to zoom into a graph

Right-clicking any results graph displays a context menu to access many functions described in this chapter.

Figure 169. Right-click context menu
Adding New Graphs

To create additional graphs, click the Add Graph button on the toolbar.

Select samples and analytes by clicking individual checkboxes, or with the Select All button. You can also click and drag over a range of samples, and select only those samples, by choosing Select from the right-click context menu.

Click the Graph Options button from the Add Graph dialog to choose a view and other options for displaying your data, as described on page 177.
After you choose options, name and save this graph, it is added to your Saved Graphs List under the Graph drop-down menu.

![Figure 172. Saved graphs list in the Graphs drop-down menu](image)

**Editing an Existing Graph**

The Edit Graph button is available only when viewing graphs with choices created by the user. The button will be grayed out while viewing either of the default graphs. This dialog displays checked boxes for the elements already chosen.

![Figure 173. Edit Graph dialog](image)

You can edit any graph by choosing it from your Saved Graph List. Add, delete or change elements by checking or unchecking the sample or analyte checkbox(es).
Deleting a Graph

Delete a graph from your Saved Graphs List with the Delete Graph button on the toolbar. You can also delete a graph by right-clicking any graph to bring up the Context menu.

Exporting Graphs to Other Applications

You can export your data to a spreadsheet application such as Excel, for its expanded graphing capabilities, or to match existing graphs. Click the Export to Excel button in the toolbar, or choose Export . . ., under the Graphs menu. The data open in an Excel spreadsheet.

Figure 174. Exporting graphs to Excel

You can also export the graphs as .bmp files, so they can be used in word processing, presentation, or other text-based applications. Click the toolbar File menu or right-click the graph, and a menu appears. Choose Save as bitmap, and the Save As dialog appears, so that you can name the file and place it anywhere in your file system.
Adjusting Your Graphs

If you open a graph that represents a very large number of data points, you may see black lines, as in the figure below.

![Graph containing many data points](image)

*Figure 175. Graph containing many data points*

Choose fewer analytes or samples, and your columns will widen, so that the analyte color codes can be represented.

Zoom into your graph by clicking and dragging over any area of interest, as shown in Figure 168. To return to the original view, click Zoom Out from the toolbar.

Another option is to print your graph on multiple pages, which allows the bars to be much wider. See the Printing Graphs section below.

Printing Graphs

Access the controls to print your graphs from the toolbar, the right-click context menu, or the File menu.

![Print Graph dialog](image)

*Figure 176. Print Graph dialog*

When the graph containing many data points from Figure 175 is printed onto four pages, the color-coded columns are visible. To preview how your graph will look printed over multiple pages, click the Go to Preview button.

The Print Graph dialog allows you to print your graph on a specific number of pages, to choose a landscape or portrait orientation, and to preview the printed copy.
Document Export Options

In addition to the export options available in the raw data and results table section of the data file, there are a number of document export options. These options are chosen from the Document Export Properties dialog box shown below, which is available from the File menu.

- **Bio-Plex XML** — this is a comprehensive export of individual results files in an .xml format. This format is useful for import into LIMS (Laboratory Information System) or other database applications.
- **Output CSV format** — this mimics the output of third-party software, such as IS 2.3 or xPONENT, with common options.
- **Custom Export using style sheets** — customer-developed stylesheets can extract any of the data exported to the Bio-Plex XML file. See page 191 for more information. Using stylesheets allows you to format the data in any way desired, provided you have experience developing stylesheets. Some default stylesheets are included for guidance.
- **Command Line Export** — custom export by passing a command line to external applications. See page 192 for more information.
Document Export Options

All these export options can be set to occur automatically at the end of a run, by choosing the Auto export after run checkbox from the Run Settings dialog. The Advanced Run Settings dialog box launches from the Run Protocol screen, during the process of setting up a Protocol.

![Advanced Run Settings](image)

**Figure 178. Advanced Run Settings**

**Bio-Plex XML Export**

You can export all the information in a Results file as an XML-formatted text file. This export option generates a comprehensive export of individual results files in an XML format. This format is useful for import into LIMS databases, and to perform data analysis using other applications.

**NOTE:** XML is a self-describing, universal file format compatible with a wide range of applications.

The XML document generated by Bio-Plex Manager includes all the data stored in the Results file, including but not limited to:

- Run parameters, including DD gate settings, instrument temperature settings, data limits, bead regions, etc.
- Run conditions, including time stamps per well, error conditions during the run, actual temperature during acquisition by well, etc.
- Complete data values and calculations (mean, median, standard deviation, coefficient of variation, etc.) per well
- Complete protocol information, including analytes selected, plate formatting, standard values, run settings, etc.
- Raw bead event data (when selected)
- Standard curve information, including mathematical models used, how well the data fit the curve, etc.
- Instrument and software information, including version numbers
- All logged events associated with the data file for CFR 21 Part 11 compliance
To export the Results data in XML format:
2. Choose the Bio-Plex XML option.
3. Choose the location to save the file.

**XML Schema File**

An XML schema file named *Bio-Plex_5.xsd* is included in the main Bio-Plex Manager application directory, for those who want to write an importer for Bio-Plex Manager results files. This schema file can be used to automatically validate the XML file.
Output CSV File Format

This option exports an output CSV file similar to those generated by IS 2.3 software. It can be opened in third-party applications designed to analyze IS 2.3 files. You have the option of changing analyte labels, well labels, and analyte sort order in the resulting CSV (comma-separated values) file.

There are several export options available in the CSV format Content field.

**ANALYTE LABELS**

Various software packages require different analyte naming conventions, such as IL-2, which appear in the column heading within the CSV files. Refer to the software instructions to identify which settings are suitable for your application.

- **Name**—Only the analyte description is generated in the report (as in IL-2)
- **Region**—Only the region identifier is listed in the column header (as in 18)
- **Name (Region)**—Both name and region ID are exported (as in IL-2 (18))

**WELL LABELS**

Rows in the CSV file represent well positions. There are two ways to indicate well position. Well A1 (plate location) is equivalent to Well 1. Well H1 is equivalent to Well 8. Row H12 is equivalent to well 96 (sequential).

- **Sequential**—(1, 2, 3)
- **Plate Location**—(A1, B1, C1)

Figure 179. CSV Content options in the Document Export window
**ANALYTE SORT ORDER**

You can indicate the left to right sort order in the output CSV file.

- **None**—sorts as the analytes are shown in the panel entry screen of Bio-Plex Manager
- **Analyte Name**—sorts alphanumerically by analyte name
- **Analyte Region**—sorts by region number

These sort options are shown in the Figure 180.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
<th>J</th>
</tr>
</thead>
<tbody>
<tr>
<td>22</td>
<td>Results</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>23</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>24</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>Data Type</td>
<td>Location</td>
<td>Analyte</td>
<td>Sample</td>
<td>Hu C-peptide</td>
<td>Hu Ghrelin</td>
<td>Hu GIP</td>
<td>Hu GLP-1</td>
<td>Hu Glucagon</td>
</tr>
<tr>
<td>26</td>
<td>A *(A1)</td>
<td>ha diabetes antigen standard S1</td>
<td>113.37</td>
<td>233.71</td>
<td>108.85</td>
<td>269.64</td>
<td>662.95</td>
<td>2768.5</td>
<td>2284.4</td>
</tr>
<tr>
<td>27</td>
<td>B *(B1)</td>
<td>ha diabetes antigen standard S2</td>
<td>8859.5</td>
<td>146.87</td>
<td>106.89</td>
<td>307.82</td>
<td>5986.5</td>
<td>2277.5</td>
<td>7253.5</td>
</tr>
<tr>
<td>28</td>
<td>C *(C1)</td>
<td>ha diabetes antigen standard S3</td>
<td>1303</td>
<td>7780</td>
<td>14582</td>
<td>27525</td>
<td>432.5</td>
<td>7542.5</td>
<td>1314</td>
</tr>
<tr>
<td>29</td>
<td>D *(D1)</td>
<td>ha diabetes antigen standard S4</td>
<td>127.5</td>
<td>30.7</td>
<td>80.38</td>
<td>121.93</td>
<td>114.7</td>
<td>1961</td>
<td>555</td>
</tr>
<tr>
<td>30</td>
<td>E *(E1)</td>
<td>ha diabetes antigen standard S5</td>
<td>24</td>
<td>131.9</td>
<td>252.7</td>
<td>1381</td>
<td>181</td>
<td>456</td>
<td>121</td>
</tr>
<tr>
<td>31</td>
<td>F *(F1)</td>
<td>ha diabetes antigen standard S6</td>
<td>15</td>
<td>425</td>
<td>610</td>
<td>224</td>
<td>51</td>
<td>111</td>
<td>59</td>
</tr>
<tr>
<td>32</td>
<td>G *(G1)</td>
<td>ha diabetes antigen standard S7</td>
<td>11</td>
<td>125.5</td>
<td>253</td>
<td>92</td>
<td>40</td>
<td>40</td>
<td>101</td>
</tr>
<tr>
<td>33</td>
<td>H *(H1)</td>
<td>ha diabetes antigen standard S8</td>
<td>12</td>
<td>75.6</td>
<td>162</td>
<td>84</td>
<td>39</td>
<td>29.5</td>
<td>120</td>
</tr>
<tr>
<td>34</td>
<td>I *(I1)</td>
<td>ha diabetes antigen standard S9</td>
<td>12634</td>
<td>25531.5</td>
<td>19942</td>
<td>26534</td>
<td>69.0</td>
<td>27019.5</td>
<td>29999</td>
</tr>
<tr>
<td>35</td>
<td>J *(J1)</td>
<td>ha diabetes antigen standard S10</td>
<td>7807</td>
<td>13982</td>
<td>17088</td>
<td>26546.5</td>
<td>6487</td>
<td>27185.5</td>
<td>66442</td>
</tr>
<tr>
<td>36</td>
<td>K *(K1)</td>
<td>ha diabetes antigen standard S11</td>
<td>1367.5</td>
<td>7600</td>
<td>16505</td>
<td>26487</td>
<td>4082</td>
<td>7358</td>
<td>12131</td>
</tr>
<tr>
<td>37</td>
<td>L *(L1)</td>
<td>ha diabetes antigen standard S12</td>
<td>118</td>
<td>31.49</td>
<td>7424.5</td>
<td>16019</td>
<td>1687</td>
<td>206</td>
<td>5383</td>
</tr>
<tr>
<td>38</td>
<td>M *(M1)</td>
<td>ha diabetes antigen standard S13</td>
<td>22</td>
<td>120.4</td>
<td>2205</td>
<td>1189.5</td>
<td>117</td>
<td>392</td>
<td>129</td>
</tr>
<tr>
<td>39</td>
<td>N *(N1)</td>
<td>ha diabetes antigen standard S14</td>
<td>14</td>
<td>401</td>
<td>690</td>
<td>222</td>
<td>52</td>
<td>102</td>
<td>101</td>
</tr>
<tr>
<td>40</td>
<td>O *(O1)</td>
<td>ha diabetes antigen standard S15</td>
<td>13</td>
<td>119.5</td>
<td>251</td>
<td>164</td>
<td>42</td>
<td>36</td>
<td>52</td>
</tr>
<tr>
<td>41</td>
<td>P *(P1)</td>
<td>ha diabetes antigen standard S16</td>
<td>14</td>
<td>80</td>
<td>172</td>
<td>86</td>
<td>44</td>
<td>22</td>
<td>108</td>
</tr>
<tr>
<td>42</td>
<td>Q *(Q1)</td>
<td>ha diabetes antigen standard S17</td>
<td>14</td>
<td>90</td>
<td>150.5</td>
<td>92</td>
<td>39</td>
<td>18</td>
<td>90</td>
</tr>
<tr>
<td>43</td>
<td>R *(R1)</td>
<td>ha diabetes antigen standard S18</td>
<td>108</td>
<td>5497</td>
<td>1087.5</td>
<td>20895</td>
<td>2451.5</td>
<td>5398</td>
<td>4160</td>
</tr>
<tr>
<td>44</td>
<td>S *(S1)</td>
<td>ha diabetes antigen standard S19</td>
<td>33</td>
<td>180.3</td>
<td>3689.5</td>
<td>3222</td>
<td>27.6</td>
<td>680.5</td>
<td>171.5</td>
</tr>
<tr>
<td>45</td>
<td>T *(T1)</td>
<td>ha diabetes antigen standard S20</td>
<td>1503</td>
<td>384</td>
<td>1383</td>
<td>101</td>
<td>18</td>
<td>103.5</td>
<td>208.5</td>
</tr>
<tr>
<td>46</td>
<td>U *(U1)</td>
<td>ha diabetes antigen standard S30</td>
<td>92</td>
<td>401</td>
<td>183</td>
<td>877</td>
<td>491</td>
<td>111</td>
<td>181</td>
</tr>
</tbody>
</table>

*Figure 180. Well labels and Analyte labels*
Using Stylesheets

Stylesheets allow unlimited customization of exported data. Click the “Use the following stylesheet” button to navigate to one of the default stylesheets. Stylesheets describe the format and content of the resulting export.

Using stylesheets allows you to format data in any way desired, provided you have experience developing stylesheets. Some default stylesheets are included for guidance.

If you are not familiar with stylesheets, there are contractors who specialize in stylesheet design. IT professionals who are familiar with XML can often develop custom stylesheets based on the examples given.

Once a style sheet is identified for document export, it will be used to define the export file parameters and the resulting file will be placed in the location indicated in the destination line discussed below.

FILE DESTINATION OPTIONS

Use the default file name and location, or click Choose Folder to specify a new file name and location. The exported file can be placed on your system or in a shared file.

Figure 181. Destination field of Document Export Properties
Command Line Export

This is an advanced option for customers who use custom-designed applications to analyze their data. You need knowledge of the following to use this option:

- The term “command argument”
- Writing computer code
- Implementing custom software applications

Select Command Line and click Select Application to locate the software application you want to automatically launch when the file is generated. This application must accept a command line filename argument.

After you locate and select the application, the application path name will appear in the Command Line field enclosed in quotation marks, and the string "&&XML&&" will be automatically appended to it, as shown in Figure 182.

NOTES:

- If you manually enter the application path name, it must be enclosed in quotation marks
- The &&XML&& token must also be enclosed in quotation marks

If the application can be found by using the system executable search PATH, only the application name needs to be entered.

![Figure 182. Example of a command line](image)
Exporting the Document

After you make the choices described above in the Document Export Options dialog box, click OK. Choose the Document Export option from the File menu.

The Document Export window uses the properties previously set in the Document Export Properties dialog and allows you to export. Your choices can also be changed in this dialog.

![Document Export window](Image)

*Figure 183. Document Export window*
Importing Luminex xPONENT Output Files

From Bio-Plex Manager, you can launch Bio-Plex Results Generator and import a Luminex xPONENT 3.1 or 4.0 CSV output file into Bio-Plex Manager.

1. From the File menu, select Import from xPONENT Output CSV. Bio-Plex Results Generator is launched and the Bio-Plex Results Generator window displays.
   
   NOTE: You must have the Bio-Plex Results Generator software installed on your machine in order to access this feature in Bio-Plex Manager.

2. Click Select File(s) and select the file you want to import.

3. Click Select and specify the location for the generated file.

4. Click Generate to convert the CSV file to an .RBX file.

   By default, the converted results file is opened in Bio-Plex Manager.

   TIP: Click Help in the Bio-Plex Results Generator window to get more information on using the product.
Exporting Results Data to Bio-Plex Data Pro™

You can seamlessly export your data from Bio-Plex Manager and import them into Bio-Plex Data Pro, where you can do an extensive and in-depth analysis of your results. To use this feature, you must have both products installed on your computer, though you do not have to have Bio-Plex Data Pro running at the time. Bio-Plex Manager automatically launches Bio-Plex Data Pro if the software is not already running.

1. From Bio-Plex Manager, open the Results file that you want to export, then click Export Results to Bio-Plex Data Pro in the toolbar.

NOTE: Bio-Rad strongly advises that data results are optimized before exporting to Bio-Plex Data Pro. You may choose to use the Bio-Plex Manager auto optimization, or you can optimize the results yourself.

If the data are not optimized, a dialog displays. If the results have been optimized, click Yes to proceed with the export. If the results are not optimized, click No to first optimize the data, then proceed with the export. For more information on curve optimization, see Standard Curve Optimizer on page 199.
2. In the Export to Bio-Plex Data Pro dialog, enter a name for the data set you are exporting. By default, the name of the results file is displayed.

3. Click Export.

The Bio-Plex Data Pro application is launched if it is not already running. The Import Data Sets dialog in Bio-Plex Data Pro automatically appears.

The data set is listed and Bio-Plex Manager is displayed as the source of the data.
Exporting Results Data to Bio-Plex Data Pro™

4. Select an existing project from the Import Into drop-down list or create a new project into which to import the data. Additional data sets can be added to the Data Set Files list by using the Browse button. You may also return to Bio-Plex Manager to export another data set.

5. Click Import. When the data have been imported, the Status displays Done. If the same data were previously imported into the project, Bio-Plex Data Pro does not import the data a second time, and the Status displays Exists. If a file with the same name was previously imported but the data are different, or the same data are exported twice from different versions of Bio-Plex Manager, the data set is imported and the Status displays Renamed.

6. Click Close. NOTE: You start this procedure from Bio-Plex Manager. However, at the end of the procedure, you are left in Bio-Plex Data Pro because the assumption is that you will want to proceed with analyzing your results in Bio-Plex Data Pro.

For more information on importing data in Bio-Plex Data Pro, see Bio-Plex Data Pro User Guide.
10 Standard Curve Optimizer

Bio-Plex Manager™ 6.1 software contains a new function to optimize the fit of standard curves. A standard practice used to improve the fit is detecting and removing outliers by using nonlinear logistic (4PL or 5PL) equations when fitting data points. Bio-Plex Manager uses the percent recovery of individual standard points to assess standard curve recovery and assess the goodness of fit.

The optimizer tools are bordered in red on the Standard Curve figure below.

Figure 184. Standard Curve Fit Optimizer tools
Refer to Determining Outliers on page 201 for more information and instructions.

**Background**

**Standard Curve Recovery**

Bio-Plex Manager calculates an observed concentration for each standard point from the standard curve. This is divided by the expected concentration (entered by the user in the Enter Standards Info window) and multiplied by 100 to give a recovery percentage. These calculations are automatically performed by the software. The reported recovery of the standard curve points are in the Obs/Exp * 100 column pictured below.

![Table](image)

*Figure 185. Obs/Exp * 100 column reports Standard Curve Recovery*

The recovery percentages of the standard curve points indicate the overall accuracy of the assay. The user can specify more or less stringent ranges for individual assays.

Use the Acceptable Recovery Range drop-down menu in the Enter Standards Info window to select an acceptable recovery range. To set different recovery ranges for different analytes, uncheck the box next to Same recovery range for all analytes. For more information on this feature, see Recovery Percentage Range on page 95.
Concentration in Range

Concentration in range (Conc in Range) reports which standards, controls, and unknown concentrations are reliable, based on the recovery range of the standards. The Conc in Range column shows only observed concentration values that fall within the range of valid standards, as defined by acceptable recovery ranges. Values that do not fall in the range are displayed as < OOR or OOR >.

![Table of Concentration in Range and Observed Concentration columns](image)

Determining Outliers

The Standard Curve Optimizer maximizes the usable range of an analyte's standard curve, based on the percent recovery range selected (the recommended recovery range is 70-130%). The optimization program evaluates several parameters, including tests for bead count, CVs of replicates hook effect, recovery value and points in the noise region of the curve (flatness at the low end).

Additionally, the optimization program will favor the fit at the low or high end of the curve, depending upon the number of unknowns falling in the respective regions.

Recommended Use

We recommend you review the standard curve fit optimizer report after running an optimization, and review the Results and Comments material outlined below. These are designed to help you review your data quickly for issues that may concern you. We also recommend that you pay particular attention to those analytes with comments, or those that return a Check Data state.
Standard Curve Optimizer Report

Once a data set has been optimized, a report is generated that will indicate any standard curves which should be reviewed by the user.

![Standard Curve Optimization Report](image)

*Figure 187. Standard Curve Optimization Report*

Two types of information presented for each analyte; Results and Comments.

**RESULTS**

This column presents the optimization event results, reported as three different outcomes.

- **Successful** — The algorithm was successful. It was able to improve the range of the assay, or no changes were implemented.
- **Not Optimized** — No changes were identified which could improve the range of the assay. It is possible that manual optimization could improve the fit.
- **Check Data** — There were significant challenges associated with this data file, and it is recommended that the data be reviewed.

Review the included comments, in any case. Possible comments are described below.
COMMENTS

Comments are included to point out particular issues that may be of interest.

- **Low Bead Counts Detected (Low Bead)** — This message will be presented if fewer than 20 beads are detected. This suggests one of the following problems:
  - Incorrect gates are set
  - Incorrect region is set
  - Insufficient agitation of plate before reading
  - Perforated well (if using a filter plate)
  - Some other contributor to bead loss

- **Standard Concentrations are not set (Stand Conc)** — Standards have either no value of 0 value entered. Correct this by applying the appropriate concentration to your standards, or renaming your 0 standard as a blank (it is inappropriate to have a standard of 0 value).

- **One or more standard has a CV higher than 20% (High % CV)** — If one or more standard has a CV higher than 20%, you may want to check your data to identify systemic loading issues. Also make sure you agree with the algorithm decisions to mark certain standards as outliers.

- **More than one standard (all replicates) has been marked as an outlier (>1 Std Removed)** — This message will be displayed if all replicates of more than one standard point has been completely removed (that is, marked as an outlier). You may want to review the data for such standard curves.

- **The upper range of your curve is limited because 2 or more high concentration standards have poor recovery.**

By default, the report displays at the end of an optimization. You may disable the automatic display by deselecting the checkbox next to Show report after optimization. This report can also be viewed at any time, by choosing the button below the optimizer controls.
Residual Variance and Fit Probability

Other statistical parameters that can be used to evaluate and adjust goodness of fit include spiked recovery, residual variance, fit probability and weighting.

Residual variance measures how well a curve fits the individual data points. Fit probability provides statistical evaluation of residual variance to determine acceptability. The values of fit probability range from 1.0 (perfect fit) to 0 (no fit).

These fit probability and residual variance values are reported by Bio-Plex Manager, as shown in this figure.

Logistic Weighting

If you are using Logistic 5PL or Logistic 4PL, Bio-Plex Manager will automatically weight the points in the curve. There are eight models for calculating the variance in the logistic weighting algorithm.

The default setting for Variance Model is Power Law Variance. Weighting coefficient $a$ will be automatically calculated.
Alternatively, users can specify a different coefficient. Click the Curve Options menu and select Logistic Weighting to display the dialog and deselect the Auto calculate coefficient $a$ checkbox. Weighting coefficient $b$ has a default value of 1.8. Users can enter a different value to adjust curve fitting.

**Figure 189. Logistic weighting**

Under default settings, data points that cannot be measured or calculated according to pre-defined specifications display as error codes.

Figure 190 tabulates the most commonly encountered error codes and their corresponding causes. The non-numeric code symbols in the Report table (OOR<>,***, or * before concentration values) may interfere with macros in some types of spreadsheets, including Excel.
These symbols can be excluded from the exported file by checking the box for Exclude table error codes, as shown in the figure below. Sampling errors related to instrument, reagent and sample preparation can also be monitored by checking the box for Sampling Errors under Report Display Options.

Figure 190. Excluding error codes
11 Data Normalization

There are two main reasons to use data normalization:

- You may need to account for differences in the amount of material loaded in each sample. This is accomplished using analytes that will not vary from sample to sample (for example, housekeeping genes, reference genes, and internal controls).
- You may want to express all other samples' measured values relative to an assigned control sample. The normalized control sample has a value of 1 and other samples have measured values relative to the control (for example, 5.57-fold higher mRNA compared to the control, or 2-fold higher protein level compared to the control).

Normalization Settings

Normalization is off by default. Click the Normalization Settings button on the toolbar, or choose View> Normalization Settings, to enable data normalization from any view of the experiment results. The dialog allows you to specify how you want to normalize data.

The Normalization Settings dialog box provides the following options:

- Internal Control/Housekeeping Genes (None, Single, and Multiple)
- Control Sample (always None or Single)
Selecting Internal Controls/Housekeeping Genes

The Internal Control/Housekeeping Gene field in this dialog allows you to account for differences in the amount of sample material. This function requires that the sample contain analytes whose concentrations will not vary from sample to sample (for example, housekeeping genes, reference genes, and internal controls).

To select a single internal control/housekeeping gene, click the Single radio button and select a housekeeping gene from the pulldown list.

To select multiple internal controls/housekeeping genes, click the Multiple radio button, and select which housekeeping genes to use from the following dialog box.

![Figure 191. Selecting a Single Internal Control](image)

To select multiple internal controls/housekeeping genes, click the Multiple radio button, and select which housekeeping genes to use from the following dialog box.
Double-click an analyte, or select and click Add. The housekeeping genes populate the Selected field of the dialog box. Bio-Plex Manager™ allows you to add up to 10 housekeeping genes.

**NOTE:** The normalized value for each sample is calculated by dividing the mean fluorescence intensity (MFI) of the analyte of interest by the MFI of the analyte used for normalization. When multiple analytes are used for normalization, the geometric mean of the normalization analytes’ MFI is used.

**Assigning a Control Sample**

The Control Sample field in this dialog allows you to express all gene sample measured values relative to an assigned control. The control sample has a value of 1 and other samples are expressed as ratios (for example, 5.57-fold higher mRNA compared to the control, or 2-fold higher protein level compared to the control).

Brackets around analytes in any list indicate they are used as internal controls.

To assign a control sample, click the Single button in the Control Sample field. Click None to disable your choice.
Figure 193. Assigning a Control Sample

NOTE: For the formulas used to calculate control sample ratios, see Normalization Formulas on page 223.

**Report Table Options**

To display normalization results, click the Report Table Options button, and select the columns you want to display from the Report Table Display Options dialog.
Figure 194. Report Table Display Options dialog

The Report Table displays columns for data normalization. The column titles associated with the normalization calculations begin with Norm Ratio or Norm FI.

**Predefined Normalization Report Schemes**

Select Norm Qualitative in the Report Scheme field. The Norm Qualitative column is designed to be used with gene expression.

When selected in Report Table Display Options, the following data normalization columns appear in the Report Table.

Figure 195. Normalization Columns in the Report Table
Normalization Definitions

The following columns and their associated calculations are provided when performing data normalization. Here are definitions for these columns:

- **Norm Ratio**—normalized ratio. See Normalization Formulas on page 223, for details about the formulas used for this calculation.
- **Norm Ratio Std Dev**—standard deviation of the Norm Ratio values for all the wells within a sample’s replicate group.
- **Norm Ratio Std Err**—the normalized standard deviation, Norm Ratio Std Dev, divided by the square root of the number of replicate wells within the sample’s replicate group.
- **Norm Ratio %CV**—the normalized standard deviation, Norm Ratio Std Dev, divided by the normalized ratio of the sample’s replicate group.
- **Norm FI**—normalized fluorescent intensity. See Normalization Formulas on page 223, for details about the formulas used for this calculation.
- **Norm FI Std Dev**—standard deviation of the Norm FI values for all the wells within a sample’s replicate group.
- **Norm FI Std Err**—the normalized standard deviation, Norm FI Std Dev, divided by the square root of the number of replicate wells within the sample’s replicate group.
- **Norm FI %CV**—the normalized standard deviation, Norm FI Std Dev, divided by the normalized FI of the sample’s replicate group.

Calculations Based Upon Your Settings

**Norm (Ratio)**—Normalized (FI—Bkgd) ratio.
The following table is based on the selections made in Normalization Options. It also describes how the Norm (Ratio) is calculated:

<table>
<thead>
<tr>
<th>Case</th>
<th>Internal Controls</th>
<th>Control Sample</th>
<th>How Norm (Ratio) is Calculated</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Single</td>
<td>None</td>
<td>Ratio of (FI-Bkgd) for the analyte and the housekeeping gene: Norm (Ratio) = (FI-Bkgd)/(FIhk-Bkgdhk)</td>
</tr>
<tr>
<td>B</td>
<td>Multiple</td>
<td>None</td>
<td>Geometric mean of the normalized (FI - Bkgd) ratios for each housekeeping gene</td>
</tr>
<tr>
<td>C</td>
<td>Single</td>
<td>Single</td>
<td>Normalized (FI - Bkgd) ratio/(FI - Bkgd) control ratio for the control (as defined in Case A): Norm (Ratio) = Norm (Ratio) single gene/Norm (Ratio) control</td>
</tr>
<tr>
<td>D</td>
<td>Multiple</td>
<td>Single</td>
<td>(Ratio) multiple internal control divided by the Norm (Ratio) multiple control (as defined in Case B) for the control: Norm (Ratio) = Norm (Ratio) multiple internal/Norm (Ratio) multiple…</td>
</tr>
<tr>
<td>E</td>
<td>None</td>
<td>Single</td>
<td>Ratio of (FI-Bkgd) for the analyte and the control: Norm (Ratio) = (FI-Bkgd)/(FI control-Bkgdcontrol)</td>
</tr>
</tbody>
</table>

NOTES:
- Replicates are done at the plate level. See the section on plates to define replicates.
- When using multiple replicates, the Norm (Ratio) for each replicate is calculated as described in Case A, B, C, D, and E. For each sample type, the replicates’ average is the Norm (Ratio).
- For information about the formulas Bio-Plex Manager uses to calculate normalization values, see Normalization Formulas on page 223.
Normalization Factor Calculations

Normalization factors are determined in the following ways.

Table 1.

<table>
<thead>
<tr>
<th>Case</th>
<th>Factor</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Control sample present for normalization</td>
<td>Average of (FI-Bkgd) for the external control for all analytes. Factor = Average [ (Flcontrol-Bkgdcontrol) analyte1, (Flcontrol-Bkgdcontrol) analyte2, (Flcontrol-Bkgdcontrol) analyte3, etc.]</td>
</tr>
<tr>
<td>B</td>
<td>No control sample and single housekeeping gene</td>
<td>Average of (Flhk-Bkgdhk) for all wells with this housekeeping gene. Data are taken from raw data table (average replicate values for each sample type from report table are not included). Factor = Average [ (Flhk-Bkgdhk) well1, (Flhk-Bkgdhk) well2, (Flhk-Bkgdhk) well3, etc.]</td>
</tr>
<tr>
<td>C</td>
<td>No control sample and multiple housekeeping genes</td>
<td>Factor = Geometric Mean (Factorhk1, Factorhk2, Factorhk3, etc.)</td>
</tr>
</tbody>
</table>
# Troubleshooting

Follow these suggestions to troubleshoot your Bio-Plex system.

<table>
<thead>
<tr>
<th>Message/Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>More Likely:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>&quot;Bio-Plex Manager 6.1 software has detected a problem with low bead number&quot;</td>
<td>Too few beads in the assay (2,500 per region recommended)</td>
<td>Check bead number calculations in assay.</td>
</tr>
<tr>
<td></td>
<td>Plate not shaken for 30 seconds before analysis.</td>
<td>Remove plate from array reader and shake for 30 seconds.</td>
</tr>
<tr>
<td></td>
<td>Buffer volume in wells is too low (125 μl is recommended).</td>
<td>Resuspend wells in 125 μl. Perform Remove Bubbles.</td>
</tr>
<tr>
<td></td>
<td>Microbubble in cuvette.</td>
<td>Perform Remove Bubbles, Perform Unclog to verify fluidics integrity.</td>
</tr>
<tr>
<td></td>
<td>Possible clog.</td>
<td>Perform Unclog and rerun. If unsuccessful, repeat. If still unsuccessful, contact Technical Support.</td>
</tr>
<tr>
<td><strong>Less Likely:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Incorrect needle height.</td>
<td>Adjust needle height.</td>
<td></td>
</tr>
<tr>
<td>Incompatible plate type used.</td>
<td>Replace with flat bottom or filter plate and adjust needle height.</td>
<td></td>
</tr>
<tr>
<td>Vacuum system not calibrated.</td>
<td>Calibrate vacuum system (see hardware manual).</td>
<td></td>
</tr>
<tr>
<td>Filter plate not flat.</td>
<td>Check filter plate flatness (see hardware manual).</td>
<td></td>
</tr>
<tr>
<td>Incompatible suspension buffer used.</td>
<td>Check buffer compatibility (see hardware manual).</td>
<td></td>
</tr>
</tbody>
</table>

| "Bio-Plex Manager has detected a problem with selection of regions" |       |          |
| Incorrect bead regions were selected in the Protocol. | Compare bead regions in the assay with those selected in the Protocol. | |
| Incorrect regions were selected when preparing the assay. | Verify regions chosen during assay preparation. | |
| Too few beads in the assay in one or more regions. | Verify regions chosen during assay preparation. | |
| Too few beads in the assay in one or more regions. | Verify that the correct number of beads was used by referring to the specific assay preparation procedure. | |
## Bio-Plex Manager Software 6.1 User Guide | Troubleshooting

<table>
<thead>
<tr>
<th>Message/Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>&quot;Bio-Plex Manager has detected a possible problem due to microbubbles in the cuvette or photobleached beads&quot;</strong></td>
<td>More likely:</td>
<td>Perform 30-minute warm up and recalibrate.</td>
</tr>
<tr>
<td></td>
<td>Calibration was performed before the array reader was warmed up.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Calibrated with incorrect CL1 or CL2 target values.</td>
<td>Check that the target values of the CAL beads match values entered in the software. If different, recalibrate.</td>
</tr>
<tr>
<td></td>
<td>Array reader was calibrated with a dirty MCV Plate IV.</td>
<td>Clean MCV Plate IV and recalibrate.</td>
</tr>
<tr>
<td></td>
<td>Misalignment of optics.</td>
<td>Perform Optics Validation. Contact Technical Support if values are not within range.</td>
</tr>
<tr>
<td><strong>Less likely:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Microbubbles present in cuvette.</td>
<td>Perform Remove Bubbles.</td>
</tr>
<tr>
<td></td>
<td>Calibration beads are photobleached (do not expose to light for more than 1 hour).</td>
<td>Recalibrate with new CAL1 beads.</td>
</tr>
<tr>
<td><strong>Needle stuck in down position</strong></td>
<td></td>
<td>See hardware manual for procedure for raising needle stuck in down position. Then remove cover from assay plate.</td>
</tr>
<tr>
<td></td>
<td>Protective assay plate covering was not removed.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Needle guide is not screwed all the way in.</td>
<td>Tighten needle guide by turning tube clockwise until tight.</td>
</tr>
<tr>
<td></td>
<td>Sample needle is bent.</td>
<td>Replace bent needle with a new needle (see hardware manual for procedure).</td>
</tr>
<tr>
<td><strong>Optics, Fluidics, Reporter, or Classify Validation Procedure fails due to low bead number</strong></td>
<td></td>
<td>Resuspend beads and repeat validation procedure. If procedure still fails, contact Technical Support.</td>
</tr>
<tr>
<td></td>
<td>Beads not resuspended.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Clog in instrument.</td>
<td>Perform Unclog operation and repeat validation procedure. If procedure still fails, contact Technical Support.</td>
</tr>
<tr>
<td><strong>&quot;Bio-Plex Manager has detected a problem with bead aggregation&quot;</strong></td>
<td></td>
<td>View histogram in Run Protocol window and make sure DD peak falls within the gate range. If necessary, adjust gates.</td>
</tr>
<tr>
<td></td>
<td>Incorrect DD gate values used.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Clumped beads present.</td>
<td>Vortex plate at 900 rpm for 11 minutes.</td>
</tr>
<tr>
<td></td>
<td>Sheath reservoir is empty.</td>
<td>Refill sheath reservoir, then perform Start Up.</td>
</tr>
<tr>
<td></td>
<td>Waste reservoir is overfilled.</td>
<td>Empty waste and reconnect.</td>
</tr>
<tr>
<td></td>
<td>Incompatible suspension buffer used.</td>
<td>Check hardware manual for buffer compatibility.</td>
</tr>
<tr>
<td>Message/Problem</td>
<td>Cause</td>
<td>Solution</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>&quot;Check Link&quot; in status bar of software</td>
<td>Array reader or microplate platform is not turned on.</td>
<td>Turn on array reader and microplate platform.</td>
</tr>
<tr>
<td></td>
<td>Software is not communicating with array reader.</td>
<td>Close and restart Bio-Plex Manager.</td>
</tr>
<tr>
<td></td>
<td>Cables between computer and array reader or microplate platform are loose/not connected.</td>
<td>Check cables for proper connections. See System cable connections on page 16.</td>
</tr>
<tr>
<td>&quot;Pressurizing&quot; in software status bar</td>
<td>Leak in sheath bottle or cap.</td>
<td>Tighten sheath cap.</td>
</tr>
<tr>
<td>Platform heater not at target temperature</td>
<td>Insufficient warm-up time allowed.</td>
<td>Allow at least 15 minutes for platform heater to reach target temperature. If heater does not reach target in 30 minutes, contact Technical Support.</td>
</tr>
<tr>
<td>Platform heater not at ambient temperature</td>
<td>Platform heater not functioning properly.</td>
<td>Contact Technical Support.</td>
</tr>
<tr>
<td></td>
<td>Insufficient cool-down time allowed.</td>
<td>Open platform door to facilitate cooling. An ice pack can also be placed on the platform plate holder to facilitate cooling.</td>
</tr>
<tr>
<td>No Assay Signal Detected</td>
<td>More likely:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Sheath reservoir cap not on securely.</td>
<td>Tighten sheath cap. Message should disappear within two minutes.</td>
</tr>
<tr>
<td></td>
<td>Sheath bottle lines are not connected properly.</td>
<td>Make sure that all hoses are connected to the appropriate ports, and that they have clicked into place.</td>
</tr>
<tr>
<td></td>
<td>Less likely:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Sheath fluid level above the AIR port on the sheath container.</td>
<td>Adjust sheath fluid level so that sheath fluid is below the AIR port of sheath bottle.</td>
</tr>
<tr>
<td></td>
<td>Sheath bottle has a leak.</td>
<td>Try new sheath bottle. Call Technical Support for further assistance.</td>
</tr>
<tr>
<td></td>
<td>High-throughput fluidics (HTF) system not turned on.</td>
<td>Turn on HTF and check to ensure that message disappears.</td>
</tr>
<tr>
<td></td>
<td>Air Compressor not working.</td>
<td>List for air pump to turn on when Warm Up is selected. Contact Technical Support for further assistance.</td>
</tr>
<tr>
<td>Bio-Plex Manager has detected a change in array reader temperature. Please calibrate before running an assay to ensure accurate results.</td>
<td>Room temperature has changed.</td>
<td>Calibrate array reader.</td>
</tr>
</tbody>
</table>
### Troubleshooting

<table>
<thead>
<tr>
<th>Message/Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The calibration was unsuccessful. Please repeat calibration. If calibration fails a second time, follow these steps.</td>
<td>Calibration procedure failed.</td>
<td>1. Make sure CAL1 beads and CAL2 beads are placed in the appropriate wells (CAL1 in red well and CAL2 in green well).&lt;br&gt;2. Make sure the calibration target values match the target values printed on the CAL1 and CAL2 bottles.&lt;br&gt;3. Replace or clean the needle.&lt;br&gt;4. Adjust needle height.&lt;br&gt;5. Run Unclog until it passes. (If it doesn’t pass by the 5th attempt, call Technical Support.)&lt;br&gt;6. Be sure to calibrate with freshly vortexed beads and a clean MCV IV plate.&lt;br&gt;7. Repeat calibration and record bead flow (optimum flow should be &gt; 200 beads/second)&lt;br&gt;If problem persists, record any additional error messages (such as temperature problem, pressure fluctuation, warm-up cancellation) before calling tech support.</td>
</tr>
<tr>
<td>Or</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The calibration was unsuccessful. Bio-Plex Manager has detected a problem with low bead number. Please repeat calibration.</td>
<td>Calibration procedure failed due to low bead number.</td>
<td></td>
</tr>
<tr>
<td>Optics Validation Procedure shows value(s) outside of acceptable range(s).</td>
<td>Problem with optical component of array reader.</td>
<td>Repeat validation procedure. If values are still out of range, contact Technical Support.</td>
</tr>
<tr>
<td>Fluidics Validation Procedure shows value(s) outside of acceptable range(s).</td>
<td>Problem with fluidics component of array reader.</td>
<td>Repeat validation procedure. If values are still out of range, contact Technical Support.</td>
</tr>
<tr>
<td>Reporter Validation Procedure shows value(s) outside of acceptable range(s).</td>
<td>Problem with optical component of array reader.</td>
<td>Repeat validation procedure. If values are still out of range, contact Technical Support.</td>
</tr>
<tr>
<td>Classify Validation Procedure shows value(s) outside of acceptable range(s).</td>
<td>Problem with calibration or optical component of array reader.</td>
<td>Repeat validation procedure. If values are still out of range, contact Technical Support.</td>
</tr>
</tbody>
</table>
Appendix

This Appendix contains:
- Security Edition: User Access by Function (below)
- Normalization Formulas (see page 223)
- Basic Concepts of the Bio-Plex suspension array system (see page 227)
- Microsphere Handling (see page 229)
- Software Warranty (see page 232)
- Reporting Problems to Bio-Rad (see page 233)
- Report Table Error Codes (see page 234)

Security Edition: User Access by Function

The following table lists the functions and user levels in Bio-Plex Manager™ 6.1 Security Edition software. An X indicates that the user level has access to the function.

<table>
<thead>
<tr>
<th>Function</th>
<th>Admin</th>
<th>Supervisor</th>
<th>Service</th>
<th>Clinician 2</th>
<th>Clinician 1</th>
<th>Reviewer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Functions that Apply to Whole Application</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Opening Files</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>View All Screens (No Modify)</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>View Audit Trail</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Print</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Save</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Export</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Electronically Sign Document</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Functions that Apply to Instrument Control</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Start Up</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Shut Down</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Warm Up</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remove Bubbles</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Wash Between Plates</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Run Calibration</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enter Calibration Lot/Exp Date</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Run Validation</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Bio-Plex Manager Software 6.1 User Guide | Appendix

<table>
<thead>
<tr>
<th>Function</th>
<th>Admin</th>
<th>Supervisor</th>
<th>Service</th>
<th>Clinician 2</th>
<th>Clinician 1</th>
<th>Reviewer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter Validation Lot/Exp Date</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Instrument - Set Up</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Instrument - Reconnect</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Instrument Info</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>View Operation Log</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>View Calibration Log</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>View Validation Log</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Functions that Apply to Protocol File—General</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>New Protocol File</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>New Results from Protocol</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Functions that Apply to Protocol File, Describe Protocol View</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Author Field</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Description Field</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Functions that Apply to Protocol File, Select Analytes View</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Select/Remove Analytes</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add/Delete/Rename/Edit Panel</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Functions that Apply to Protocol File, Formal Plate View</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Format Wells</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change Number of Unknown Samples</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Functions that Apply to Protocol File, Enter Standards Info View</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enter Standards Info (Description &amp; Concentration)</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enter Std Curve Regression Method</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enter Std Curve Adv Settings</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enter Std Concentration Units</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enter Recovery Range</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Select External Standards</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Functions that Apply to Protocol File, Enter Sample Info View</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enter Sample Info (Sample Description)</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enter Sample Info (Sample Dilution)</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Functions that Apply to Protocol File, Enter Controls Info View</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enter Controls Info</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Functions that Apply to Protocol File, Run Protocol View</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Start a Run</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>
Security Edition: User Access by Function

<table>
<thead>
<tr>
<th>Function</th>
<th>Admin</th>
<th>Supervisor</th>
<th>Service</th>
<th>Clinician 2</th>
<th>Clinician 1</th>
<th>Reviewer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rerun/Recovery Mode</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Select Beads to Count</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Select Bead Count Method (Per Well/Per Analyte)</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set Sample Timeout</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Advanced Settings</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change Raw Data Display Options</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Print Histogram &amp; Bead Map</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Histogram—Restore Default Gates</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Histogram—Adjust DD Gates</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Histogram—Autoscale</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Histogram—Log/Linear View</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Histogram—Zoom</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Histogram—Max/Restore</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Bead Map—Log/Lin</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Bead Map—Zoom</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Bead Map—Max/Restore</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>

Functions that Apply to Results File—General

<table>
<thead>
<tr>
<th>Function</th>
<th>Admin</th>
<th>Supervisor</th>
<th>Service</th>
<th>Clinician 2</th>
<th>Clinician 1</th>
<th>Reviewer</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Protocol from Results</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change DD Gates</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Refresh Calculations</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Modify Plate ID</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Functions that Apply to Results File, Describe Protocol View

<table>
<thead>
<tr>
<th>Function</th>
<th>Admin</th>
<th>Supervisor</th>
<th>Service</th>
<th>Clinician 2</th>
<th>Clinician 1</th>
<th>Reviewer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Author Field</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Description Field</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Functions that Apply to Results File, Select Analytes View

<table>
<thead>
<tr>
<th>Function</th>
<th>Admin</th>
<th>Supervisor</th>
<th>Service</th>
<th>Clinician 2</th>
<th>Clinician 1</th>
<th>Reviewer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select/Remove Analytes</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add/Delete/Rename/Edit Panel</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Functions that Apply to Results File, Format Plate View

<table>
<thead>
<tr>
<th>Function</th>
<th>Admin</th>
<th>Supervisor</th>
<th>Service</th>
<th>Clinician 2</th>
<th>Clinician 1</th>
<th>Reviewer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Formatting Wells</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Functions that Apply to Results File, Enter Standards Info View

<table>
<thead>
<tr>
<th>Function</th>
<th>Admin</th>
<th>Supervisor</th>
<th>Service</th>
<th>Clinician 2</th>
<th>Clinician 1</th>
<th>Reviewer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter Standards Info (Description &amp; Concentration)</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enter Std Curve Reg Method</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enter Std Curve Advanced Settings</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Function Details

<table>
<thead>
<tr>
<th>Function</th>
<th>Admin</th>
<th>Supervisor</th>
<th>Service</th>
<th>Clinician 2</th>
<th>Clinician 1</th>
<th>Reviewer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter Standard Concentration Units</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enter Recovery Range</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Select External Standards</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Functions that Apply to Results File, Enter Sample Info View</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enter Sample Info (Desc)</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enter Sample Info (Dilution)</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Functions that Apply to Results File, Enter Controls Info View</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enter Controls Info (Desc, Conc, &amp; Dilution)</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Functions that Apply to Results File, Raw Data View</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change Display Options</td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Set/Clear Outliers</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Functions that Apply to Results File, Report Data View</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set/Clear Outliers</td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Show/Hide Outliers</td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Report Table Options</td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Organize by Type</td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Organize by Group</td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show Replicates</td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sort</td>
<td></td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Show Help for Table Legend</td>
<td></td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Select Analytes to View</td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Functions that Apply to Results File, Standard Curve View</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Regression Type</td>
<td></td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Same Reg Type—All Analytes</td>
<td></td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Logistic Weighting Options</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Labels</td>
<td></td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Error Bars</td>
<td></td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Analyte</td>
<td></td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Axis Transformation</td>
<td></td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Swap XY Axes</td>
<td></td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Turning On and Off Secure Mode</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Turn On/Off Secure Mode</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unlock Application Override</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**NOTE:** System Administrator creates Groups and assigns Users to Groups.
Normalization Formulas

Bio-Plex Manager uses the following formulas to calculate normalization values.

- All calculations are done first on a per well basis
- All fluorescence values are adjusted mean fluorescence (Fl – Background), unless no blanks are provided in the experiment
- All calculations are done on a per gene level, except where indicated
- The following equations are written for gene expression studies. You can substitute “gene” with “analyte” and use the same calculations for normalizing protein concentrations with internal/endogenous controls

For these calculations:

Gene of Interest = Analyte of Interest
Housekeeping Gene = Endogenous Control Protein

Variables below are HKG = Housekeeping Gene
Fl = Fluorescence Intensity
n = number of housekeeping genes
Average Fl(sample) = Flwell1, Flwell2 . . . Flwelln

Norm Ratio is the software’s term for normalized expression values. It is calculated three different ways, depending on the options chosen in the Normalization Settings dialog. These are outlined below as Norm Ratio, Norm Ratio’ and Norm Ratio”.

A control sample may be assigned in order to:
- Compare results across multiple plates (control sample must be the same biological sample on each plate)
- Simply express all results on the same plate, relative to the controls sample
**Norm Ratio**

The calculation is a simple division of each sample’s calculated value by the control sample’s calculated value.

When internal controls are not chosen:

\[
\text{Norm Ratio}_{(\text{sample})} = \frac{\text{Average FL}_{(\text{sample})}}{\text{Average FL}_{(\text{control sample})}}
\]

When internal controls are chosen:

\[
\text{Norm Ratio''}_{(\text{sample x})} = \frac{\text{Norm Ratio'}_{(\text{sample x})}}{\text{Norm Ratio'}_{(\text{control sample})}}
\]

**Norm Ratio’**

When internal controls are chosen and no control samples are identified:

\[
\text{Norm Ratio'}_{(\text{well})} = \frac{\text{FL}_{\text{control sample}}}{\text{FL}_{\text{sample x}} \times \text{FL}_{\text{internal control}}}
\]

To figure Norm Ratio’ per sample, use the average normalized value of each sample.

\[
\text{Norm Ratio'}_{(\text{sample})} = \frac{\text{Norm Ratio'}_{(\text{well})} + \text{Norm Ratio'}_{(\text{sample x})} + \ldots + \text{Norm Ratio'}_{(\text{sample n})}}{n}
\]

**Norm Ratio”**

Calculating Norm Ratio” allows the researcher to express all data relative to the control, so that data across experiments using the same control samples can be compared.

When control sample and housekeeping genes (internal controls) are chosen:

\[
\text{Norm Ratio”}_{(\text{sample x})} = \frac{\text{Norm Ratio’}_{(\text{sample x})}}{\text{Norm Ratio’}_{(\text{control sample})}}
\]
Normalized Fluorescence Values (Norm FI)

(This calculation requires internal controls to be chosen.)

Normalized Fluorescence Values (Norm FI) are fluorescence values adjusted to account for experimental sample to sample variations (loading differences). Norm FI can be used to compare results across experiments to get a clearer picture of experimental variability. It is left to the researcher to decide the appropriateness of this calculation for a particular experiment.

Norm FI is calculated as follows when housekeeping genes (internal controls) are chosen.

\[
\text{Norm FI (well)} = \text{FI Gene of Interest} \times \frac{\text{Avg All HKG FI (ALL wells)}}{\text{FI Well 1} \times \text{FI Well 2} \times \cdots \times \text{FI Well n}}
\]

where Avg All HKG FI (ALL wells) = the average FI for all housekeeping genes in every well of the experiment.

This number serves as a mean factor around which all others will fall and converts a “unitless” ratio back into FI.

The next calculation averages per well data to arrive at the per sample normalized fluorescence value (Norm FI (sample)).

\[
\text{Norm FI (sample)} = \frac{\text{Norm FI (well 1)} + \text{Norm FI (well 2)} + \cdots + \text{Norm FI (well n)}}{n}
\]

When control is chosen, Norm FI is calculated as follows.

\[
\text{Norm FI (sample x)} = \text{Norm ratio (sample x)} \times \text{Average FI (control sample)}
\]

Average FI (control sample) serves as a mean factor around which all others will fall and converts a “unitless” ratio back into FI.
Ratio (Simple) and the Grouping Function

If you are not using the grouping function present in the plate formatting section of the software, this does not apply to you.

When using this function, remember that the Ratio value presented is only relevant for making comparisons within a group. Outside the group, these numbers are arbitrary and meaningless (unless the reference sample is another instance of the exact same biological sample in every group).

Since data outside of groups cannot be compared, the grouping function in the plate formatting section of the software defeats any inter- and many intra-experiment normalization. Relative differences among samples within the same group are still valid.

If you are normalizing your data, ratio calculation is a simple ratio of the calculated value of a reference sample of the group, compared to the calculated value of each member of that group. Data can be presented as member over reference, or as reference over member.

\[
\text{Ratio} = \frac{\text{Norm Ratio}_{\text{sample}}}{\text{Norm Ratio}_{\text{reference}}} \quad \text{or} \quad \frac{\text{Norm Ratio}_{\text{reference}}}{\text{Norm Ratio}_{\text{sample}}}
\]

If you are not normalizing your data, the ratio is calculated using FI values.

\[
\text{Ratio} = \frac{\text{FI}_{\text{sample}}}{\text{FI}_{\text{reference}}} \quad \text{or} \quad \frac{\text{FI}_{\text{reference}}}{\text{FI}_{\text{sample}}}
\]
Basic Concepts

The following is a brief overview of the basic principles of the Bio-Plex suspension array system. For more information, see "Practical Flow Cytometry", 3rd edition, by Howard M. Shapiro, M.D. (New York: Wiley-Liss Inc., 1995).

Microspheres

xMAP microspheres are highly uniform, 5.5-micron polystyrene beads that have been crosslinked during polymerization for physical and thermal stability. Microspheres are grouped into sets; each set is then embedded with specific quantities of two fluorescent dyes. The ratio of these two dyes gives each set of microspheres a unique spectral address.

Each set of microspheres is then conjugated with a different reactant specific for a particular target analyte. Reactants can include enzyme substrates, receptors, antigens, and antibodies. A conjugated bead-reactant mixture can be mixed with a sample to create, for example, a capture sandwich immunoassay.

NOTE: To ensure the stability of the spectral address, it is essential to protect the microspheres from light. Do not subject microspheres to prolonged high temperatures, and protect them from freezing and thawing.

Reporter Fluorochromes

When you mix your samples with the microspheres, the target analytes bind to the reactants on the surface of the beads. The amount of analyte that binds to the beads is then quantitated through the use of a fluorochrome, R-phycoerythrin. The intensity of this fluorochrome as detected by the array reader is directly proportional to the amount of analyte present. The excitation wavelength of the array reader reporter channel is 532 nm; the emission wavelength is 575 + 12 nm. Specific information on R-phycoerythrin is shown in the following table.

<table>
<thead>
<tr>
<th>R-Phycoerythrin Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Formula weight (Daltons)</td>
</tr>
<tr>
<td>Absorbance max (nm)</td>
</tr>
<tr>
<td>Extinction max (M-1cm-1)</td>
</tr>
<tr>
<td>Emission max (nm)</td>
</tr>
<tr>
<td>Quantum yield</td>
</tr>
</tbody>
</table>
**Fluidics**

There are two fluidic paths in the array reader. The first path includes a syringe-driven mechanism that controls the sample uptake. This mechanism permits small sample uptake volumes from small reaction volumes. The syringe-driven system transports a user-specified volume of sample from a microplate well to the cuvette. The sample is injected into the cuvette at a steady rate, and the microspheres in the sample are aligned in a single file through the path of the two lasers.

Following analysis, the first sample path is automatically purged with sheath buffer fluid via the second fluidics path. This process effectively removes residual sample in the tubing, valves, and sample needle.

**Excitation**

There are two lasers in the array reader: one for classifying each microsphere and its associated analyte, and the other for quantitating the amount of analyte bound to each microsphere. The first laser, the classification or "red" laser, excites the dyes embedded in each microsphere; the fluorescent signal is discriminated with selective emission filters and converted into intensity units by fluorescence detectors and a digital signal processor, and the microsphere is classified. The second laser, the reporter or "green" laser, excites the fluorochromes bound to the target analytes on the surface of the microspheres; again, the fluorescent signal is discriminated with selective emission filters and converted into intensity units by fluorescence detectors and a digital signal processor, and the amount of analyte is quantitated.
Microsphere Handling

Microsphere Dispersion

xMAP microspheres will settle and aggregate if left undisturbed. You should always ensure that they are evenly distributed before dispensing. Gentle vortexing is the most effective method of mixing for most coated microsphere preparations; however, sonication can also be used to separate aggregated microspheres prior to coupling. After sonication, microspheres generally remain dispersed for about 1 hour. Sonication is most effective if applied to a centrifuged pellet of microspheres. In order to maintain bead concentration, we suggest you centrifuge your stock beads before sonication.

The following two indirect sonication methods are effective at separating aggregates in closed containers of microsphere preparations. Inserting a sonicator probe into preparations is not recommended.

 Probe Sonicator

To disperse a microsphere pellet using a probe sonicator:

1. Place probe tip in a small bath of water.

2. Insert the end of the microsphere tube near the tip of the sonicator probe, without touching it. Do not immerse the tube closure.

3. Adjust sonication for optimal disruption and pulse sonicate until the microsphere pellet is dispersed.

 Bath Sonicator

To disperse a microsphere pellet using a bath sonicator:

1. Turn on the bath sonicator and examine the surface for an area of maximum disruption.

2. Insert the end of the tube into the sonicator bath near the area of maximum disruption.

3. Sonicate until the microsphere pellet is dispersed.
Enumeration of Microsphere Suspensions

xMAP microspheres are provided at standard concentrations. The microsphere yield after a coupling process may be less than the starting concentration due to loss during wash steps. The microsphere loss can vary according to operator technique, coupled reactant properties, and scale of coupling.

It is not advisable to construct an assay without defining the concentration of the subject-coupled microsphere preparation. The total surface area (total number of microspheres) represented in an assay is a critical variable, so the optimization and control of this variable begins with manipulation of known microsphere numbers. Microspheres can be counted with a hemocytometer. Please follow counting and calculation methods outlined in the instructions for your hemocytometer.

Microsphere Separation Methods

Bio-Plex assay development often requires separation of microspheres from an aqueous matrix. This can be done using either centrifugation or vacuum methods.

CENTRIFUGATION

Microsphere coupling protocols require separation of microspheres from reaction mixtures or wash buffers by means of centrifugation. Generally, a tabletop microcentrifuge that can spin 1.5 ml microcentrifuge tubes can pellet microspheres in 1-2 minutes. The g-forces vary in these instruments from approximately 6,000 to 13,000 X g.

VACUUM

A vacuum separation method can be used for routine high-throughput washing required for washed assay procedures. In this case, the microsphere reactions are performed in microtiter filter-bottom 96-well plates. A vacuum is applied to the plate, allowing the liquid to filter through while retaining the microspheres on the filter. Resuspension is accomplished by adding adequate fluid to each well and by repetitive vigorous pipetting.
Microsphere Handling

Microsphere Agitation During Assay

Agitation of Bio-Plex assays with a plate shaker during incubation steps prevents microspheres from settling during extended incubation periods. The benefit of agitation may not be discernible for some assay conditions and should be evaluated according to the requirements of a given application. It is important to resuspend the beads in an assay for 30 seconds before performing a reading.

Microsphere Stability and Storage

xMAP microspheres are light sensitive and should be protected from light during all stages of storage and usage. In addition, freezing conditions and organic solvents should be avoided.
Software Warranty

Bio-Rad Laboratories warrants that Bio-Plex Manager™ software shall substantially conform, in all operational features, to Bio-Rad’s current specifications as published in Bio-Rad’s user and installation guides and that, when properly installed, it will be free of material defects which affect system performance.

The Purchaser must notify Bio-Rad in writing, within 30 days of delivery of the software (not including delivery of any subsequent modifications to the software), of any defect. If the software is found to be defective by Bio-Rad, Bio-Rad’s sole obligation under this warranty is to remedy the defect in a manner consistent with Bio-Rad’s regular business practices. For a defect which adversely affects the performance of the software, Bio-Rad shall use its best efforts to cure such defect as soon as reasonably practicable after receipt of Purchaser’s notice. For minor defects, Bio-Rad shall use its best efforts to correct such minor defects in the next release of its software. If, however, Bio-Rad is unable to cure a major defect within 90 days of receipt of Purchaser’s notice, Purchaser shall have the option to cancel this agreement, whereupon Bio-Rad shall refund only the software fees paid.

The warranties set forth in this agreement are in lieu of all other representations and warranties, expressed or implied, including warranties of merchantability and fitness for a particular purpose and any other statutory or common-law warranty. Bio-Rad on its own behalf expressly disclaims and excludes any and all such other representations and warranties. Liability of Bio-Rad to Purchaser, if any, for breach of warranty, or any other claim relating to this agreement, shall be limited to the total amount of software fees paid by Purchaser to Bio-Rad. In no event shall Bio-Rad be liable for incidental or consequential damages, loss of business or profits, special or indirect damages of any nature whatsoever. No amendment, waiver, or other alteration of the warranties in this agreement may be made except by mutual agreement in writing.

Purchaser agrees that Bio-Rad’s liability arising out of contract, negligence, strict liability in tort or warranty shall not exceed the amount of software license fees paid by Purchaser.

This manual and the software (computer program) described in it are copyright Bio-Rad Laboratories, Inc. with all rights reserved worldwide. Under the copyright laws, this manual and the software program contained herein may not be copied, in whole or in part, without the prior written consent of Bio-Rad, except in the normal use of the software or to make a backup copy. This exception does not allow copies to be made for others, whether or not sold, but all of the materials purchased (with all backup copies) may be sold, given or loaned to another person. Under the law, copying includes translating into another language or format.

A multiuse license may be purchased to allow the software to be used on more than one computer owned by the Purchaser, including a shared disk system.
Reporting Problems to Bio-Rad

Included in your Bio-Plex Manager installation is a program called Solobug. You can use this program to request features and design changes, or report noncritical problems.

NOTE: For critical problems, contact Bio-Rad Technical Support at the numbers listed on the inside front cover of this manual.

To use Solobug, select Solobug from the Start menu, enter your information and a description of the request in the Solobug window, and click Save. This will create a report that you can attach to an email and send to Bio-Rad.

Please send your Solobug files to Bio-Rad at:
LSG.TechServ.US@Bio-Rad.com (in the U.S.)
LSG.TechServ.Intl@Bio-Rad.com (International)
Report Table Error Codes

Certain data that cannot be measured or calculated will be flagged in the Report Table.

Columns and their possible error codes are listed below.

<table>
<thead>
<tr>
<th>Column</th>
<th>Error Code</th>
<th>Cause</th>
</tr>
</thead>
<tbody>
<tr>
<td>FI</td>
<td>***</td>
<td>No data present</td>
</tr>
<tr>
<td></td>
<td>---</td>
<td>Marked as an outlier</td>
</tr>
<tr>
<td>FI - Background</td>
<td>***</td>
<td>No data present (negative values, if any will be displayed)</td>
</tr>
<tr>
<td></td>
<td>---</td>
<td>Marked as an outlier</td>
</tr>
<tr>
<td>SD</td>
<td>***</td>
<td>No data present</td>
</tr>
<tr>
<td>CV%</td>
<td>***</td>
<td>No data present</td>
</tr>
<tr>
<td>Obs Conc (4PL/5PL)</td>
<td>***</td>
<td>No data present</td>
</tr>
<tr>
<td></td>
<td>OOR&gt;</td>
<td>Out of Range - Above asymptote of equation</td>
</tr>
<tr>
<td></td>
<td>OOR&lt;</td>
<td>Out of Range - Below asymptote of equation</td>
</tr>
<tr>
<td></td>
<td>OOR</td>
<td>Out of Range - Math Error</td>
</tr>
<tr>
<td></td>
<td>*Value</td>
<td>Above or below standards FI</td>
</tr>
<tr>
<td>Obs Conc (Linear)</td>
<td>***</td>
<td>No data present</td>
</tr>
<tr>
<td></td>
<td>OOR</td>
<td>Negative extrapolated data</td>
</tr>
<tr>
<td></td>
<td>*Value</td>
<td>Positive extrapolated data or Data above/below the standards FI</td>
</tr>
<tr>
<td>Exp Conc</td>
<td>***</td>
<td>No data entry - this value is input by user</td>
</tr>
<tr>
<td>OBS/Exp * 100</td>
<td>***</td>
<td>OOR displayed in Obs Conc column</td>
</tr>
<tr>
<td>Conc in Range</td>
<td>OOR&lt; or OOR&gt;</td>
<td>Obs Conc is not within the specified recovery range of standards conc (the recovery range is specified by the user)</td>
</tr>
<tr>
<td>Sampling Error</td>
<td>1</td>
<td>Low bead number detected in the well</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>Aggregated beads detected in the well</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>Classify efficiency problem detected in the well</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>Region selection problem detected in the well</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>Platform temperature problem detected in the well</td>
</tr>
</tbody>
</table>
## Glossary

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accuracy</td>
<td>The closeness of a measured value to the actual value or the difference</td>
</tr>
<tr>
<td></td>
<td>between expected and measured values. Using the Reporter Validation Kit,</td>
</tr>
<tr>
<td></td>
<td>accuracy is defined as the percent difference between the measured</td>
</tr>
<tr>
<td></td>
<td>regression curve and the expected or actual data points.</td>
</tr>
<tr>
<td>Aggregated microspheres</td>
<td>Microspheres that have associated. Two microspheres that have</td>
</tr>
<tr>
<td></td>
<td>associated are called a doublet.</td>
</tr>
<tr>
<td>Analyte</td>
<td>The substance being measured, identified, quantitated, or otherwise</td>
</tr>
<tr>
<td></td>
<td>analyzed in an experiment. In the Bio-Plex system, analytes are</td>
</tr>
<tr>
<td></td>
<td>molecules that are being quantitated.</td>
</tr>
<tr>
<td>Antibody</td>
<td>Immunological protein capable of binding a unique antigen via a specific</td>
</tr>
<tr>
<td></td>
<td>binding site or epitope. Used in immunological assays to quantitate the</td>
</tr>
<tr>
<td></td>
<td>amount of a specific analyte present.</td>
</tr>
<tr>
<td>Assay</td>
<td>The bead and reagent mixture that, when combined with sample, is</td>
</tr>
<tr>
<td></td>
<td>loaded into microplate wells and read by the array reader.</td>
</tr>
<tr>
<td>Background (noise)</td>
<td>Fluorescent intensity measured by the reporter channel that is due to</td>
</tr>
<tr>
<td></td>
<td>non-specific binding of a fluorochrome and the electronic noise of the</td>
</tr>
<tr>
<td></td>
<td>array reader. If you include blank wells in your microplates, you can</td>
</tr>
<tr>
<td></td>
<td>calculate the average background intensity and subtract it from the</td>
</tr>
<tr>
<td></td>
<td>intensity readings of your standards and unknowns.</td>
</tr>
<tr>
<td>Bead</td>
<td>A microsphere.</td>
</tr>
<tr>
<td>Calibration</td>
<td>A process that uses microspheres (calibrators) with a stable fluorescent</td>
</tr>
<tr>
<td></td>
<td>intensity to adjust the gain settings in the array reader’s detectors for</td>
</tr>
<tr>
<td></td>
<td>optimal and consistent microsphere classifications and reporter readings,</td>
</tr>
<tr>
<td></td>
<td>over time and across different array readers.</td>
</tr>
<tr>
<td>Calibrators</td>
<td>Microspheres with stable fluorescent intensities used to standardize the</td>
</tr>
<tr>
<td></td>
<td>signal output of the array reader.</td>
</tr>
<tr>
<td>Capture antibody</td>
<td>An antibody used in sandwich immunoassays that binds or “captures” a</td>
</tr>
<tr>
<td></td>
<td>specific analyte for quantitation.</td>
</tr>
<tr>
<td>Carboxylated microspheres</td>
<td>Microspheres with chemically modified surfaces covered with carboxyl</td>
</tr>
<tr>
<td></td>
<td>functional groups (COOH) that allow covalent biomolecular attachment.</td>
</tr>
<tr>
<td>Classification channels</td>
<td>Fluorescent detection channels of the array reader that detect the</td>
</tr>
<tr>
<td></td>
<td>fluorescent intensities of two dyes embedded in each microsphere. If the</td>
</tr>
<tr>
<td></td>
<td>signals from the two dyes place the bead within a specified classification</td>
</tr>
<tr>
<td></td>
<td>region, the bead is identified as a unique analyte in a sample.</td>
</tr>
<tr>
<td>Classification regions</td>
<td>Defined regions in a dot plot bead map that are used to identify beads in</td>
</tr>
<tr>
<td></td>
<td>an assay based on the fluorescent signals from their embedded dyes.</td>
</tr>
<tr>
<td>Classify validation</td>
<td>A validation procedure for measuring the ability of the array reader to</td>
</tr>
<tr>
<td></td>
<td>efficiently classify assay beads into specified regions.</td>
</tr>
<tr>
<td>Clumping</td>
<td>The aggregation of two or more microspheres.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>-----------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Concentration in range</td>
<td>A measure of unknown, standard, and control concentrations that are reliable, based on the recovery range of valid standards. Values outside the range are flagged as &gt;OOR or &lt;OOR.</td>
</tr>
<tr>
<td>Conjugated microsphere</td>
<td>A microsphere set that has been chemically modified so that its surfaces are covered with molecules that bind with the target analytes in an assay system.</td>
</tr>
<tr>
<td>Cytokine</td>
<td>An immunological protein that can signal a response in the immune system.</td>
</tr>
<tr>
<td>Detection antibody</td>
<td>An antibody used in capture sandwich immunoassays that binds a captured analyte to a fluorochrome, allowing for quantitation of the protein. Detection antibodies may be biotinylated, which allows for addition of a streptavidin-bound fluorochrome, or the detection antibody may be directly labeled with a fluorochrome.</td>
</tr>
<tr>
<td>Doublet</td>
<td>Two microspheres that have associated. The resulting signal of the associated microspheres is twice that of a single microsphere (singlet).</td>
</tr>
<tr>
<td>Doublet discriminator</td>
<td>A channel that measures the amount of light scatter from particles that flow past the red laser. Light scatter is directly proportional to particle size, and the channel is designed to identify particles that are smaller or larger than a single microsphere, including microspheres that are clumped or aggregated.</td>
</tr>
<tr>
<td>Dynamic range</td>
<td>The calculated number of decades covered by the reporter channel scale of the array reader. Range is calculated using the Reporter Validation Kit.</td>
</tr>
<tr>
<td>Emission spectrum</td>
<td>The wavelength range of light emitted by an excited fluorochrome when its electrons fall from a higher to a lower energy state. Expressed in nanometers (nm).</td>
</tr>
<tr>
<td>Ex/Em</td>
<td>A common way of reporting a molecule’s excitation and emission wavelengths (for example, Ex/Em = 488/520 nm).</td>
</tr>
<tr>
<td>Excitation spectrum</td>
<td>The wavelength range that excites a molecule’s electrons to a higher energy state. Expressed in nanometers (nm).</td>
</tr>
<tr>
<td>External standard</td>
<td>A standard that has been imported from a different file.</td>
</tr>
<tr>
<td>Fit probability</td>
<td>A statistical measure of goodness of fit that incorporates the residual SSE (sum of the square of the error). A fit probability of 1 indicates a perfect fit, while a fit probability of 0 indicates no fit.</td>
</tr>
<tr>
<td>Fluidics validation</td>
<td>The process of verifying the well-to-well carryover of beads in the array reader.</td>
</tr>
<tr>
<td>Fluorescence</td>
<td>The emission of light that occurs when the electrons of a fluorochrome drop to a lower energy state.</td>
</tr>
<tr>
<td>Fluorochrome</td>
<td>A fluorescent molecule.</td>
</tr>
<tr>
<td>Gate</td>
<td>An electronic method of discriminating or eliminating aggregated microspheres in the analysis of an assay. A gate separates singlet beads from aggregated beads.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Group</td>
<td>A group of wells defined on a plate. You can calculate the ratio of the fluorescent intensities of the group’s member wells to the fluorescent intensity of a Reference well in the group.</td>
</tr>
<tr>
<td>Immunofluorescence</td>
<td>A technique that uses a covalently linked fluorochrome-antibody complex to detect or quantify a particular antigen.</td>
</tr>
<tr>
<td>Instrument threshold</td>
<td>The instrument threshold is a measure of system noise, and is the reporter channel signal from a blank bead that contains no reporter dye.</td>
</tr>
<tr>
<td>Kinase</td>
<td>An enzyme that functions to phosphorylate specific proteins. Kinases are responsible for the activation of a variety of proteins through the process of phosphorylation.</td>
</tr>
</tbody>
</table>
| Laser                       | A highly purified source of light used to excite fluorochrome electrons.  
<pre><code>                            | An acronym for Light Amplification by Stimulated Emission of Radiation.                                                                  |
</code></pre>
<p>| Linearity                   | A measurement of the coefficient of determination, or $R^2$ value, of a set of standard beads. An $R^2$ value of 0.995 or greater is an acceptable linearity value using the Bio-Plex Validation Kit. |
| Logistic regression         | A regression model for binary (dichotomous) outcomes. The data are assumed to follow binomial distributions with probabilities that depend on the independent variables. |
| Lower limits of Quantitation| For any given assay, this is the lowest value Bio-Plex Manager will report in the Concentration in Range column of the data table. Values below this range are considered less trustworthy based on either the poor recovery values of standards below this range or background of the assay. For more details, review the definition of Concentration in Range. |
| Median fluorescent intensity| A relative measurement of fluorescent intensity based on the median, a robust statistical measure.                                      |
| Microparticle               | A solid substance with a diameter in the micrometer range. Often used as a synonym for a microsphere.                                     |
| Microsphere set             | A set of multianalyte microspheres containing a unique mixture of two distinct fluorochromes to distinguish them from other multianalyte microspheres. |
| Microspheres                | Latex spheres with a diameter in the micrometer range. Also called beads.                                                              |
| Multianalyte or multiplex   | An analysis of several assays or tests performed simultaneously in the same reaction container.                                           |
| Operational qualification   | The process of determining that an instrument is fit for its intended use. The Bio-Plex Validation Kit is a tool for operational qualification. |
| Optics validation           | The process for verifying the alignment of the optics assembly of the array reader.                                                      |
| Outlier                     | A well or replicate group of wells whose measured value is outside the normal range. You can exclude outliers from statistical calculations. |
| Panel                       | A group of related bead sets. For example, the Human Cytokine panel includes bead sets for Human IL-2, Human IL-4, Human IFN gamma, and other human cytokines. You can select multiple bead sets from the same panel or sets from different panels in the same multiplex assay. |</p>
<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>PE</td>
<td>See phycoerythrin.</td>
</tr>
<tr>
<td>Phosphoprotein</td>
<td>An enzyme that functions to phosphorylate specific proteins. Phosphoproteins are responsible for the activation of a variety of proteins through the process of phosphorylation.</td>
</tr>
<tr>
<td>Photobleaching</td>
<td>A chemical reaction caused by exposure to light, in which a fluorochrome is converted into a differently fluorescent or non-fluorescent compound.</td>
</tr>
<tr>
<td>Photomultiplier tube</td>
<td>A light detector typically used in fluorescence detection systems, designed to convert a fluorescent signal into an electronic signal that can be quantitated. PMT settings display as an RP1 number during calibration, when using Bio-Plex Manager.</td>
</tr>
<tr>
<td>Phycoerythrin (PE)</td>
<td>The fluorochrome used as the reporter molecule in Bio-Plex assays. Excitation = 546 nm, emission = 575 nm.</td>
</tr>
<tr>
<td>PMT</td>
<td>See photomultiplier tube</td>
</tr>
<tr>
<td>Precision</td>
<td>A measure of the reproducibility of replicate readings, usually represented by the coefficient of variation (%CV).</td>
</tr>
<tr>
<td>Protocol file (*.pbx or *.spb)</td>
<td>A file containing the settings of a reading, including the microplate wells to read, the analytes to detect, sample size, etc. To perform a reading, you open a Protocol file, select the settings, and then run the Protocol. You can then save the Protocol settings and reuse or modify them. After a reading, a Results file is created containing the settings from the Protocol as well as the data results. The raw data from the most recent reading are also stored in the Protocol file. In Bio-Plex Manager Security Edition, Protocol files may be Secure files, in which case they have the file extension *.spb.</td>
</tr>
<tr>
<td>Quality control</td>
<td>Procedures and guidelines that determine conformity to requirements.</td>
</tr>
<tr>
<td>Recovery percentage</td>
<td>A mechanism for assessing the fit of the standard curve to the actual standards. For each analyte standard, an observed concentration is back-calculated from the standard curve and the fluorescent intensity. This is divided by the expected concentration and multiplied by 100 to give the recovery percentage.</td>
</tr>
<tr>
<td>Recovery range</td>
<td>The range of acceptable recovery percentages (see above). For example, a recovery range of 80–120% means that the observed concentration of a standard should be within 80–120% of the expected concentration. Concentrations of standards and unknowns that fall outside this range are flagged as unreliable.</td>
</tr>
<tr>
<td>Reference</td>
<td>A well within a group of wells defined on a plate that is used as a reference. You can calculate the ratio of the fluorescent intensity of the Reference well to the fluorescent intensities of the other wells in the group.</td>
</tr>
<tr>
<td>Region</td>
<td>The region of a fluorescent color map used to identify a particular bead set. Each bead set is embedded with specific quantities of two fluorescent dyes; the combination of these fluorochromes, as detected by the array reader, places the bead set within a unique region on the color map, thereby identifying the set and its associated analyte.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Reporter</td>
<td>A fluorescent molecule that is incorporated into an assay in such a way that the fluorescence intensity is directly proportional to the amount of analyte in an assay.</td>
</tr>
<tr>
<td>Reporter channel</td>
<td>The channel of the array reader that detects the fluorescent signal of the reporter molecule (phycoerythrin).</td>
</tr>
<tr>
<td>Reporter system</td>
<td>Any combination of molecules in solution that serves to quantitate the analytes in a particular assay.</td>
</tr>
<tr>
<td>Reporter validation</td>
<td>A standard method for verifying the performance of the reporter channel of the array reader. The five primary parameters that verify accurate performance of the reporter channel include linearity, dynamic range, sensitivity, accuracy, and slope of the response.</td>
</tr>
<tr>
<td>Residual variance</td>
<td>A statistical measure of a good fit. This is the weighted sum of the squared errors between the observed response and the response predicted by the fitted curve (residual SSE), divided by the number of degrees of freedom. A small residual variance indicates a good curve fit.</td>
</tr>
<tr>
<td>Results file (*.rbx or *.srbx)</td>
<td>A file containing the results of a reading, including the raw data, the settings information from the Protocol, and tools for analyzing and exporting the data (tables, a standard curve, export functions, etc.). Each reading generates a new Results file. In Bio-Plex Manager Security Edition, Results files may be Secure files, in which case they have the file extension *.srbx.</td>
</tr>
<tr>
<td>Sample</td>
<td>A solution of analyte standards or unknowns that, when added to an assay, will bind to the microspheres in that assay and be identified and quantitated by the array reader.</td>
</tr>
<tr>
<td>Sampling error</td>
<td>A measure of the degree to which a sample differs from the entire population.</td>
</tr>
<tr>
<td>Sandwich immunoassay</td>
<td>Immunoassay for the quantitation of a specific analyte through the use of monoclonal antibodies (Ab). A sandwich is formed when an analyte of interest binds to a capture Ab, and then a second antibody (detection Ab) binds to a different epitope of the protein.</td>
</tr>
<tr>
<td>Secure file</td>
<td>A Protocol or Results file that has been electronically &quot;signed&quot; by a user. Once signed, this file is a controlled document that cannot be overwritten by Bio-Plex Manager and that preserves a built-in audit trail of all saved changes. If you make changes to a Secure file and save it as a new file, the new file will not be signed; however, the audit trail will be preserved in the new file and the file will remain a Secure file.</td>
</tr>
<tr>
<td>Sensitivity</td>
<td>The lowest detectable signal above instrument noise. Noise may be attributed to the lasers, the detectors and the amplification electronics of the array reader.</td>
</tr>
<tr>
<td>Signal</td>
<td>The detectable measurement unit of a reporter molecule.</td>
</tr>
<tr>
<td>Signal-to-noise ratio</td>
<td>The ratio of a specific assay signal to the underlying noise in the assay. Signal to noise is typically used to measure the sensitivity of an assay.</td>
</tr>
<tr>
<td>Singlet(s)</td>
<td>A single microsphere or a population of single microspheres. Compare to doublets which are two microspheres associated together.</td>
</tr>
</tbody>
</table>
### Glossary

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Slope</strong></td>
<td>Defined as the rise over the run when plotting a series of points to form a line. Using the Reporter Validation Kit, the slope of the response is related to the dynamic range of the array reader and yields information about the response of the photomultiplier tube (PMT).</td>
</tr>
<tr>
<td><strong>Spectral address</strong></td>
<td>The unique fluorescent emission spectra of a microsphere.</td>
</tr>
<tr>
<td><strong>Standard deviation</strong></td>
<td>The spread in individual data points (for example, in a replicate group) to reflect the uncertainty of a single measurement.</td>
</tr>
<tr>
<td><strong>Standard error</strong></td>
<td>The standard deviation of a set of replicates divided by the square root of the number of replicates.</td>
</tr>
<tr>
<td><strong>Unconjugated microspheres</strong></td>
<td>A microsphere set that has been chemically modified so that its surfaces are covered with some functional group, but that has not been chemically prepared for use as a component in an assay system. These base microspheres do not carry biomolecular reactant.</td>
</tr>
<tr>
<td><strong>Uniformity</strong></td>
<td>The reproducibility of a signal over a series of replicate measurements.</td>
</tr>
<tr>
<td><strong>Upper Limit of Quantitation</strong></td>
<td>For any given assay, this is the highest value Bio-Plex Manager will report in the Concentration in the Range column of the data table. Values above this range are considered less trustworthy based on either the poor recovery values of standards above this range or saturation of the assay. For more details, review the definition of Concentration in Range.</td>
</tr>
<tr>
<td><strong>Validation</strong></td>
<td>A formal process for documenting that an instrument is fit for its intended use and is kept in an appropriate state of maintenance and calibration.</td>
</tr>
<tr>
<td><strong>Validation kit</strong></td>
<td>A set of reagents and procedures designed to verify the performance of the array reader apart from an assay. Bio-Plex Validation Kit 4.0 assesses the alignment of the optics assembly, measures the performance of the reporter channel, evaluates the fluidics system, and verifies the classify efficiency of the array reader.</td>
</tr>
<tr>
<td><strong>Variance</strong></td>
<td>The mean square deviation of a variable around the average value.</td>
</tr>
</tbody>
</table>
Index

Numerics
21 CFR Part 11 Rule 168

A
Adjusting Your Graphs 158
Advanced Run Settings 98
   Bead Map Selection 98
   Doublet Discriminator Gates 100
   Sample Size 98
   Sampling Errors 99
   Save Options 99
Alcohol Flush 44
Alcohol Wash 44
Autofilling Replicate Groups 65
Autofilling Well Numbers 64

B
Back flush 44
Basic Concepts 219
   Excitation 220
   Fluidics 220
   Microspheres 219
   Reporter Fluorochromes 219
Bead Map 108
   Density Filtering 111
   Display Options 110
   Logarithmic/Linear Display 111
   Magnifying and Resizing 110
   Scaling the Bead Map Data 110
Bio-Plex assay and reagent website 2
Bio-Plex Manager
   General Workflow 7
   Installing 11
   Main toolbar 16
   Menu bar 16
   Quick Guide 17
   Required screen resolution 10
   Status Bar 17
   System requirements 9
Bio-Plex Manager software Editions 5
Bio-Plex MCV Plate IV 22
Bio-Plex Manager Software 6.1 User Guide | Index

Bio-Plex suspension array system  
Advantages 3  
Components 2  
Description 1  
Disconnecting 14  
Reconnecting 14  
Bio-Rad Technical Support  
Contact information  
  Website address 4

C  
Calculating Concentrations Automatically 86  
Calibration  
  Logging the Calibration 30  
  Performing the Calibration 30  
  Setting Up the Calibration 29  
Changing a Replicate Group 66  
Changing the Doublet Discriminator Gate Range 123  
Changing Well Formatting 68  
Choosing Graph Options 150  
Combining Panels of Analytes 61  
Compatibility with Luminex Software 6  
Creating a New Panel of Analytes 56  
Customizing Analytes and Panels 55

D  
Data Normalization 193  
  Assigning a Control Sample 195  
  Calculations Based Upon Your Settings 198  
  Factor Calculations 199  
  Predefined Schemes 197  
  Report Table Options 196  
  Selecting Internal Control(s) 194  
Defining a Group 70

E  
Editing a Panel of Analytes 60  
Entering Concentration Units 87  
Entering Concentrations 85

F  
Fluidics Functions 43

G  
Generating Results from a Protocol 103  
Glossary 205  
Graphing  
  Adding 155  
  Analytes across a single sample 152  
  Analytes across multiple samples 152  
  Deleting 157  
  Editing 156  
  Exporting to Other Applications 157  
  Samples across a single analyte 151  
  Samples across multiple analytes 151  
  Viewing Information 153  
Defining a Replicate Group 65  
Defining Blank Wells 68  
Defining Control Wells 67  
Defining Standard Wells 66  
Defining the Reference 71  
Defining Unknown Sample Wells 63  
Deleting and Renaming Custom Panels 61  
Deleting Well Formatting 68  
Doublet Discriminator Gate Range 106  
Drain 44
Hardware protection key use in USB port
Histogram
  Magnifying 107
  Resizing the Histogram 107
  Scaling the Histogram Data 107
  Selecting the Channel Type 106
Histogram and Bead Map 104

Instrument Information 43
Instrument Operations Log 45

Logistic Weighting 88
Luminex xPONENT software
  compatibility with Bio-Plex Manager 6

Manually Stopping a Reading 103
Microsphere Handling 221
  Agitation During Assay 223
  Bath Sonicator 221
  Dispersion 221
  Enumeration of Microsphere Suspensions 222
  Separation Methods 222
  Stability and Storage 223

Normalization Definitions 197
Normalization Formulas 215
Normalization Settings 193
Normalized Fluorescence Values (Norm FI) 217

Obs/Exp * 100 Column 134

Performing a Validation Run 38
Plate Formatting 63
Plate Groupings 69
Plate Loading Guidelines 101
Predefined Normalization Schemes 197
Preparing Protocols
  Step 1. Describe Protocol 53
  Step 2. Select Analytes 53
  Step 3. Format Plate 62
  Step 4. Enter Standards Info 72
  Step 5. Enter Controls Info 90
  Step 6. Enter Sample Info 92
Prime 44
Printing Graphs 158
Printing the Plate Format 71
Bio-Plex Manager Software 6.1 User Guide | Index

R

Raw Data
- Exporting 125
- Printing 126
- Setting the Plate ID 124
- Table Error Codes 126

Raw Data Table 112
- Bead Statistics 113
- Copying the Raw Data 115
- Display Options 114
- Formatting 115
- Sampling Error Codes 113
- Set Number Format 115

Recovery Percentage Range 89
Regression Methods 87

Report Table
- Concentration in Range Column 134
- Context Menus 136
- Copying 137
- Display Options 128
- Displaying Table Error Codes 130
- Exclude Table Error Codes 141
- Expand Replicate Info 130
- Exporting 137
- Organizing by Type or Group 130
- Predefined Report Schemes 129
- Printing 137
- Resizing the Columns 136
- Saving Settings 131
- Selecting Columns to Display 128
- Setting Number Formats 131
- Showing/Hiding Outliers 135
- Single or Multiple Analyte Layout 129
- Toolbar 127

Report Table Column Descriptions 132
Reporting Problems to Bio-Rad 225
Resequencing Well Numbers 66
Reservoir Functions 96

Run Protocol Window 94
- Bead Count 95
- Sample Timeout 95
- Running Protocols 93
- Running the Protocol 102
- Status Bar 103

S

Sample Needle Adjustment 18
Sanitize 44

Security Edition
- 21 CFR Part 11 168
- Audit Trail 179
- Calibration Logs 173
- Document ID Number 176
- Electronic Records 172
- Enabling Secure Mode 171
- Features 167
- File Security and Validation 172
- Installing 169
- Instrument Operations Logs 173
- Locked symbol shows Secure Mode 17
- Locking Bio-Plex Manager 183
- Logging Off 183
- Secure Protocol and Results Files 173
- Signed vs. Unsigned Files 173
- Standard Mode vs. Secure Mode 168
- System Requirements 169
- Unlocked symbol shows Standard Mode 17
- User Access by Function 211
- User Authentication 171
- User Information 170
- User Level Restrictions 170
- Users, Passwords, and User Levels 169
- Validation Logs 173

Selecting Analytes 54
Selecting External Standards 81
Selecting/Entering Calibration Control Numbers 26

Software Editions
- Security Edition 5
- Standard 5

Software Licenses
- Desktop 6
- Instrument Control 6
- Network 6

Software Warranty 224
Solobug
- Reporting Problems 225
Sorting Report Table Data 137
Standard Concentration Lots 73
Standard Curve 142
Copying 147
Linear vs. Logistic Regression Methods 147
Printing 148
Regression Methods 144
Standard Curve Optimizer 185
Starting Bio-Plex Manager 13
System cable connections 14
System Controls
- Eject/Retract Plate 43
- Instrument Information 43
- Optics Warm Up and Shut Down 24
- Platform Heater 42
- Remove Air Bubbles 33
- Start Up 23
- Unclog 34
- Validation 35
- Wash Between Plates 32

Validation
- Setting Up a Validation Run 36
- Validation Kit 35
- Validation Log 39
- Validation Type Selection 37

W
- Wash 44
- Well Numbering and Replicate Groups 64

U
- Uninstalling Bio-Plex Manager 12
- Using the Security Edition 167